Core Certification
Student Manual
Texas
# Table of Contents

## Contents

<table>
<thead>
<tr>
<th>Module 1 - Simple Document Assembly</th>
<th>.................................................................</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module 1 - Assignment</td>
<td>.........................................................................................................................</td>
<td>8</td>
</tr>
<tr>
<td>Module 1 - Quick Check</td>
<td>.........................................................................................................................</td>
<td>16</td>
</tr>
</tbody>
</table>

| Module 2 - Client/Case Manager      | .......................................................................................................................... | 17 |
|-------------------------------------|..........................................................................................................................|---|
| Module 2 - Assignment               | .......................................................................................................................... | 20 |
| Module 2 - Quick Check              | .......................................................................................................................... | 25 |

| Module 3 - Default Answers          | ......................................................................................................................... | 26 |
|-------------------------------------|.........................................................................................................................|---|
| Module 3 - Assignment               | ......................................................................................................................... | 30 |
| Module 3 - Quick Check              | ......................................................................................................................... | 34 |

| Module 4 - Document Management      | ......................................................................................................................... | 35 |
|-------------------------------------|.........................................................................................................................|---|
| Module 4 - Assignment               | ......................................................................................................................... | 40 |
| Module 4 - Quick Check              | ......................................................................................................................... | 44 |

| Module 5 - Searching for Forms      | ......................................................................................................................... | 45 |
|-------------------------------------|.........................................................................................................................|---|
| Module 5 - Assignment               | ......................................................................................................................... | 47 |
| Module 5 - Quick Check              | ......................................................................................................................... | 53 |

| Module 6 - Editing Case Answers     | ......................................................................................................................... | 54 |
|-------------------------------------|.........................................................................................................................|---|
| Module 6 - Assignment               | ......................................................................................................................... | 57 |
| Module 6 - Quick Check              | ......................................................................................................................... | 62 |

| Module 7 - Optimizing ProDoc Settings | ......................................................................................................................... | 63 |
|---------------------------------------|.........................................................................................................................|---|
| Module 7 - Assignment 1               | ......................................................................................................................... | 68 |
| Module 7 - Assignment 2               | ......................................................................................................................... | 75 |
| Module 7 - Quick Check                | ......................................................................................................................... | 80 |

| Module 8 - Saving Time with QuickText | ......................................................................................................................... | 81 |
|---------------------------------------|.........................................................................................................................|---|
| Module 8 - Assignment                 | ......................................................................................................................... | 84 |
| Module 8 - Quick Check                | ......................................................................................................................... | 87 |

| Module 9 - Texas Family Law PowerPack| ......................................................................................................................... | 88 |
|--------------------------------------|.........................................................................................................................|---|
| Module 9 - Assignment                | ......................................................................................................................... | 97 |
| Module 9 - Quick Check               | ......................................................................................................................... | 105 |

<p>| Module 10 - Document Formatting      | ......................................................................................................................... | 106 |</p>
<table>
<thead>
<tr>
<th>Module 10 - Assignment 1</th>
<th>109</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module 10 - Assignment 2</td>
<td>113</td>
</tr>
<tr>
<td>Module 10 - Quick Check</td>
<td>120</td>
</tr>
<tr>
<td><strong>Module 11 – Graphic Forms</strong></td>
<td>121</td>
</tr>
<tr>
<td>Module 11 - Assignment</td>
<td>126</td>
</tr>
<tr>
<td>Module 11 - Quick Check</td>
<td>135</td>
</tr>
<tr>
<td><strong>Module 12 - Form Sets</strong></td>
<td>136</td>
</tr>
<tr>
<td>Module 12 - Assignment</td>
<td>140</td>
</tr>
<tr>
<td>Module 12 - Quick Check</td>
<td>161</td>
</tr>
<tr>
<td><strong>Module 13 - Editing Master Forms</strong></td>
<td>162</td>
</tr>
<tr>
<td>Module 13 - Assignment</td>
<td>166</td>
</tr>
<tr>
<td>Module 13 - Quick Check</td>
<td>182</td>
</tr>
<tr>
<td><strong>Module 14 - eFiling from ProDoc</strong></td>
<td>183</td>
</tr>
<tr>
<td>Module 14 - Assignment</td>
<td>187</td>
</tr>
<tr>
<td>Module 14 - Quick Check</td>
<td>189</td>
</tr>
<tr>
<td><strong>Module 15 - SOS Part I</strong></td>
<td>190</td>
</tr>
<tr>
<td>Module 15 - Assignment</td>
<td>197</td>
</tr>
<tr>
<td>Module 15 - Quick Check</td>
<td>198</td>
</tr>
<tr>
<td><strong>Module 16 - SOS Part II</strong></td>
<td>199</td>
</tr>
<tr>
<td>Module 16 - Assignment</td>
<td>204</td>
</tr>
<tr>
<td>Module 16 - Quick Check</td>
<td>205</td>
</tr>
<tr>
<td><strong>Appendix I - Extra Credit</strong></td>
<td>206</td>
</tr>
<tr>
<td><strong>Appendix II - Additional Resources</strong></td>
<td>225</td>
</tr>
<tr>
<td>Tech Tips</td>
<td>225</td>
</tr>
<tr>
<td>Quick Reference Sheets</td>
<td>225</td>
</tr>
<tr>
<td>Self Running ProDoc Training Videos</td>
<td>226</td>
</tr>
<tr>
<td><strong>Appendix III - ProDoc Certification Exam Information</strong></td>
<td>228</td>
</tr>
</tbody>
</table>
Module 1 - Simple Document Assembly

A. MODULE DESCRIPTION

In this module you will learn how to quickly assemble two documents: one using the minimal assembly technique and the other using the preferred technique.

B. OBJECTIVES

Upon successful completion of this module you will be able to:

1. Explain the various steps required to complete the document assembly process.
2. Produce a simple ProDoc document.

C. PROCEDURE

1. Quick Document assembly - creating a document for one time use

Complete the following steps:

a. Click the Assemble icon (lightning bolt) on the toolbar or Assemble Document icon (lightning bolt) in the Quick Click Menu. The Starting Document Assembly window opens. Depending upon the window’s status when it was last used, it will either reveal two steps or four steps.

b. Click the Don’t use a case file check box.

c. Click the Select forms button, then click the title of the volume you want to use. The Select Forms window will then open.

d. Select a form by clicking the box next to the form number or by highlighting the desired form and clicking the Select button at the bottom of the window. Notice that there is a tab for numerical and alphabetical form listings: look at each and note the differences. After selecting the form, click the OK button at the bottom of the window. Use the Attorney-Client Matters volume and form 3-15 New Client Letter.

e. Verify where the completed documents will be stored. If the Directory field is not visible on the window, click the flat blue arrow button at the bottom of the window border to reveal Steps 3 and 4. ProDoc will remember the window setting.

f. Click the Start Assembling button.

g. If the copyright window appears, click Do not show this window again, then click OK to close the window.

h. Answer the questions for this document. Type or select the answers and click the Next button.

i. ProDoc will now assemble the answers and display the document on the screen. This is called the “merge” phase. Click the Auto button, then click Yes. This will complete the
merge questions by entering a placeholder for each unanswered question.

j. The Completed Documents window appears. It displays the location where the document is saved and the document’s file name. Click the Continue button.

k. The completed document is now assembled in the word processor, is displayed on the screen and is ready for editing or printing.

Next, complete the following steps:

1. Close the document and do not save the changes.
2. Click the Assemble icon.
3. Click Don’t use a case file.
4. Select the volume and the same form which was previously assembled.
5. Click the Start Assembling button.
6. Answer the first question and click the Next button.
7. Click Quit.

2. Comprehensive document assembly - saving case answers

Saving and reusing answers is a huge time saver. Complete the following steps:

a. Click Return to Session Settings, then the OK button. The Starting Document Assembly window appears.

b. Uncheck the Don’t use a case file box.

c. To select or create a client and case, click the Select Case button. The Select A Case window opens. If you do not have any clients or cases, you will after the next few steps.

d. Click the New Client button on the bottom left side of the window to create a new client.

e. Type the client’s name, prefix, and address on the left-hand side of the screen. Leave the Business Name and Non-client boxes unchecked. Use the following name and address: Mr. James A. Johnson, 123 Center Street, Anytown, TX 71111.

Practice Tip: Have the person in your office that creates a new case enter all of the information into ProDoc. This way, as documents are assembled, ProDoc already has the information needed to get started.

f. If you don’t see a Correspondence & Phones window on the right side of the Client Will Be Added window, click the flat blue expand/contract button on the right edge of the Client Will Be Added window to open the extra information area.

g. In the Salutation field, type Dear <prefix> <customer’s last name> and then a colon (:). It should look like this: Dear Mr. Johnson:

h. Press the Tab key or click the Refresh button to paste the client’s name and address into the Full Envelope Address field.
i. Click the **New** button in the **Phones** area and type *(210) 555-2212* as the **Business** phone number, then click **OK**. Now, click **OK** in the **Client Will Be Added** screen to close the window and save the client’s information.

j. With **Johnson, James A.** still selected, click the **New** Case button (located below the **New Client** button), fill in the case ID with 1234 and enter a description of **Divorce**.

k. Click **OK** to close the **Case Will Be Added** window.

l. With the **Divorce** case selected under **Johnson, James A.**, click the **Select Case** button.

m. Select the **Attorney-Client Matters** volume and form, **New Client Letter**. The **New Client Letter**, along with the majority of the client and case management forms, are in this volume.

n. Click the **Select forms** button, select the appropriate volume, click the box by the desired form and click the **OK** button at the bottom of the window.

o. Verify where the completed documents will be stored.

p. Click the **Start Assembling** button.

q. If the copyright window appears, click **Do not show this window again** and click **OK**.

r. Answer the questions in this document by typing in or selecting the answers and then clicking **Next**.

By completing this step you process the assembly questions which draft the legal language of the form depending upon your answers and built-in logic.

s. Review the function of each button on the **Processing Assembly Questions** dialog window.
Quit - Enables you to exit the document assembly session and save your answers.

Show/Hide Explanation - This button opens or hides the indepth explanation we provide for nearly every question.

The “merge phase” of the document assembly process begins when you finish Assembly Questions. ProDoc assembles the document according to the answers and displays the document on the screen in a merged format.

Review the function of each button on the “merge phase” window.

QuickText - Enables you to enter saved information from a “language library” (explained more in Module 8).

Auto - Clicking this causes ProDoc to skip all remaining questions and enter a placeholder into the word processor document in place of the missing information.

(P)revious - Click to go back to the previous question. Also click Alt + P.

(N)ext - Click to go back to the next question. Also click Tab or Alt + N.

Calendar - Click to view a calendar.

Calculator - Click to open a simple calculator.

Help - Click to get help with the question.

The Completed Documents dialog window appears and allows you to change the location of the saved file. Click Continue.

The completed document is now assembled in the word processor and is ready for editing or printing.

D. REVIEW

1. What action does not occur when you select the Don’t use a case file checkbox?
2. If you do not see a form that you need in the numerical listing, how else can you look for it?

3. Once you have an assembled document in your word processor, describe how you would change the document’s formatting. Is the formatting saved in ProDoc?

E. ADDITIONAL RESOURCES

An additional resource to assist you with understanding the ProDoc document assembly process is this self-running video: tinyurl.com/pd-doc-assembly
Module 1 - Assignment

Directions

1. Complete the “client interview” by using the information below. Write the information as answers on the worksheet for the New Client Letter. A blank worksheet is provided in the module.

2. Click the Assemble icon. Select the James A. Johnson Divorce case.

3. The New Client Letter is located in the Attorney-Client Matters volume, as are most of the client and case management forms. After clicking the Select Forms button, change the default volume to Attorney-Client Matters select the New Client Letter form. If you are prompted to select related forms, click the OK button without selecting any.

4. Ensure the block is checked to review your prior answers. Click Start Assembling.

5. Assemble the document with the answers on the worksheet. Print the finished New Client Letter and compare it to the example form with answers in this module.

Form: New Client Letter

- SELECT the TYPE of CASE:
  - [√] 1 – Civil
  - [ ] 2 – Criminal

- NUMBER OF clients in this case: (this question will only appear if you choose Civil case above) 1

- Client’s FULL NAME: (this question will be repeated for each client should you choose multiple clients above)
  
  James A. Johnson

- Will a FEE be CHARGED to the client for the INITIAL CONSULTATION?
  - [ ] 1 Yes
  - [√] 2 No

- SELECT the CLIENTS for whom you wish to generate a New Client Letter:
  - [ ] List of Clients (this question will only appear if you choose multiple clients above)
  - [ ] __________________________________________________
  - [ ] __________________________________________________

- Describe Client: (this question will be repeated for each client should you choose multiple clients above)
  - [√] 1 - male
  - [ ] 2 - female
SELECT the TYPE of PROFESSIONALS for whom you wish to state their HOURLY RATE:

- [√] 1 - Primary attorney
- [ ] 2 - Law clerk
- [ ] 3 - Paralegal
- [ ] 4 – Other

Will the FEE AGREEMENT be ATTACHED as an EXHIBIT to the New Client Letter?

- [ ] 1 Yes
- [√] 2 No

DESCRIBE Primary Attorney:

- [√] 1 - Sole practitioner
- [ ] 2 - Member of a firm

DESCRIBE the Primary Attorney:

- [√] Male
- [ ] Female

County in which the Agreement is performable: Bexar

STYLE of cause of action or DESCRIPTION of matter: Divorce

Client’s SALUTATION for correspondence: Provided by case file

DESCRIPTION of the services requested by the client/potential client: Represent you in your Divorce case

- AMOUNT charged for an initial consultation: 0
- NAME of Client’s PRIMARY ATTORNEY: William Jones
- AMOUNT charged per hour for primary attorney: 450
- AMOUNT charged per hour for law clerks:
- AMOUNT charged per hour for paralegals:
- TITLE of other professional:
- AMOUNT charged per hour for the other professional:
- LAW FIRM’S AREA CODE: (210)
- LAW FIRM’S TELEPHONE NUMBER: 555-1213
- YEAR in which the client will SIGN the New Client Letter: Present Year
- FULL NAME of person to contact at the office of client: James A. Johnson
- CAPACITY of the person to contact at the office of client: Client
New Client Letter - Blank Worksheet

Directions:
This is a blank worksheet of the questions asked in order when filling out the form for the New Client Letter. Use this to collect the information needed to complete this form.

- SELECT the TYPE of CASE:
  - [ ] 1 – Civil
  - [ ] 2 – Criminal

- NUMBER OF clients in this case: (this question will only appear if you choose Civil case above)

- Client’s FULL NAME: (this question will be repeated for each client should you choose multiple clients above)

- Will a FEE be CHARGED to the client for the INITIAL CONSULTATION?
  - [ ] 1 Yes
  - [ ] 2 No

- SELECT the CLIENTS for whom you wish to generate a New Client Letter:
  - [ ] List of Clients (this question will only appear if you choose multiple clients above)
    - [ ] __________________________________________________
    - [ ] __________________________________________________
    - [ ] __________________________________________________

- Describe Client: (this question will be repeated for each client should you choose multiple clients above)
  - [ ] 1 - male
  - [ ] 2 - female
  - [ ] 3 - entity

- SELECT the TYPE of PROFESSIONALS for whom you wish to state their HOURLY RATE:
  - [ ] 1 - Primary attorney
  - [ ] 2 - Law clerk
  - [ ] 3 - Paralegal
  - [ ] 4 – Other

- Will the FEE AGREEMENT be ATTACHED as an EXHIBIT to the New Client Letter?
  - [ ] 1 Yes
  - [ ] 2 No
• DESCRIBE Primary Attorney:
  [ ] 1 - Sole practitioner
  [ ] 2 - Member of a firm

• Describe the Primary Attorney:
  [ ] Male
  [ ] Female

• DATE of New Client Letter to the client:

• STYLE of cause of action or DESCRIPTION of matter:

• Client’s SALUTATION for correspondence:

• DESCRIPTION of the services requested by the client/potential client:

• AMOUNT charged for an initial consultation:

• NAME of Client’s PRIMARY ATTORNEY:

• AMOUNT charged per hour for primary attorney:

• AMOUNT charged per hour for law clerks:

• AMOUNT charged per hour for paralegals:

• TITLE of other professional:

• AMOUNT charged per hour for the other professional:

• LAW FIRM’S AREA CODE:

• LAW FIRM’S TELEPHONE NUMBER:

• YEAR in which the client will SIGN the New Client Letter:

• FULL NAME of person to contact at the office of client:

• CAPACITY of the person to contact at the office of client:
March 19, 2011
James A. Johnson
123 Center Street
Anytown, Texas 71111

NEW CLIENT INFORMATION LETTER

Re: Divorce

Dear Mr. Johnson:

I am pleased that you have chosen my law office to represent you in your Divorce case. The purpose of this letter is to provide you with some general information on my law office’s policies and procedures, and a broad explanation on the method used by my law office to charge for my services.

Outcome or Results

Due to numerous and complicated factors which are beyond my control, I cannot guarantee a favorable outcome in any business matter that I am handling for you. I will, however, within the bounds of legal ethics, provide reasonable and competent services to represent and protect your legal interests. In the event the matter requires negotiation or involves litigation, I will negotiate with the opposing party on your behalf in order to settle or resolve the dispute. I will not conclude or settle the matter without your approval.

In order for me to represent you competently, please do not communicate with any of the parties, witnesses, insurance companies, adjustors, investigators or attorneys in the case without my involvement.

In the event my representation is to collect money owed to you, you grant me a lien on the claim or cause of action and upon any sum of money or property to be recovered in order to secure any unpaid attorney’s fees or costs incurred as discussed in this letter. All monies collected shall be disbursed through my office.

Office Appointments

Many legal matters can be handled by telephone, fax transmissions or mail in order to avoid numerous personal trips to and from the office. It is more productive to handle routine matters by phone as opposed to personal visits because it saves each of us time.
In the event you need to meet personally with me or a staff member, feel free to do so. Simply make an appointment with the administrative assistant, who will schedule an appropriate time on my calendar.

**Initial Consultation**

My law office charges no fee for an initial consultation with a client. The consultation includes meeting the client, ascertaining the facts necessitating the need for legal services, analyzing the situation, and advising the client what, if any, services the law office may be able to perform on the client’s behalf.

**Client Availability**

In order to properly represent you, you agree to keep my office advised of your whereabouts during both day and evening hours by providing me with current business and home telephone numbers. In the event the matter involves litigation, you may be required to attend court appearances and comply with discovery requests and deposition notices.

**Fee Determination**

Some or all of the following factors may be taken into account when determining a fee structure and setting a fee:

6. The time and labor required, the novelty and difficulty of the questions involved, and the skill requisite to perform the legal service properly.

7. The likelihood, if apparent to the client, that the acceptance of the particular employment will preclude other employment.

8. The fee customarily charged in the locality for similar legal services.

9. The amount involved and the results obtained.

10. Time limitations imposed by the client or by circumstances.

11. Nature and length of the professional relationship with the client.

12. Experience, reputation and ability of the lawyer or lawyers performing the services.

13. Type of fee structure (fixed fee, hourly rate, contingent, or other).

**Types of Fee Structures**

The fee structure may be based on a flat rate (sometimes called “value billing”), an hourly rate, or on a contingency basis.

**Flat Rate:** A flat rate is a one-time payment to cover all of the costs of handling a specific legal matter such as an incorporation, an uncontested bankruptcy, or a divorce.

**Hourly Rate:** An hourly rate is an hourly charge for all the attorney’s time devoted to handling a specific case.

**Contingency Fee:** When allowed by law, the attorney may charge a contingency fee which is based on a percentage of the judgment awarded to the client.
Flat Rates (Value Billing)

Flat rates are used primarily in routine, uncomplicated legal matters. A flat fee is always based on certain specific assumptions. If those assumptions are incorrect, changed, or modified, then the attorney must revert to an hourly rate since he cannot provide competent professional services as requested and needed under a flat fee arrangement.

For example, a flat fee for a divorce proceeding might include: a meeting with the client, determining the client’s needs; drafting and filing the divorce petition; having the spouse sign a document which waives service of citation; preparation of an agreed divorce decree; representing the client at the hearing; and obtaining a final agreed divorce decree.

However, if the matter cannot be resolved by agreement, then the flat fee arrangement would no longer apply due to the changed circumstances. In such a situation, I would apply the flat fee as a retainer or deposit against the total fee owed. Once the hourly rate fee exceeds the monies previously collected, I would bill the client at the stated hourly rate based on the time spent on the case.

Current Hourly Rates

William Jones $450

Hourly rates are reviewed from time to time and adjusted as and when appropriate. When an adjustment is required, you will be notified and advised accordingly.

Regulation of Attorneys

Attorneys are regulated by the State Bar of Texas per the State Bar Act. Clients have certain rights and privileges under the Act. The State Bar of Texas investigates and prosecutes professional misconduct committed by attorneys. Although not every complaint against or dispute with a lawyer involves professional misconduct, the State Bar’s Office of Chief Disciplinary Counsel will provide you with information about how to file a complaint if you believe one is necessary. For more information about your rights as a client, you may call the State Bar, toll free, at 1-800-932-1900.

Conclusion

I hope this letter has answered any questions that you may have had regarding how attorneys charge for their legal services and how I have agreed to handle the legal matter. If you have any questions concerning any other matters, please call me at (210) 555-1213.

Once again, I am delighted that you have decided to use my services, and I look forward to working with you.

Very truly yours,

William Jones

Receipt acknowledged on this ___________ day of _________________________ 2011.

___________________________________________
James A. Johnson
Module 1 - Quick Check

1. True or False: It is recommended to use the “Don’t use a case file” option during the document assembly process.

2. True or False: By using subvolumes, it can be quicker to find a document in a volume.

3. True or False: If you type in the form number when selecting a form, the highlight will jump to the indicated form.
Module 2 - Client/Case Manager

A. MODULE DESCRIPTION

One of the most important features of ProDoc is its ability to build a case file for saving your answers. The Client/Case Manager allows you to reuse information entered in earlier assembly sessions every time you produce subsequent documents for that case.

B. OBJECTIVES

1. Upon successful completion of this module, the students will be able to:

2. Create a new client and case with address and correspondence information.

3. Modify existing information, changing name, address and case information.

4. Demonstrate the use of the Assemble icon and Client/Case Manager.

5. Demonstrate the copy/paste feature by copying a client's name and address to the word processor.

C. PROCEDURE

Complete the following steps:

1. Add a New Client

a. From the main ProDoc screen, click the Client/Case icon. This will display the Client/Case Manager window.

b. To add a new client, click the New Client button in the lower left side of the screen. This will display the Client Will be Added window.

c. Enter the following client information. Press Tab to move between fields:

   i. Mrs. Jane Q. Doe

   ii. Mrs. Doe is a client, so leave the Business and Non-client boxes unchecked.

   iii. 123 Main Street, Anytown, TX 78888

d. If a Correspondence & Phones section does not appear on the right side of the window, click the blue button on the right edge of the Client Will Be Added window to open the extra information area.

   e. In the Salutation field, type Dear Mrs. Doe:

   f. Click the Refresh button.

   g. Click the New button for the Phones field.

   h. From the drop down list, select Home and type (210) 555-1212 as the number.

   i. Click the OK button to close the window.
In the upper right hand corner of the dialog box, click the **Custom Fields** tab. This is where you can enter up to six fields of custom information for each client. This is set up under the **Customize** menu, **Options and Custom Fields**. Once these fields are set up, they should not be changed.

Click **OK** to close the **Client Will Be Added** window.

Click the **New Case** button. In the **Case Will Be Added** window, enter **1234** as the **Case ID** number.

In the **Description** field, type **Divorce** and click **OK**. The **Client/Case Manager** window will be displayed.

If a **Client Information** tab and a **Send To** button are not displayed on the right side of the window, click the blue button on the right edge of the window to open the extra information area.

You will now start a letter to the client. Click the word processor button in the ProDoc taskbar if the word processor is not currently running. Start with a blank page. Press the **Enter** key 5 times and type the date. Press the **Enter** key three more times.

Use either the ProDoc toolbar (if installed) or the Windows® taskbar to switch back to ProDoc. Click the **Send To** button and select **Paste address with salutation**. ProDoc then pastes the client’s name and address into the document.

Close the document and do not save the changes. Switch back to ProDoc.

**2. Other Client/Case Manager Features**

Notice the **Now Showing** feature: drop-down arrow field at the top of the **Client/Case Manager** to filter between showing **All Contacts and Cases**, **Active Clients**, **Closed Clients**, **Private Clients** and **Non-Clients**. Normally you would set this to show **Active Clients**.

Click the “+” sign to the left of the client’s name to display the client’s **Cases**. This displays all of the client’s cases. Highlight a case and click the **Case Custom Fields** tab. These fields (up to six per case) can be used to enter custom case information and can be updated like the client custom fields mentioned before.

Click the **Show Cases** button to display all cases. It will be renamed as the **Hide Cases** button. Click it to hide all cases.

You can update or delete the highlighted client or case by clicking the appropriate buttons.

**D. OTHER RESOURCES**

Another ProDoc resource you may find useful in better understanding the Client/Case Manager feature includes:

- **Client and Cases TechTip** ([tinyurl.com/pd-clients-cases](http://tinyurl.com/pd-clients-cases)) - This TechTip provides step-by-step instructions with screens shots in use this feature.
E. REVIEW

1. True or False: It is not recommended to add a client or a case when assembling a document.

2. True or False: The only two items that ProDoc needs to store a client in the database is the client’s last name and a case description.

3. True or False: You can create six customizable fields for clients and six for cases.
Module 2 - Assignment

Assignment Description:

Adding a new client and case to the Client/Case Manager. Updating a client or case uses the same windows and procedures, except that the process is started by clicking the Update Client/Update Case buttons instead of the New Client/New Case buttons.

Directions:


2. Open the Client/Case Manager and ensure Active Clients appears in the Now Showing field.

3. Add a new client by entering the following information into the Client/Case Manager:
   a. Last Name: Doe
   b. First Name: John
   c. Middle Name: H.
   d. Prefix: Mr.
   e. Suffix: Jr.
   f. Address: 123 Main Street
   g. City: Anytown
   h. State: TX
   i. Zip: 71111
   j. Salutation: Dear Mr. John H. Doe, Jr.:
   k. Phone-Business: 210-555-1212
   l. Phone-Home: 210-555-2120

4. On the Custom Fields tab for Mr. Doe, add the following information:
   a. SSN: 002-29-3330
   b. DOB: 01-02-1979

5. Click OK to close the window and click Yes to update the envelope address. Click New Case and enter the following information:
   a. Case ID: 2009-09-30-1
   b. Date: 1/29/2011
   c. Description: Criminal Defense
   d. Click the OK button to close the window.
   e. Without closing the Client/Case Manager, assemble a new document for the case.

6. Click the Assemble icon at the top of the screen.
7. When the Starting Document Assembly window opens, assemble a New Client Letter for Mr. Doe’s criminal defense case using the information below:
   a. In the Attorney-Client Matters volume, select the correct form.
   b. Complete your assembly session using the information below.
   c. This is a Criminal case with Mr. Doe as the only client.
   d. Enter your Initial Consultation Fee as $500.00 (include the $).
   e. Enter your Hourly Fee as $250.00 (include the $).
   f. As the primary attorney, you will be the only person billing on this case.
   g. Enter any other information as appropriate.
   h. Complete and compare the form to the New Client Letter included in this module.
New Client Letter, Module 2

ATTORNEY-CLIENT COMMUNICATION: THIS DOCUMENT AND ITS CONTENTS CONSTITUTE LEGALLY PRIVILEGED INFORMATION

January 31, 2011

John H. Doe, Jr.
123 Main Street
Anytown, Texas 71111

NEW CLIENT INFORMATION LETTER

Re: Criminal Case

Dear Mr. John H. Doe, Jr.:

I am pleased that you have chosen my law office to represent you in your criminal case. The purpose of this letter is to provide you with some general information on my law office’s policies and procedures, and a broad explanation on the method used by my law office to charge for my services.

Outcome or Results

Due to numerous and complicated factors which are beyond my control, I cannot guarantee a favorable outcome in any litigation matter that I am handling for you. I will, however, within the bounds of legal ethics, provide reasonable and competent services to represent and protect your legal interests. In the event the matter requires negotiation or involves litigation, I will negotiate with the prosecuting attorney to achieve a satisfactory resolution of the charge. I will not plea bargain the charge without your approval.

In order for me to represent you competently, please do not communicate with any of the parties, witnesses, insurance companies, adjustors, investigators or attorneys in the case without my involvement.

Office Appointments

Many legal matters can be handled by telephone, fax transmissions or mail in order to avoid numerous personal trips to and from the office. It is more productive to handle routine matters by phone as opposed to personal visits because it saves each of us time.

In the event you need to meet personally with me or a staff member, feel free to do so. Simply make an appointment with the administrative assistant, who will schedule an appropriate time on my calendar.
**Initial Consultation**

My law office charges $500.00 for an initial consultation with a client. The consultation includes meeting the client, ascertaining the facts which gave rise to the charge, analyzing the situation, and advising the client what, if any, services the law office may be able to perform on the client’s behalf.

**Client Availability**

In order to properly represent you, you agree to keep my office advised of your whereabouts during both day and evening hours by providing me with current business and home telephone numbers. In the event the matter involves litigation, you may be required to attend court appearances and comply with discovery requests and deposition notices.

**Fee Determination**

Some or all of the following factors may be taken into account when determining a fee structure and setting a fee:

1. The time and labor required, the novelty and difficulty of the questions involved, and the skill requisite to perform the legal service properly.
2. The likelihood, if apparent to the client, that the acceptance of the particular employment will preclude other employment.
3. The fee customarily charged in the locality for similar legal services.
4. The seriousness of the case.
5. Time limitations imposed by the client or by circumstances.
7. Experience, reputation and ability of the lawyer or lawyers performing the services.
8. Type of fee structure (fixed fee or hourly rate).

**Types of Fee Structures**

The fee structure may be based on a flat rate (sometimes called “value billing”), or on an hourly rate.

**Flat Rate:** A flat rate is a one-time payment to cover all of the costs of handling a specific legal matter such as an incorporation, an uncontested bankruptcy, or a divorce.

**Hourly Rate:** An hourly rate is an hourly charge for all the attorney’s time devoted to handling a specific case.

**Flat Rates (Value Billing)**

Flat rates are used primarily in routine, uncomplicated legal matters. A flat fee is always based on certain specific assumptions. If those assumptions are incorrect, changed, or modified, then the attorney must revert to an hourly rate since he cannot provide competent professional services as requested and needed under a flat fee arrangement.
For example, a flat fee for a DUI charge might include: a preliminary investigation into the facts and circumstances of the case; legal research; advice to the client regarding the case and any offers of plea bargain; and, a plea of guilty or no contest to the charges or to some lesser included offense that disposes of the charges.

However, if the matter cannot be resolved by plea bargain, then the flat fee arrangement would no longer apply due to the changed circumstances. In such a situation, I would apply the flat fee as a retainer or deposit against the total fee owed. Once the hourly rate fee exceeds the monies previously collected, I would bill the client at the stated hourly rate based on the time spent on the case.

**Current Hourly Rates**

Ima Student $250.00

Hourly rates are reviewed from time to time and adjusted as and when appropriate. When an adjustment is required, you will be notified and advised accordingly.

**Regulation of Attorneys**

Attorneys are regulated by the State Bar of Texas per the State Bar Act. Clients have certain rights and privileges under the Act. The State Bar of Texas investigates and prosecutes professional misconduct committed by attorneys. Although not every complaint against or dispute with a lawyer involves professional misconduct, the State Bar’s Office of Chief Disciplinary Counsel will provide you with information about how to file a complaint if you believe one is necessary. For more information about your rights as a client, you may call the State Bar, toll free, at 1-800-932-1900.

**Conclusion**

I hope this letter has answered any questions that you may have had regarding how attorneys charge for their legal services and how I have agreed to handle the legal matter. If you have any questions concerning any other matters, please call me at (210) 555-1212.

Once again, I am delighted that you have decided to use my services, and I look forward to working with you.

Very truly yours,

Ima Student

Receipt acknowledged on this __________ day of __________ 2011.

___________________________________________
John H. Doe, Jr.
Module 2 - Quick Check

9. True or False: The icon for the Client/Case Manager is the folder with overlaid pages.

10. True or False: The Refresh button is used to paste the address and salutation into your word processor.

11. True or False: Both clients and cases have 6 fields each for custom information.
Module 3 - Default Answers

A. MODULE DESCRIPTION

There are many questions in a law office which often have the same answer, such as the law firm's name (signature block) or the attorney's bar number. The user can save a tremendous amount of time and effort by setting default answers, and ProDoc makes the process extremely easy to complete. Some default answers are established during software installation, such as the majority of law firm information. The two ways to establish all other default answers include: 1) using global questions and 2) setting defaults during document assembly. Also, there are three types of default answer questions: 1) global, 2) volume and 3) supplemental.

B. OBJECTIVES

Upon successful completion of this module, you will be able to:

1. Demonstrate how to set and update default firm information.
2. Demonstrate how to answer the global questions in a default answer set.
3. Demonstrate how to set a default answer during the document assembly process.

C. PROCEDURE

1. Setting default firm information

Certain firm information fields are entered during software installation. These can only be changed in the Options And Settings window. Complete the following steps to ensure these answers are consistent throughout this class. Many documents produced in later modules, and examples included in the manual, will contain this information. Note that these answers may have already been set during installation.

a. Click Customize, then Firm Information. Note that you can also reveal the Firm Information fields by clicking Customize > Options, then clicking the Firm Information link on the left side of the window.

b. Enter the following information in the Firm Information fields on the right side of the window.

1. Firm Name: Student's Name, Attorney at Law
2. Address (first line): 123 Main Street
3. Address (second line): Suite 100
4. City: Attorneyville
5. State: Texas
6. Zip Code: 71111
7. Phone: (210) 555-1212
2. Answering the global questions in a default answer set

Complete the following steps to set default answers.

a. From the Customize menu, click Default Answers and then Global Questions. The answers to Global questions are used throughout all of ProDoc’s documents. Volume questions are specific to a volume.

b. ProDoc will display the Set Default Answers for Global Questions dialog box. You will answer the following questions: P0190, P0191 and P0194. These questions deal with the client’s primary attorney information.

c. To get to question P0190, either use the scroll bar and scroll until you reach P0190 or just type “P0190”, which will move the highlight directly to the question. Click question P0190 and then click the Update Default Answer button.

d. This will display the question associated with P0190, Name of Client’s PRIMARY ATTORNEY. Type Allen A. Attorney and click OK.

e. Click P0191 and click the Update Default Answer button. Answer the question with AAA and click OK.

f. Click P0194 and click the Update Default Answer button. Enter 12345. Click OK.

g. Click the Close button to close this dialog box.

3. Using default answers

Complete the following steps.

a. Click the Assemble icon.

b. Select John H. Doe, Jr. as the client. Create a case and enter Landlord as the description. Select this case.

c. Select the Attorney-Client Matters volume.

d. Select form 4-15 Attorney Fee Agreement for Hourly Clients.

e. Click the OK and Start Assembling buttons.

f. Answer the assembly questions by clicking Next. Once the questions have been answered, the document will be assembled on the screen.

g. Press the Tab key to move through the merge questions on the screen.

The blanks will be filled in by the default answers as you press Tab (where answers exist). Take special note of the signature block information. Once the signature block information is entered in the database, there is no need to type this information in the
field.

h. When the completed documents dialog box appears, click Continue.

i. ProDoc will pass the document to the word processor. Scroll through the document. Note where the default answers are inserted.

4. Setting default answers during document assembly

a. While answering questions during document assembly, click the Default button at the top of the question window.

b. Select Yes on the window that pops up to ask if this answer should be set as the default answer.

From this point forward, every time that particular question is first asked during an assembly session, the default value will be displayed unless it is overridden by an answer that was given during a prior session using the same case or by a default answer calculated by ProDoc. To change the default, type in the new answer, set it as a default answer and continue assembling the document.

5. Using Default Answer Sets

If a law office has multiple attorneys, each attorney can have a default answer set. Multiple sets are easy to create, select and use. Note that, for each assembly session you begin, the default answer set you have designated in the Assembly Settings section of the Options And Settings window will always appear as the default set for use. To use a different set, you must select it on Step 4 of the Starting Document Assembly window each time you assemble documents.

Complete the following steps.

a. From the Customize menu, choose Default Answers and Default Answer Sets.

b. Click the New button.

c. Type the second attorney’s name (Ima Attorney) in the Set Name field.

d. In the Existing Set to Copy field, click the drop-down menu and select Primary Set.

e. Click the OK button. Click the Close button.

f. Click Customize > Default Answers and Global Questions again.

g. In the drop down window at the top, select the second attorney.

h. Answer the questions P0190, P0191, and P0194. This will set the personal information for the second attorney. Click Close.

i. Click the Assemble icon.

j. Select a client and case.

k. Select the Attorney-Client Matters volume.
l. Select form **4-15 Attorney Fee Agreement for Hourly Clients**.

m. On **Step 4** at the bottom of the window, you now have the option to select either attorney in the **Default answer set** field. This is how ProDoc fills in the attorney information related to the client/case.

D. ADDITIONAL RESOURCES

Additional ProDoc resources available to assist you in understanding more about the Default Answers feature include:

- **Default Answer Sets TechTip** ([tinyurl.com/pd-default-answers](tinyurl.com/pd-default-answers)): This TechTip provides step-by-step instructions with screenshots in use this feature.

- **Default Answer Sets Video** ([tinyurl.com/pd-defaults](tinyurl.com/pd-defaults)): This self-running video demonstrates how to use this feature.

E. REVIEW

1. True or False: Default answers are not a part of ProDoc’s database and therefore are not saved.

2. True or False: Volume questions and global questions are the same.

3. True or False: Once a default answer has been set, it cannot be changed.
Module 3 - Assignment

Assignment Description:

There are many ProDoc document questions in a law office which have the same answer, such as the law firm’s name (signature block) or the attorney’s bar number. You can save a tremendous amount of time and effort by setting default answers. In this assignment, you will set the default answers for your law firm.

Directions:

In the lesson module, you have already set default answers for firm information questions. You will now change some default answers for specific attorney information. Click Customize > Default Answers > Global Questions. Ensure the PRIMARY SET appears in the Default Answer Set field. Enter the following information in questions P0190 to P0194. Highlight each question, click Update Default Answer, enter the information, then click OK.

1. NAME of Client’s PRIMARY ATTORNEY: Sue R. Settle
2. INITIALS of client’s Primary Attorney: SRS
3. Primary attorney’s STATE BAR NO.: 84516

To see how the default answers work, you will now assemble a simple document.

4. Click the Assemble icon, then the Select case button.
5. Double-click John H. Doe as the client and double-click Criminal Defense to select that case.
6. Click the Select forms button. Click the Volume field and click the Attorney-Client Matters volume to select it.
7. Click the box or title for form 3-16 Receipt for Client’s Documents to select this form.
8. Click the OK button. On the Starting Document Assembly window, ensure Step 4 lists PRIMARY SET as the Default answer set. Click the flat blue button at the bottom of the window to reveal Step 3 and Step 4 if these steps are not visible.
9. Click the Start Assembling button. ProDoc will now ask a series of questions designed to help you complete the document.
10. SELECT the TYPE of CASE: Criminal
11. DESCRIBE John H. Doe, Jr.: male
12. NUMBER of DOCUMENTS and/or PHYSICAL ITEMS received from John H. Doe, Jr.: 1
13. DESCRIBE Primary Attorney: Sole practitioner

ProDoc will now ask a series of merge questions and display the document.

14. DATE of the receipt to be signed by John H. Doe, Jr.: Today’s Date
15. Press the Tab key to advance to the next question.
16. 1st document or physical item rcvd: **Witness statement**

17. Press the **Tab** key to advance to the next question.

18. Continue pressing the Tab key to automatically complete the balance of the document. Note how ProDoc automatically fills in the information that was stored in the database.

19. ProDoc will now display the **Completed Documents** dialog box on the screen. Click the **Continue** button to accept the default location and name.

20. ProDoc will automatically assemble the document and pass it to your word processor. Review the document and notice that the answers that you typed in are now in the assembled document.
Receipt - Blank

*{{*

ATTORNEY-CLIENT COMMUNICATION: THIS DOCUMENT AND ITS CONTENTS CONSTITUTE LEGALLY PRIVILEGED INFORMATION

______

______

______

____, _____ _____

RECEIPT

______

On _____, [/we], the attorney[s] for _____, received the following items, documents and/or physical objects:

*{{

[numbering].______

}}*

The parties acknowledge and agree that neither the attorney[s] nor the attorney[‘s/s’] [law office/law firm] assumes responsibility for the loss, destruction, deterioration, or damage to the items received. Any such loss, destruction, deterioration, or damage shall be borne by the client or the client’s insurance carrier.

Date:

_________________________________________

[client signature block]

Date:

_________________________________________

[attorney signature block]*[}
Receipt - Finished

ATTORNEY-CLIENT COMMUNICATION: THIS DOCUMENT AND ITS CONTENTS CONSTITUTE LEGALLY PRIVILEGED INFORMATION

February 19, 2011

John H. Doe, Jr.
123 Main Street
Anytown, Texas 71111

RECEIPT

Dear Mr. John H. Doe, Jr.:

On February 19, 2011, I, the attorney for John H. Doe, Jr., received the following items, documents and/or physical objects:

1. Witness statement

The parties acknowledge and agree that neither the attorney nor the attorney’s law office assumes responsibility for the loss, destruction, deterioration, or damage to the items received. Any such loss, destruction, deterioration, or damage shall be borne by the client or the client’s insurance carrier.

Date: _____________

___________________________________________

John H. Doe, Jr.

Date: ____________

___________________________________________

Sue R. Settle
123 Main Street
Suite 100
Attorneyville, Texas 71111
(210) 555-1212
(210) 555-2121 (telefax)
Texas Bar No. 84516
Module 3 - Quick Check

1. True or False: Once the default answers have been answered they cannot be changed.

2. True or False: To update all default firm information, you need to answer the default questions P0190 to P0194 and update firm information in the Options And Settings window.

3. True or False: To accept a default answer, either click the OK button or press the Enter key.
Module 4 - Document Management

A. MODULE DESCRIPTION

ProDoc provides various methods for document management. In this module, we will explore the Clients & Cases Document Manager feature and other document handling options.

B. OBJECTIVES

1. After successful completion of this module, you will be able to:

2. Explain the use of the Document Manager feature in ProDoc.

3. Demonstrate the use of the various icons on the Document Manager screen.

4. Explain the operation of the Completed Documents settings.

5. Explain how to drag and drop non-ProDoc created documents into the Document Manager.

C. PROCEDURE

1. Document settings adjustment

Complete the following steps:

   a. Click the Customize menu and select Options.

   b. Click the Completed Documents link.

   c. Review the Folder for completed documents section.

   d. Ensure that the check box is checked in the Filename of completed documents section, then click OK.

   e. Click the Document icon.

   f. Note that the left side of the window is the Client/Case selection area.

   g. Review the following functions in the Client/Case selection area:

      1. Clicking the New Client button lets you add a new client.

      2. Clicking the Update Client button lets you update the selected client’s information.

      3. Clicking the Delete Client button will delete the selected client. A confirm deletion dialog box appears to verify the deletion.

   h. Clicking the “+” sign to the left of a client’s name displays a list of the client’s available cases. Clicking the Show Cases button (at the top right of the Client/Case area) displays all cases for all clients.

      1. Clicking the New Case button lets you add a new case.

      2. Clicking the Update Case button lets you update the selected case information.
3. Clicking the **Delete Case** button will **delete** the selected case. A confirm deletion dialog box appears to verify the deletion.

i. When a case has been selected, the **Open File, Reassemble, Preview PDF, Add, Update** and **Delete** buttons become available in the **Documents for Case** section on the right side of the window.

1. Clicking the **Add** button allows you to add a document from outside of ProDoc to the **Document Manager** system.

2. Clicking the **Update** button with a document selected allows you to update the document record.
   
   i. You can specify the name of the file, the current location of the file, select an action (such as leave, rename, copy or move) to be applied to the file and select where the document is to be stored.

   ii. If the document that is selected from the document pane is not found at the current location, ProDoc will indicate this in red lettering. You can then click the file folder icon and browse in order to find the correct location for the selected file.

3. Clicking the **Delete** button with a document selected will **delete** the selected document.
   
   i. This deletes the selected document from the document list after prompting by a confirm delete dialog box.

   ii. Selecting the **Delete Document From Disk** checkbox (in the **Confirm Delete** window) allows you to permanently delete the selected document.

   iii. Select this option if you want to permanently delete the selected document from the disk along with removing the document from the list.

j. Clicking the **Open File** button will open the document that is selected in the word processor for editing.

k. Clicking the **Reassemble** button with a document selected lets you reassemble the selected document when previous case answers have been or may need to be modified. ProDoc will prompt the user to either overwrite the existing document or create a new document using the modified answers.

l. The **Preview PDF** button is inactive until you highlight a PDF document (see **Graphic Forms, Module 1**). With a PDF document selected, clicking this button opens the PDF document in your default PDF reader.

m. Clicking the **Windows Explorer** icon at the top left corner of the window (file folder with magnifying glass) will start the Windows Explorer program.

n. Clicking the **Find a Document** icon (binocular on pages) helps you search for a document or a string of text using one of two methods:

1. Clicking the **Document Text Search** radio button enables you to search for documents throughout either the **Document Manager** database or throughout any drive or folder which your computer can access.
i. Click the appropriate radio button in the **Search** section to search **Only Documents in ProDoc** or **All Documents** on your computer.

ii. You can use the remaining fields to search for specific text strings and/or file names, and you can designate drives and/or directories in which to search.

iii. After setting your criteria, clicking the **Search** button tells ProDoc to perform the search. During the search, click the **Cancel** button to stop searching. Results will be displayed on the right side of the window. Double-click a document title to open it in your word processor.

2. Clicking the **Advanced Database Search** radio button opens fields which allow you to use a variety of stored criteria to locate documents in the **Document Manager** based upon your search entries.

   i. Enter operators in the drop-down arrow fields and matching criteria in the adjacent fields.

   ii. After setting your criteria, click the **Search** button to have ProDoc search the **Document Manager** database. Results will be displayed on the right side of the window. Double-click a document title to open it in your word processor. Click the **Clear** button to clear both the criteria you have set and the documents found.

2. **Accessing the Document Manager**

   There are three different ways to access the **Document Manager**:

   a. Click **Clients & Cases** on the menu bar and then click **Document Manager**.

   b. Click the **Document** icon on the ProDoc toolbar.

   c. Click **Open Completed Document** on the **Quick Click Menu**.

3. **Drag and drop with Document Manager**

   This feature allows you to relocate a non-ProDoc document to the **Document Manager**. After the document has been dropped into the Document Manager, ProDoc will now keep track of this document. Complete the following steps:

   a. Set your preferences. Click **Customize > Options**, then **Miscellaneous Firm Settings**. Click the radio button which best suits your needs in the **Drop of a file from Windows Explorer causes the file to be** section. If you are unsure of which to choose, select **Ask what to do for each file**. Click **OK** to close the window.

   b. Open the **Document Manager**, click the **Windows Explorer** icon and browse to the location containing the non-ProDoc document. Resize the two windows to allow for the dropping and dragging of the document.

   c. To associate the document with the client level, click the client to highlight the name. To associate the document with a specific case, click the case description to highlight it.

   d. Click and drag the document to the **Title** column of the **Documents For** pane and release the mouse button. This will either move the file, copy the file, or you can select which option you want, depending on what you selected in **Step a**. above.
e. Right click the document. Notice the menu there with all of the same document modification functions previously discussed.

f. Select the Update choice. Notice that the new current location of the file is the client folder.

4. Review ProDoc document management from within the word processor

These functions require the word processor toolbar. Complete the following steps:

a. Open your word processor and look for a toolbar with five icons, similar to the graphic that follows:

With Microsoft Word 2007 and 2010 you may find this under the Add-Ins tab. If this toolbar is there, move on to the next step. If it is not:

1. Click Customize>Options, then click the Word Processor link on the left side of the window.

2. Click the button labeled Install a ProDoc® toolbar in (word processor).

3. Follow the prompts to install the toolbar.

b. Switch to the word processor and click the Save Document into ProDoc Manager icon (floppy disk with blue arrow). The Select a Case window will appear.

c. Select a client and a case in which you want to store the document. The Update Document Record dialog window will appear with the contact and case listed.

d. This window lets you enter information into ProDoc’s Document Manager when saving documents that are not created in ProDoc. If the window only displays the Document Title field, you can click the flat blue arrow button at the bottom of the window to expand it.

1. If all you want to do is add a document title, do so, then click OK to add the document to ProDoc.

2. If you expand the window, you may select the client and case, enter the document title, author, storage destination, file name and any summary information desired for the document. Click OK and the document will be added to the Document Manager.

5. Functions of the Word Processor Toolbar Buttons

- Starts ProDoc or brings ProDoc into focus if it is already running.
- Starts a new document.
- Opens an existing document.
- Saves the open document into ProDoc’s Document Manager.
- Search for documents using key words or advanced matching options.
D. REVIEW

1. Which icon/button is used to reassemble the document once an answer has been changed?

2. What is the difference between using the **Delete** button/icon for a highlighted document and using the **Delete Document From Disk** check box?

3. Explain the process of switching from your word processor to ProDoc using the ProDoc toolbar.
Module 4 - Assignment

1. Assignment Description:

ProDoc allows the user to manage documents that are created both from within ProDoc and from the word processor. In this assignment you will learn how to work with documents using the Document Manager feature.

2. Directions:

Setting up a demonstration client

1. Add Robert J. Smith, Jr. as a client using the Client/Case Manager.
   a. Enter the first and last names, middle initial and suffix.
   b. Under the cases tab, add a case description of Landlord.

   a. Use the following information to assemble the document:
      i. Your client is the only plaintiff.
      ii. There is one defendant, Terry Tenant.
      iii. The opposing counsel’s name is Dewey Van Horn and Dewey was served by certified mail.
      iv. Dewey’s address is 425 Soledad Street, San Antonio, Texas 78205.
      v. Enter no cause number yet.
      vi. Justice of the Peace in Precinct 5, Bexar County, Texas.
      vii. $100 Jury fee.
   b. After the document has been assembled, view the document in the word processor.

3. Working with the Clients & Cases Document Manager

1. Click the Document icon (file folder with pages on top).

2. Select Robert J. Smith, Jr. in the client’s list.
   a. Click the Update Client button to update the name and address.
   b. Type the appropriate information in the street address, city, state and zip code fields, using the following: 145 Center Street, San Antonio, Texas 78188.
   c. Click OK to finish updating that information.

3. Click the New Client button to add another client.
   a. Add Mrs. Susan Smith as a client and add her case, a Will.
   b. Click OK after adding her and her case.
4. To add another case for this client:
   a. Click the Will case and then click the New Case button.
   b. When the Case Will Be Added window appears, type Probate as her new Case Description. Notice that Mrs. Smith has two cases now, Will and Probate.

5. To delete a case from the list:
   a. Click the Will case and then click the Delete Case button.
   b. Confirm that you want to delete the case by clicking Yes.

6. To delete a client from the Document Manager:
   a. Highlight the client you wish to delete and click the Delete Client button.
   b. Delete Mrs. Smith. Notice that this also deletes the remaining case.

7. To modify a saved document record:
   a. Click Robert J. Smith, Jr. in the client list.
   b. Click the Landlord case.
   c. Click once on the Request for Jury Trial document on the right side (double-clicking the document’s title will open the document in your word processor) and click the Update button.
   d. In the Update Document Record window, add the date at the end of the Document Title. It should look like this: Request for Jury Trial, 8/4/2011. Click OK to close the dialog box.

8. To open a selected document:
   a. Double-click the document title, or
   b. Highlight the document and then click the Open File button.

9. Clicking the Windows Explorer icon (folder with magnifying glass) will open Windows Explorer, which will allow you to view files and folders.

10. Clicking the Find a Document icon (binoculars) will allow you to search for a document in one of two ways: search throughout any drive or folder which your computer can access, or search Document Manager’s database.
   a. To search for a document that contains the word request, click the Find a Document icon, then:
      i. Select the Document Text Search and All Documents radio buttons.
      ii. Type request in the Text to search for field.
      iii. In the Directory to search field, make sure the path is C:\Clients\ (or where you store your client documents; ask your instructor if you are not sure where these are stored).
      iv. Click the Search button.
      v. ProDoc will find one match. The bottom left portion of the window will display the client and case: Robert J. Smith and Landlord.
b. To search Document Manager’s database for a document title containing Request:
   i. Select the Advanced Database Search radio button.
   ii. Type Request in the Title row search criteria field. Leave the operator as Contains.
   iii. Click the Search button.
   v. The Document Text Search looks wherever you wish to search.
   vi. The Advanced Database Search will only search for files contained in the Document Manager.

11. Once a document is found, you can double-click the document title to open the document in your word processor.
REQUEST FOR JURY TRIAL

This request for setting of jury trial is filed by Robert J. Smith, Jr. and shows:

1. The jury fee of $100.00 has been paid.

2. This request is made not later than five days after service of citation upon defendant.

Respectfully submitted,

Sue R. Settle, Attorney at Law
123 Main Street
Suite 100
Attorneyville, Texas 71111

Certificate of Service

I certify that on November 4, 2011, a true copy of this Request for Jury Trial was served on Dewey Van Horn, 425 Soledad Street, San Antonio, Texas 78205, by certified mail, return receipt requested in accordance with the Texas Rules of Civil Procedure.

Sue R. Settle
Module 4 - Quick Check

1. True or False: The **Document Manager** can only keep track of documents created in ProDoc.

2. True or False: You can delete a client and case from the **Document Manager** feature.

3. True or False: The pencil icon is used to add a new item in the **Document Manager**.

4. In the **Document Manager**, if you have a client selected but you do not see any documents that have been created, what should you do?
Module 5 - Searching for Forms

A. MODULE DESCRIPTION

There are two methods of searching for a form in ProDoc. One method is searching for a specific word or phrase in a form; the other is searching for a form when you do not know which volume to search.

B. OBJECTIVES

After successful completion of this module, you will be able to:

1. Demonstrate how to search for a specific form.
2. Demonstrate how to search forms for a specific string of text.

C. PROCEDURE

1. Searching for a string of text in a volume

Complete the following steps:

a. From the File menu, select Find Forms.

b. Select the volume to search by clicking the box next to the Attorney-Client Matters volume.

c. In the Search for field, type New and click the Search button.

d. If the Search titles only checkbox is checked, ProDoc will only search for the selected text in the titles of the forms. If the box is unchecked, ProDoc will search all forms in the selected volume for the text and then display the results.

e. You can scan more than one volume by selecting more than one volume.

f. During the search of the Attorney-Client Matters volume, ProDoc will find a few forms that contain the text New in the title of the form.

g. Note the way the information is presented on the results screen, i.e. form title, volume information, and form number. You can see which volume the form is located in and the form number.

h. Click the first form (it should be 3-15), then click the View button to view the form. While viewing the form, you can either open it in your word processor or close the window. Close the window.

i. If you want to search for a word or string of words in each form, you can uncheck the Search titles only box before searching. Do this now.

j. Enter Spouse in the Search for field and click the Search button. ProDoc will display several instances of the word Spouse found in text of the forms for the Attorney-Client Matters volume.
k. Notice that the results list is in the same format as the results from a titles-only search.

l. Close the Search Results window by clicking the Close button. Close the Search window by clicking the Close button.

D. ADDITIONAL RESOURCES

Additional ProDoc resources available to assist you in understanding more about the Finding Forms feature includes:

- Finding Forms TechTip (tinyurl.com/finding-pd-forms): This TechTip provides step-by-step instructions with screenshots in use this feature.

E. REVIEW

1. Describe the procedure used to search for a form in a volume using the Search titles only option.

2. Describe the procedure for searching multiple volumes for a string of text while not using the Search titles only option.
Module 5 - Assignment

A. ASSIGNMENT DESCRIPTION:

In this assignment, you will search for a form when you do not yet know exactly which form you need. You only know a word in the form you wish to find, but not the whole title of the form.

B. DIRECTIONS:

1. From the File menu, click Find Forms.
2. When the Search window appears, select the Landlord and Tenant volume.
3. In the Search for field, type Eviction, then click the Search button.
4. ProDoc should find three forms with the word Eviction in the title. Click 1-2 Citation for Eviction, then click the View button.
5. ProDoc will display a blank copy of the document on the screen.
6. Click the word processor button at the bottom of the window to send the document to the word processor.
7. Once the document is displayed in the word processor, notice the blanks in the text on the form. This is where the answers will be placed during the assembly phase. A copy of the blank document is provided in this module.
8. Close the word processor. Click Close to close the Search Results window. Click Close to close the Search window.
9. Assemble your own copy of the Citation for Eviction, using the worksheet in this module, the Assemble icon, and the John H. Doe, Jr. Criminal Defense case. Print a copy of the finished assembled document and compare it to the finished document from this module.
Citation for Eviction - Blank

EVICTION CITATION
THE STATE OF TEXAS

To:

[NAMES OF DEFENDANTS]

____, ______, ______

You have been sued. You may employ an attorney. If you or your attorney do not file an answer with the Court which issued this citation by 10:00 a.m. on the seventh day after you were served this citation and petition, a default judgment may be taken against you. The nature of the Plaintiff’s demand in brief is as follows:

Suit by Plaintiff to evict you and regain possession of the premises you occupy. A suit for rent may be included. Please review attached petition.

ANSWER MAY BE A WRITTEN OR ORAL DENIAL IN PERSON AT THE ADDRESS BELOW OR BY PHONE AT ______

Your cause is styled:

[Caption]

Suit was filed on ______.

In order to obtain a jury trial, you must request one and pay a jury fee no later than 5 days after you are served with this citation.

FAILURE TO APPEAR FOR TRIAL MAY RESULT IN A DEFAULT JUDGMENT BEING ENTERED AGAINST YOU.

Issued: ______

_____________________________
Justice of the Peace, Precinct No. ______
______ County, Texas
______

Plaintiff Attorney/Agent:
* [Attorney Name: ______
Address: ______
______, ______  ______
Telephone Number: ______]*

* [Landlord Name: ______
Address: ______]
OFFICER’S RETURN

Came to hand on ___________________________ at ___________________________ and executed at within ______ County, Texas at ___________________________ on __________________________ by delivering to [NAMES OF DEFENDANTS] a true copy of this citation together with the accompanying copy of the petition, having first attached such copy of such petition to such copy of citation and endorsed on such copy of citation the date of delivery.

_____________________________
Deputy Constable
Precinct No. ______
Citation for Eviction - Worksheet

Form: Citation for Eviction

The following questions are included in the assembly phase for this document:

1. NUMBER OF clients in this case: 1
   - Is SUIT FILED by ATTORNEY or LANDLORD/REPRESENTATIVE?
     - [✓] 1 - Suit is filed by attorney
     - [ ] 2 - Suit is filed by landlord or landlord’s agent

2. NUMBER OF plaintiffs: 1

3. Plaintiff’s FULL NAME: John H. Doe Jr.

4. NUMBER OF defendants: 1

5. Defendant’s FULL NAME: Terry Tenant

The following additional questions are included in the merged phase for this document:

6. What is the STREET ADDRESS for the TENANT(S)? 12006 North Main St.

7. What is the CITY of the TENANT(S) address? Middleville

8. What is the POSTAL CODE STATE for the TENANT(S) Address? TX

9. What is the ZIP CODE of the ADDRESS for the TENANT(s)? 75391

10. What is the TELEPHONE NUMBER of the COURT? (498) 469-5555

11. What is the CAUSE NUMBER under which the suit will be filed?

12. What is the PRECINCT NUMBER in which case is filed? 02

13. What is the COUNTY in which PROPERTY is LOCATED? Square

14. What is the DATE on which the Suit was FILED? 04/04/11

15. What is the DATE on which CITATION was ISSUED? 04/04/11

16. What is the NAME of the JUDGE? Roy Bean

17. What is the ADDRESS of the COURT (line form)? 101 Legal Avenue
Citation for Eviction - Finished

**EVICTION CITATION**

**THE STATE OF TEXAS**

To:

TERRY TENANT

12006 North Main St., Middleville, TX 75391

**SUIT TO EVICT**

THIS SUIT TO EVICT INVOLVES IMMEDIATE DEADLINES. CALL THE STATE BAR OF TEXAS TOLL-FREE AT 1-877-9TEXBAR IF YOU NEED HELP LOCATING AN ATTORNEY. IF YOU CANNOT AFFORD TO HIRE AN ATTORNEY, YOU MAY BE ELIGIBLE FOR FREE OR LOW-COST LEGAL ASSISTANCE.

DEMANDA PARA DESALOJO

ESTA DEMANDA PARA DESALOJO IMPLICA FECHAS LIMITADAS PARA RESPONDER. SI USTED NECESITA AYUDA PARA ENCONTRAR UN ABOGADO, LLAME AL “STATE BAR OF TEXAS” AL NUMERO DE TELÉFONO GRATUITO 1 877 983 9227. SI USTED NO TIENE SUFICIENTE RECURSOS PARA OBTENER UN ABOGADO, PODRÍA CALIFICAR PARA ASISTENCIA LEGAL GRATIS O ECONÓMICA.

You have been sued. You may employ an attorney. If you or your attorney do not file an answer with the Court which issued this citation by 10:00 a.m. on the seventh day after you were served this citation and petition, a default judgment may be taken against you. The nature of the Plaintiff’s demand in brief is as follows:

- Suit by Plaintiff to evict you and regain possession of the premises you occupy. A suit for rent may be included. Please review attached petition.

**ANSWER MAY BE A WRITTEN OR ORAL DENIAL IN PERSON AT THE ADDRESS BELOW OR BY PHONE AT (498) 469-5555.**

Your cause is styled:
Suit was filed on 04/04/07.

In order to obtain a jury trial, you must request one and pay a jury fee no later than 5 days after you are served with this citation.

FAILURE TO APPEAR FOR TRIAL MAY RESULT IN A DEFAULT JUDGMENT BEING ENTERED AGAINST YOU.

Issued: April 4, 2011

Roy Bean
Justice of the Peace, Precinct No. 02
Square County, Texas
101 Legal Ave.

Plaintiff Attorney/Agent:

Attorney Name: Maxie Field
Address: 962 Coronado Blvd
Universal City, Texas 78148
Telephone Number: (800) 759-5418

OFFICER’S RETURN

Came to hand on ___________________________ at ___________________________ and executed at ___________________________ ___________________________ within Square County, Texas at ___________________________ on _______________________ by delivering to TERRY TENANT a true copy of this citation together with the accompanying copy of the petition, having first attached such copy of such petition to such copy of citation and endorsed on such copy of citation the date of delivery.
Module 5 - Quick Check

1. True or False: When using the search forms feature, you can only search for one word at a time.

2. True or False: When using the search forms feature, you can search multiple volumes at one time.

3. True or False: After a search has been completed and the results are shown on the screen, you can click the desired document and it will open automatically in your word processor.
Module 6 - Editing Case Answers

A. MODULE DESCRIPTION

One of the most powerful features of ProDoc is the ability to edit answers that have already been stored in ProDoc's database. Once an answer has been changed, you can reassemble the document, or create a new document, and the correct information will be included.

B. OBJECTIVES

After successful completion of this module, you will be able to:

1. Demonstrate how to print a case data sheet.
2. Demonstrate how to locate a specific question or answer and the answer that needs to be changed using the Find buttons.
3. Describe the procedure used to reassemble a document once an answer has been changed.

C. PROCEDURE

1. How to print a case data sheet

To assist in locating specific answers or stored data that needs to be changed, print a case data sheet for the John H. Doe, Jr., Criminal Defense case. You can then quickly scan the sheet and locate answers that need to be changed.

Complete the following steps:

a. Click Print and select Case Data Sheet.

b. Click the Select Case button.

c. Click the “+” sign to the left of John H Doe, Jr., then the Criminal Defense case, and then click the Select Case button at the bottom of the window.

d. If you wish to preview the document on screen before printing, place a check mark next to Print Preview.

   1. Choose Yes and you will be taken to a Preview page on which you can view the document as it will be printed. Use the Page Navigator feature to move from page to page in the Preview mode. Complete the print job when you are finished with your review.

   2. Choose No to skip the Preview and complete the print job.

e. Click the Print button. Click OK in the Report Destination window.

f. This case data sheet will display all of the questions for all of the documents for the selected case. Next, click the printer icon on the toolbar to print the report.

g. To change the answers to a case, click the Clients & Cases menu choice and click Case
Answers.

h. Select the same case as you did in Step 3.

i. This will display a Change Answers For: window. The window will display all case
questions with their associated token (question) numbers and answers.

j. Locate the question with token A0630 using the procedures below:

1. Click the Find Question button to locate the question by entering a token, word or
phrase. Enter physical in the Find What field and click Find Next. The question with
token A0630 will be highlighted.

2. You can also use the Find Answer button in the same manner. Click the first line entry
in the window to move the highlight to it. Click the Find Answer button, enter 1 and
click Find Next. Click the Find Next button until the question with token A0630 is
highlighted.

3. Note that if the question you wish to change is displayed, you can simply click it to
highlight it. You can also scroll through the questions by using the scroll bar on the
right side of the window.

k. Once that question has been located, click the View/Edit Answer button to select the
question A0630V, NUMBER of Documents and/or physical items received from the 1st
client. Change the answer to 2 and click OK.

l. You can use the Find Previous and Find Next buttons to find previous and next matching
instances of questions (or answers, depending on your choice). Click the Find Next
button. A1000G, NUMBER of Plaintiffs, will be highlighted. Since there is only one
plaintiff, do not change the answer.

m. Click the Close button on the Search the Answers window. Click the Close button on the
Change Answers For: window.

n. ProDoc will ask if you would like to save your answers and permanently delete any deleted
answers. Click Yes.

o. You will now reassemble the document with the new answers. Click the Document icon
and then:

1. Highlight the same case. Click the “+” sign next to John H. Doe, Jr., then click the
Criminal Defense case, and then click the document Receipt for Client’s Documents
on the right-hand side.

2. Click the Reassemble button. ProDoc will ask if you want to overwrite the existing
document or create a new one. Select Overwrite the same Document.

3. Uncheck the box to review your previous answers, then click OK.

p. ProDoc will now assemble the document and display it on the screen.

q. Verify that the changes you made are shown in the merged document. Use the Tab key to
move through the merge phase questions and accept the answers or blanks which appear.
r. Click **Continue** on the **Completed Documents** window.

s. ProDoc will open the document in the word processor for review. The answers you changed will appear in the appropriate locations on the document. Compare this document with the **Receipt for Client’s Documents - With Changes** document in this module.

D. ADDITIONAL RESOURCES

Additional ProDoc resources available to assist you in understanding more about the **Editing Case Answers** feature include:

- **Print Case Data Sheet TechTip** ([tinyurl.com/pd-case-data](http://tinyurl.com/pd-case-data)): This TechTip provides step-by-step instructions with screens shots in use this feature.

- **Editing Case Answers TechTip** ([tinyurl.com/pd-edit-answers](http://tinyurl.com/pd-edit-answers)): This TechTip provides step-by-step instructions with screens shots in use this feature.

- **Revising Finished Documents TechTip** ([tinyurl.com/pd-revise-docs](http://tinyurl.com/pd-revise-docs)): This TechTip provides step-by-step instructions with screens shots in use this feature.

- **Edit Case Answers Video** ([tinyurl.com/pd-edit-case-answers](http://tinyurl.com/pd-edit-case-answers)): This self-running video demonstrates how to use this feature.

E. REVIEW

1. What is the procedure to print a case data sheet?

2. How can you find a specific question when you are reviewing case answers?

3. What is the procedure for reassembling a document once an answer has been changed?
Module 6 - Assignment

A. ASSIGNMENT DESCRIPTION:

One of the most common tasks in document assembly is changing an answer to a question once the document has been assembled. In this assignment, you will change a number of answers in a previously assembled document and then reassemble the document.

B. DIRECTIONS:

The attorney has decided to change a few of the answers that are in the assembled document. Edit case answers for the John H. Doe, Jr., Criminal Defense case. Using what you have learned in the manual, locate each of the questions listed below and make the indicated changes. Review a copy of the printed document so you can see where the changes need to be made. (Hint: Use the Find feature in Edit Case Answers to locate each of the questions that need to be changed.)

1. Make the following changes:
   a. Remove the dollar sign in $500, the answer to P0384V AMOUNT charged for an initial consultation.
   b. Remove the dollar sign in $250, the answer to P0374V AMOUNT charged per hour for primary attorney.
   c. Change the client’s salutation to Dear Mr. John H. Doe, Jr.: in the question associated with Token P0134.

2. Once these changes have been made:
   a. Click Close, Yes to save the changes.
   c. Overwrite the existing document and do not review the previous answers.
   d. Use the Tab key to move through any merge phase questions that appear to accept answers or blanks. When the document is displayed in the word processor, print a final copy for your instructor to review.
   e. Compare this final document with the New Client Letter - With Changes document in this module.
February 19, 2011

John H. Doe, Jr.
123 Main Street
Anytown, Texas 71111

RECEIPT

Dear Mr. Doe:

On February 19, 2011, I, the attorney for John H. Doe, Jr., received the following items, documents and/or physical objects:

1. Witness statement
2. _________________________________________________________

The parties acknowledge and agree that neither the attorney nor the attorney’s law office assumes responsibility for the loss, destruction, deterioration, or damage to the items received. Any such loss, destruction, deterioration, or damage shall be borne by the client or the client’s insurance carrier.

Date: _______________________

__________________________________________________________
John H. Doe, Jr.

Date: _______________________

__________________________________________________________
Ima Student
123 Main Street, Suite 100
Attorneyville, Texas 71111
(210) 555-1212
(210) 555-2121 (telefax)
Texas Bar No. 12345
January 31, 2011

John H. Doe, Jr.

123 Main Street

Anytown, Texas 71111

NEW CLIENT INFORMATION LETTER

Re: Criminal Case

Dear Mr. John H. Doe, Jr.:

I am pleased that you have chosen my law office to represent you in your criminal case. The purpose of this letter is to provide you with some general information on my law office’s policies and procedures, and a broad explanation on the method used by my law office to charge for my services.

Outcome or Results

Due to numerous and complicated factors which are beyond my control, I cannot guarantee a favorable outcome in any litigation matter that I am handling for you. I will, however, within the bounds of legal ethics, provide reasonable and competent services to represent and protect your legal interests. In the event the matter requires negotiation or involves litigation, I will negotiate with the prosecuting attorney to achieve a satisfactory resolution of the charge. I will not plea bargain the charge without your approval.

In order for me to represent you competently, please do not communicate with any of the parties, witnesses, insurance companies, adjustors, investigators or attorneys in the case without my involvement.

Office Appointments

Many legal matters can be handled by telephone, fax transmissions or mail in order to avoid numerous personal trips to and from the office. It is more productive to handle routine matters by phone as opposed to personal visits because it saves each of us time.

In the event you need to meet personally with me or a staff member, feel free to do so. Simply make an appointment with the administrative assistant, who will schedule an appropriate time on my calendar.
Initial Consultation

My law office charges $500.00 for an initial consultation with a client. The consultation includes meeting the client, ascertaining the facts which gave rise to the charge, analyzing the situation, and advising the client what, if any, services the law office may be able to perform on the client’s behalf.

Client Availability

In order to properly represent you, you agree to keep my office advised of your whereabouts during both day and evening hours by providing me with current business and home telephone numbers. In the event the matter involves litigation, you may be required to attend court appearances and comply with discovery requests and deposition notices.

Fee Determination

Some or all of the following factors may be taken into account when determining a fee structure and setting a fee:

1. The time and labor required, the novelty and difficulty of the questions involved, and the skill requisite to perform the legal service properly.
2. The likelihood, if apparent to the client, that the acceptance of the particular employment will preclude other employment.
3. The fee customarily charged in the locality for similar legal services.
4. The seriousness of the case.
5. Time limitations imposed by the client or by circumstances.
7. Experience, reputation and ability of the lawyer or lawyers performing the services.
8. Type of fee structure (fixed fee or hourly rate).

Types of Fee Structures

The fee structure may be based on a flat rate (sometimes called “value billing”), or on an hourly rate.

Flat Rate: A flat rate is a one-time payment to cover all of the costs of handling a specific legal matter such as an incorporation, an uncontested bankruptcy, or a divorce.

Hourly Rate: An hourly rate is an hourly charge for all the attorney’s time devoted to handling a specific case.

Flat Rates (Value Billing)

Flat rates are used primarily in routine, uncomplicated legal matters. A flat fee is always based on certain specific assumptions. If those assumptions are incorrect, changed, or modified, then the attorney must revert to an hourly rate since he cannot provide competent professional services as requested and needed under a flat fee arrangement.

For example, a flat fee for a DUI charge might include: a preliminary investigation into the
facts and circumstances of the case; legal research; advice to the client regarding the case and any offers of plea bargain; and, a plea of guilty or no contest to the charges or to some lesser included offense that disposes of the charges.

However, if the matter cannot be resolved by plea bargain, then the flat fee arrangement would no longer apply due to the changed circumstances. In such a situation, I would apply the flat fee as a retainer or deposit against the total fee owed. Once the hourly rate fee exceeds the monies previously collected, I would bill the client at the stated hourly rate based on the time spent on the case.

Current Hourly Rates

Ima Student $250.00

Hourly rates are reviewed from time to time and adjusted as and when appropriate. When an adjustment is required, you will be notified and advised accordingly.

Regulation of Attorneys

Attorneys are regulated by the State Bar of Texas per the State Bar Act. Clients have certain rights and privileges under the Act. The State Bar of Texas investigates and prosecutes professional misconduct committed by attorneys. Although not every complaint against or dispute with a lawyer involves professional misconduct, the State Bar’s Office of Chief Disciplinary Counsel will provide you with information about how to file a complaint if you believe one is necessary. For more information about your rights as a client, you may call the State Bar, toll free, at 1-800-932-1900.

Conclusion

I hope this letter has answered any questions that you may have had regarding how attorneys charge for their legal services and how I have agreed to handle the legal matter. If you have any questions concerning any other matters, please call me at (210) 555-1212.

Once again, I am delighted that you have decided to use my services, and I look forward to working with you.

Very truly yours,

__________________________________________
Ima Student

Receipt acknowledged on this ______________________ day of ______________________ 2011.

__________________________________________
John H. Doe, Jr.
Module 6 - Quick Check

1. True or False: When changing answers using the Edit Case Answers method, you can only change one at a time.

2. True or False: After changing your answers, you must save your changes if you want them to be updated in the database.

3. Which ProDoc feature do you use to reassemble the document after you have changed an answer?
Module 7 - Optimizing ProDoc Settings

A. MODULE DESCRIPTION

To obtain the best performance, ProDoc needs to be set up to take advantage of certain settings. These settings include: default answer sets, document assembly settings, default word processor settings, personal settings and firm settings.

B. OBJECTIVES

Upon successful completion of this module, you will be able to:

1. Review the function and use of default answer sets.
3. Configure the default word processor program.
4. Install a ProDoc toolbar in the word processor.

C. PROCEDURE

The first three sections, Default Firm Information, Default Answers and Default Answer Sets, are a review of Module 3 information. At this point, you may want to lead a classroom discussion or demonstration for setting up firm information, default answer sets, and default answers. If your students are comfortable with these topics, feel free to proceed to the section titled Modifying Document Assembly Options. If you need a review of Module 3, review or complete steps in Module 3 without changing any information or answers. Please do not change firm information or default answers until your class works through the Module 7 Assignment.

• Default Firm Information. Certain firm information fields are entered during software installation. These can only be changed in the Options And Settings window. To access firm information, click Customize > Firm Information to open the window. Review the information in the Firm Information fields on the right side of the window.

• Default Answer Sets. These allow each attorney in the firm to have a different set of saved answers. To set up a default answer set, click Customize on the main menu, then Default Answers and Default Answer Sets. You can copy another attorney’s set or the Primary Set if desired. Note that the Primary Set cannot be renamed or deleted.

• Default Answers. These can be set as needed for global, volume or supplemental questions. A common use of this feature is to save default answers for different attorneys in the firm. To change default answers, click Customize > Default Answers, then choose the category you wish to use. Common answers to change in Global Questions are P0190-P0194, which deal with attorney information.

1. Personal Settings

Complete the following steps:
a. **Assembly Settings**

1. From the **Customize** menu, choose **Options**. **Assembly Settings** will be displayed as the first screen under the **Personal Settings** section.

2. You can select which default answer set will be the primary set for ProDoc. There is only one set to start with if there is only one attorney. Leave the **Primary Set** as the default.

3. Verify that the first four check boxes are checked (starting at the top of the page and working downward).
   
   i. **Insert placeholder** - You can change the placeholder; e.g. blank line.
   
   ii. **Show assembled document during merge phase** - Allows you to view the document as the document assembly progresses into the merge phase.
   
   iii. **Add assembled document to most recently used file list** - This places the document in the word processor’s recently opened file list.
   
   iv. **Switch to Word Processor/PDF Viewer after assembly** – Switches system focus to the word processor once the document is finished assembling.

4. Check the **assemble RTF document** if using Microsoft Word box if you are using Microsoft Word.
   
   i. Check **Review prior answers**. This allows you to see and change answers carried over from previous documents.
   
   ii. **DDE Timeout**. This setting controls communications between ProDoc and your word processor. Do not change this setting unless you are talking with technical support technicians at ProDoc.

b. **Word Processor**

1. Usually, the word processor used for class will already be selected. If you need to change this, select the desired word processor from the drop down list. If it is not listed, click the **Help** button for help with finding and installing the desired word processor.

2. Click the large button at the bottom to install the ProDoc toolbar and menu in the selected word processor.

c. **Completed Documents**

1. Verify the folder for storing completed documents. The default is **C:\Clients**. If you prefer a different location, you can enter it here.

2. Verify the folder name components for completed documents. Folder name components are the folder specified above, plus any number of alternative options.

3. Verify that **Use form title for filename** is checked.

4. Verify that **Specify filename extension** is checked. Use **doc** as the default for **Microsoft Word**. Use **wpd** for **WordPerfect**.

d. **Graphic Forms**

   Normally you would use the existing defaults. If desired, you can change print options, fonts,
styles and zoom percentage.

e. **Miscellaneous Personal Settings**

   1. Three options exist for navigation shortcuts:
      
      i. **Quick Start Assistant (Beginner)** is designed to help new users assemble documents very quickly with step-by-step help.
      
      ii. **Quick Click Menu (Advanced)** is designed to help more advanced users quickly find essential functions.
      
      iii. **None** is provided for users who don’t want to use any navigation shortcuts.

   2. If a commercial PDF reader (such as Adobe Acrobat Reader) is installed on the computer, uncheck the box titled **Use the ProDoc Reader to View PDF Documents**. If not, check the box in order to view PDF documents.

   3. **Restore Window Position** opens a window giving you the option to reset all windows to their default positions.

   4. **Reset Volume Banner Screens** opens a window where you can choose to show all banner screens or leave their individual settings intact.

   5. **Reset Legal Size Reminder** opens a window where you can choose to display or not display ProDoc’s legal size paper reminder when you print a form requiring this paper size.

2. **Firm Settings**

Under the **Firm Settings** section of the **Options And Settings** window:

a. **Backup**

   1. Always check **Auto Backup at exit** if you are not using SOS. If you are using SOS, you should disable backup in ProDoc and perform all backups in SOS because SOS backs up all ProDoc and all SOS data fields. If this option is selected, the remaining backup options are enabled.

   2. **Days between backups** specifies how many days to skip between performing automatic backups. No backup is done if the difference between the current date and the date of any existing backup copies is less than the frequency. If the frequency is zero, a backup is always done.

   3. **Station triggering automatic backups** should always contain the log in information of a person who regularly uses ProDoc.

   4. **Backup folder** specifies the folder which receives the backup files.

b. **Small Office Suite (SOS)**

   1. If you are using SOS, check the box titled **Enable the Generation of charge slips in SOS for documents assembled**.

   2. In **Module 16** you will learn how to set form prices here.

c. **Timeslips**
1. Timeslips users should check the box to **Enable the Timeslips** connection.

2. Click the **Help** button to see an overview of the settings for this window.

d. **Phone Types**

   1. ProDoc allows additional phone types to be added beyond what is listed, such as a second office number.

   2. Insert a **Spouse** phone type by clicking the **New** button, typing in **Spouse** and then pressing the **Tab** key.

e. **Clients & Cases**

   1. For lesson purposes, place a check in the boxes to **Use unique Client ID’s to identify clients** and **Use unique Case ID’s to identify cases**.

   2. You can uncheck the boxes to disable the functions in the future.

f. **Custom Fields**

   1. A total of 12 custom fields can be configured: six for **client custom fields** and six for the **case custom fields**.

   2. Type in **DOB** (for date of birth) in the **Custom Client 1** field and **SSN** (for social security number) in the **second field**.

   **NOTE:** If you decide at a later date to change the fields, the title change could make the information stored in these fields meaningless.

g. **Firm Information**

   Complete the fields with your fictitious firm information. Some of these fields may have been completed during program installation.

h. **Miscellaneous Firm Settings**

   1. ProDoc will show and describe logically related forms in certain specific volumes when the **Show Logically Related Forms** is checked. This occurs when certain forms are assembled, and the user can then easily choose to assemble the related forms.

   2. Select the number of days of lead time to choose to receive notification of volume expiration. The default of 30 days is a good choice.

   3. For maximum flexibility when dragging documents into the **Clients & Cases Document Manager**, click the radio button labeled **Ask what to do for each file**.

I. **ADDITIONAL RESOURCES**

Additional ProDoc resources available to assist you in understanding more about **Customizing/Optimizing ProDoc Settings** include:

- **Customize ProDoc Settings TechTip** ([tinyurl.com/pd-custom-settings](tinyurl.com/pd-custom-settings)): This TechTip provides step-by-step instructions with screens shots in use this feature.

- **Customizing Firm Information Video** ([tinyurl.com/pd-settings-firm](tinyurl.com/pd-settings-firm)): This self-running video demonstrates how to use this feature.
• **Customizing Personal Information Video** ([tinyurl.com/pd-custom-personal](tinyurl.com/pd-custom-personal)): This self-running video demonstrates how to use this feature.

**J. REVIEW**

1. True or False: You can only have one answer set in ProDoc.

2. Name a situation for which you should enable backup in ProDoc.
Module 7 - Assignment 1

A. ASSIGNMENT DESCRIPTION:

You will optimize some settings (specifically Default Answers) to see how optimization can help you work with ProDoc more efficiently.

You will then draft a document.

B. DIRECTIONS:

You are a recently hired law office staff member, you have a copy of ProDoc on your new computer, and you need to optimize it so you can complete your work more efficiently. Complete the following tasks to ensure that ProDoc settings are correctly configured.

c. Make the following changes:
   1. Set up a default answer set for a new attorney: Jean Johns, Attorney at Law.
   2. Her state bar number is 12341234.
   3. Keep the other default answers the same as the other attorneys in the practice.

d. After adding Jean Johns, make her set the default answer set.

e. Set the placeholder to _______________ (a series of 12 underscores).

f. Set to show assembled document during merge phase.

g. Set to add assembled documents to recently used file list.

h. Set to switch to the word processor after assembly.

i. Add the ProDoc toolbar to your word processor.

j. Change the directory for completed documents to C:\ProDoc (check with your instructor to verify this location).

k. Fill in the firm information tab fields with the following information.

The Law Firm of Dewey, England and Smith, 2222 S. Court St., Dallas, Texas 77772; (972) 888-8888, (972) 888-7777 (fax).

l. Set up a custom field for TXDL# and Other.

m. Add Parents’ Home for a new phone type.

When you are finished, change the directory for completed documents back to C:\Clients.

1. Your Assignment

Your firm has been retained to create a new business entity for the 5th Street Partnership. They want you to generate for them an Agreement to Incorporate Partnership.

   1. Create a New Client and Case:
i. **5th Street Partnership** - a business name, not an individual
   
i. **Address:** *515 Elm St, Ste 500, Dallas, TX 77520*
   
iii. Create a New Case: Description - **New Business Formation**

a. Click the **Assemble Document** button

b. Select the **5th Street Partnership** client and **New Business Formation** case.

c. Under **Select forms** select the **Business Transactions Solutions** volume

d. Click the **Alphabetical** Tab and begin typing **Agreement to ..**

At this point the selector has moved to **Agreement to Incorporate Partnership** so select it and click **OK**.

e. Select **Jean Johns** as the **Default answer set**.

f. Begin the assembly session using the data on the **Agreement to Incorporate Partnership Worksheet**.

g. As you are answering the questions, set any answers denotes with a **D** as a **Default Answer** to be added to **Jean Johns Default Answer Set** for this volume.

h. In this case you do not yet have all the information you need to complete the document so **tab** through any questions where the information is not furnished on the worksheet or is not already defaulted in.

A copy of the completed form is attached. Note the placeholders in the place of the data you do not yet have.
### ASSIGNMENT 1 - WORKSHEET

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELECT the BUSINESS STRUCTURE of 5th Street Partnership:</td>
<td>Corporation</td>
<td></td>
</tr>
<tr>
<td>NUMBER of SHAREHOLDERS</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>NUMBER of OFFICERS</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>NUMBER of PARTNERS</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Do you want the document ACKNOWLEDGED by a NOTARY PUBLIC?</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>NAME of the COMPANY for which you are preparing documents:</td>
<td>5th Street Partnership</td>
<td></td>
</tr>
<tr>
<td>NAME under which the COMPANY will operate:</td>
<td>Gravity Forces</td>
<td></td>
</tr>
<tr>
<td>NAME of the First SHAREHOLDER:</td>
<td>Bill Bennett</td>
<td></td>
</tr>
<tr>
<td>NAME of the Second SHAREHOLDER:</td>
<td>James Sakel</td>
<td></td>
</tr>
<tr>
<td>NUMBER of SHARES owned by Bill Bennett:</td>
<td>10,0000</td>
<td></td>
</tr>
<tr>
<td>NUMBER of SHARES owned by James Sakel:</td>
<td>100,000</td>
<td></td>
</tr>
<tr>
<td>NAME of the First OFFICER:</td>
<td>Bill Bennet</td>
<td></td>
</tr>
<tr>
<td>NAME of the Second OFFICER:</td>
<td>James Sakel</td>
<td></td>
</tr>
<tr>
<td>TITLE of Bill Bennet:</td>
<td>President</td>
<td></td>
</tr>
<tr>
<td>TITLE of James Sakel:</td>
<td>Vice President</td>
<td></td>
</tr>
<tr>
<td>NAME of the First PARTNER:</td>
<td>Bill Bennett</td>
<td></td>
</tr>
<tr>
<td>NAME of the Second PARTNER:</td>
<td>James Sakel</td>
<td></td>
</tr>
<tr>
<td>STREET ADDRESS where Bill Bennet RESIDES:</td>
<td>2348 Von Ormy Glen</td>
<td></td>
</tr>
<tr>
<td>STREET ADDRESS where James Sakel RESIDES:</td>
<td>6719 Abrams Blvd</td>
<td></td>
</tr>
<tr>
<td>CITY where Bill Bennet RESIDES:</td>
<td>Von Ormy</td>
<td></td>
</tr>
<tr>
<td>CITY where James Sakel RESIDES:</td>
<td>Austin</td>
<td></td>
</tr>
<tr>
<td>STATE where Bill Bennet RESIDES:</td>
<td>TX D</td>
<td></td>
</tr>
<tr>
<td>STATE where James Sakel RESIDES:</td>
<td>TX D</td>
<td></td>
</tr>
<tr>
<td>ZIP CODE where Bill Bennet RESIDES:</td>
<td>78189</td>
<td></td>
</tr>
<tr>
<td>ZIP CODE where James Sakel RESIDES:</td>
<td>78840</td>
<td></td>
</tr>
<tr>
<td>NUMBER of MONTHS of OFFICER TERM:</td>
<td>36</td>
<td></td>
</tr>
<tr>
<td>MINIMUM NUMBER of YEARS for EMPLOYEE NON-COMPETE CLAUSE:</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>GEOGRAPHICAL RESTRICTIONS for EMPLOYEE NON-COMPETE CLAUSE:</td>
<td>Texas D</td>
<td></td>
</tr>
<tr>
<td>NAME of LEGAL COUNSEL for CORPORATION:</td>
<td>The Law Firm of Dewey, England and Smith</td>
<td></td>
</tr>
<tr>
<td>ADDRESS where the AGREEMENT was EXECUTED (line style):</td>
<td>425 Elm St, Dallas, TX 77250</td>
<td></td>
</tr>
<tr>
<td>NUMBER of DAYS after this AGREEMENT the CORPORATION shall be FORMED:</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>MONTHLY SALARY of Bill Bennet:</td>
<td>$0.00</td>
<td></td>
</tr>
<tr>
<td>MONTHLY SALARY of James Sakel:</td>
<td>$50,000</td>
<td></td>
</tr>
<tr>
<td>EXHIBIT NUMBER or LETTER for BALANCE SHEET:</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>REGULATORY OFFICER or AGENCY that will REGULATE COMPANY:</td>
<td>the Secretary of State</td>
<td></td>
</tr>
<tr>
<td>EXHIBIT NUMBER or LETTER detailing PARTIES’ LIABILITIES:</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>STATE whose LAWS will GOVERN the Agreement between the PARTIES:</td>
<td>Texas</td>
<td></td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>STATE where the ACKNOWLEDGMENT of Bill Bennett took place:</td>
<td>TX</td>
<td></td>
</tr>
<tr>
<td>STATE where the ACKNOWLEDGMENT of James Sakel took place:</td>
<td>TX</td>
<td></td>
</tr>
<tr>
<td>COUNTY where the ACKNOWLEDGMENT of Bill Bennett took place:</td>
<td>DALLAS</td>
<td></td>
</tr>
<tr>
<td>COUNTY where the ACKNOWLEDGMENT of James Sakel took place:</td>
<td>DALLAS</td>
<td></td>
</tr>
</tbody>
</table>

### A. SHAREHOLDER INFORMATION

<table>
<thead>
<tr>
<th>Shareholder</th>
<th>Office</th>
<th>Compensation</th>
<th>Number of Shares</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bill Bennet</td>
<td>President</td>
<td>$0.00</td>
<td>10,000</td>
</tr>
<tr>
<td>James Sakel</td>
<td>Vice President</td>
<td>$50,000</td>
<td>10,000</td>
</tr>
</tbody>
</table>
AGREEMENT TO INCORPORATE PARTNERSHIP

Agreement made November 4, 2011, between Bill Bennett, of 2348 Von Ormy Glen, Von Ormy, TX 78189 and James Sakel, of 6719 Abrams Blvd, Austin, TX 78840.

A. The parties hereto are copartners engaged in the business of [__________] under the firm name of Gravity Forces at [__________], [__________] [__________] [__________].

B. The parties desire to incorporate such business under the laws of the State of Texas, and to fix and determine their respective rights, interests, and obligations with respect thereto.

In consideration of the mutual promises hereinafter set forth, the parties agree as follows:

1. Formation of Corporation

Within thirty (30) days after the date hereof, the parties shall cause a corporation to be formed under the laws of the State of Texas.

2. Name of Corporation

Subject to availability, the name of the corporation shall be 5th Street Partnership.

3. Purposes of Corporation

The purposes for which the corporation shall be formed are: [__________].

4. Capitalization

The corporation shall have authority to issue, in the aggregate, [__________] of [__________] shares without par value. Such shares may be issued for money or property actually received or services rendered.

5. Directors

Each of the parties hereto shall be a first director of the corporation.

6. Officers

On adoption of bylaws establishing offices in the corporation, the parties hereto, as first directors, shall elect each of the parties named below to the office set forth next to his or her name, and each such party agrees to accept and serve in such office for a term of 36 months at the salary set forth opposite his or her name and office.

<table>
<thead>
<tr>
<th>Shareholder</th>
<th>Office</th>
<th>Compensation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bill Bennett</td>
<td>President</td>
<td>$0.00</td>
</tr>
<tr>
<td>James Sakel</td>
<td>Vice President</td>
<td>$50,000</td>
</tr>
</tbody>
</table>

7. Sale and Transfer of Assets to Corporation

Immediately on incorporation of the corporation, the parties hereto, as copartners, shall sell and transfer to the corporation all of the assets and business of the partnership, including inventory, fixtures, equip-
ment, books and records, bank deposits, goodwill, and all other personal property, both tangible and intangible, together with all real property or interests therein, including leaseholds, and shall join in execution of appropriate legal instruments to accomplish the sale and transfer.

8. Valuation of Assets; Corporate Indebtedness

It is agreed that the fair monetary value of the partnership’s assets and business to the corporation, and the respective values of interest therein of the parties hereto are accurately represented on the balance sheet attached hereto as Exhibit A, and incorporated herein by reference, and each of the parties, as a first director, shall vote for a resolution of the board of directors of the corporation.

(a) Determining that such amount is the fair monetary value to the corporation of the partnership’s assets and business;

(b) Acknowledging that the corporation is indebted to the parties in the agreed amounts of their respective interests in the partnership; and

(c) Authorizing the officers of the corporation to make, execute, and deliver to the parties its promissory notes in the usual form for the agreed amounts.

In the event that the Secretary of State for the State of Texas should arrive at a lower fair monetary value to the corporation of the assets and business of the partnership than that set forth on Exhibit A, the parties hereto agree to accept proportionately less shares of stock in full satisfaction and discharge as to above.

9. Issuance of Stock; Discharge of Indebtedness

The parties hereto, as the first directors, shall immediately authorize the officers of the corporation to seek permission from the Secretary of State for the State of Texas to issue shares of stock in this corporation in satisfaction and discharge of this indebtedness of the corporation to the parties hereto as follows:

<table>
<thead>
<tr>
<th>Shareholder Name</th>
<th>Number of Shares</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bill Bennett</td>
<td>10,000</td>
</tr>
<tr>
<td>James Sakel</td>
<td>100,000</td>
</tr>
</tbody>
</table>

10. Partnership Liabilities

The parties hereto shall cause the corporation to assume all of the liabilities of the partnership, including without limitation those shown on Exhibit B, which is attached hereto and incorporated herein by reference, and to discharge such liabilities and indemnify the parties in respect thereto.

11. Conduct of Corporate Affairs

Each of the parties hereto agrees to devote his full time to the conduct of the business and affairs of the corporation.

12. Competitive Activities

Each of the parties hereto will occupy an important executive position with the corporation, and in such position will have access to information crucial to the success of the corporation as a business enterprise. In view of the foregoing, each of the parties agrees that for a period of two (2) years after he or she ceases to be an officer or director of the corporation (or if such period is unenforceable by appropriate legal action, then for such period as may be enforceable), he or she will not engage in the same or
any similar kind of business in Texas, or if such area is too broad to be enforceable by appropriate legal action, then in such area as may be enforceable.

13. Employment of Attorney; Expenses of Incorporation

The parties hereto shall employ The Law Firm of Dewey, England and Smith as legal counsel for the purpose of drafting articles of incorporation, bylaws, and any other documents related to the formation of the corporation under the laws of the State of Texas, and for the purpose of advising the parties hereto and the corporation as necessary in connection with each step in this organization. It is further agreed that charges for these legal services and all fees of the Secretary of State and all other costs, including franchise taxes, shall be expenses of incorporation to be paid for by the corporation, it being understood, however, that each of the parties, as copartners, shall be obligated to advance such sums as may be required out of partnership funds.

Executed at 425 Elm St, Dallas, TX 77250 on the date first above written.

By: _________________________________

Bill Bennett

STATE OF TX )
COUNTY OF DALLAS )
This instrument was acknowledged before me on this ____ day of ____________________ ,____ by Bill Bennett.

__________________________________

Notary Public
My Commission Expires: _________________

By: _________________________________

James Sakel

STATE OF TX )
COUNTY OF DALLAS )
This instrument was acknowledged before me on this ____ day of ____________________ ,____ by James Sakel.

__________________________________

Notary Public
My Commission Expires: _________________
Module 7 - Assignment 2

A. ASSIGNMENT DESCRIPTION:

You have now received the information you were missing that was needed to complete your Agreement to Incorporate Partnership document for the 5th Street Partnership. You will now complete it.

B. DIRECTIONS:

c. Make the following changes:

1. Open the Document Manager and select 5th Street Partnership, Business Formation case.
2. In the documents pane click on the Agreement to Incorporate Partnership.
3. Click the Reassemble button.
   i. Choose to Overwrite the same document. You could have chosen above to start a new document assembly session but that would have resulted in two version of this document—the original and this revised version. By choosing this reassembly method, you can simply overwrite the old version so you have only one active version in your system.
   ii. Deselect Do you want to review your previous answer? because, in this case, you only want to enter missing data. This will prevent you from having to review your previously entered data.
4. Click OK.
5. ProDoc opens into the Merge Assembly process to the area with missing data.
6. Enter the data based on Worksheet 2.
7. Complete the rest of the assembly process.
8. However, when you review your final draft you notice that there are two dollar signs attached to the compensation amounts.
9. Your initial reaction is to simply make the change on the Word document. But, you remember that this does not fix the underlying issue so you decide to update the database so all future documents will be generated correctly.
10. Using the the knowledge you gained in Module 6 - Editing Case Answers:
   i. Print a Case Data Sheet,
   ii. Edit the Case Answers to remove the extra dollar signs, and
   iii. Reassemble the document.
11. A copy of the final document is attached.
## ASSIGNMENT 2 - WORKSHEET

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>PURPOSE for which the COMPANY was formed:</td>
<td>creating and marketing anti-gravity propulsion devises</td>
</tr>
<tr>
<td>TOTAL AUTHORIZED NUMBER of SHARES of STOCK:</td>
<td>500,000</td>
</tr>
<tr>
<td>CLASS of SHARES the PROMOTER may SUBSCRIBE:</td>
<td>Class 1</td>
</tr>
<tr>
<td>NAME of the FIRM the PARTNERS CURRENTLY OPERATE:</td>
<td>Gravity Forces</td>
</tr>
<tr>
<td>STREET ADDRESS of the FIRM the PARTNERS CURRENTLY OPERATE:</td>
<td>2525 Octagon Blvd</td>
</tr>
<tr>
<td>CITY of the FIRM the PARTNERS CURRENTLY OPERATE:</td>
<td>Sweetwater</td>
</tr>
<tr>
<td>STATE of the FIRM the PARTNERS CURRENTLY OPERATE:</td>
<td>TX</td>
</tr>
<tr>
<td>ZIP CODE of the FIRM the PARTNERS CURRENTLY OPERATE:</td>
<td>79840</td>
</tr>
</tbody>
</table>
FINAL DRAFT - AGREEMENT TO INCORPORATE PARTNERSHIP

AGREEMENT TO INCORPORATE PARTNERSHIP

Agreement made November 4, 2011, between Bill Bennett, of 2348 Von Ormy Glen, Von Ormy, TX  78189 and James Sakel, of 6719 Abrams Blvd, Austin, TX  78840.

A. The parties hereto are copartners engaged in the business of marketing and manufacturing under the firm name of Gravity Forces at 2525 Octagon Blvd, Sweetwater TX  79840.

B. The parties desire to incorporate such business under the laws of the State of Texas, and to fix and determine their respective rights, interests, and obligations with respect thereto.

In consideration of the mutual promises hereinafter set forth, the parties agree as follows:

1. Formation of Corporation
Within thirty (30) days after the date hereof, the parties shall cause a corporation to be formed under the laws of the State of Texas.

2. Name of Corporation
Subject to availability, the name of the corporation shall be 5th Street Partnership.

3. Purposes of Corporation
The purposes for which the corporation shall be formed are: creating and marketing anti gravity propulsion devises.

4. Capitalization
The corporation shall have authority to issue, in the aggregate, 500,000 of Class 1 shares without par value. Such shares may be issued for money or property actually received or services rendered.

5. Directors
Each of the parties hereto shall be a first director of the corporation.

6. Officers
On adoption of bylaws establishing offices in the corporation, the parties hereto, as first directors, shall elect each of the parties named below to the office set forth next to his or her name, and each such party agrees to accept and serve in such office for a term of 36 months at the salary set forth opposite his or her name and office.

<table>
<thead>
<tr>
<th>Shareholder</th>
<th>Office</th>
<th>Compensation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bill Bennet</td>
<td>President</td>
<td>$0.00</td>
</tr>
<tr>
<td>James Sakel</td>
<td>Vice President</td>
<td>$50,000</td>
</tr>
</tbody>
</table>

7. Sale and Transfer of Assets to Corporation
Immediately on incorporation of the corporation, the parties hereto, as copartners, shall sell and transfer to the corporation all of the assets and business of the partnership, including inventory, fixtures, equipment, books and records, bank deposits, goodwill, and all other personal property, both tangible and intangible, together with all real property or interests therein, including leaseholds, and shall join in execution of appropriate legal instruments to accomplish the sale and transfer.
8. **Valuation of Assets; Corporate Indebtedness**

It is agreed that the fair monetary value of the partnership’s assets and business to the corporation, and the respective values of interest therein of the parties hereto are accurately represented on the balance sheet attached hereto as Exhibit A, and incorporated herein by reference, and each of the parties, as a first director, shall vote for a resolution of the board of directors of the corporation.

(a) Determining that such amount is the fair monetary value to the corporation of the partnership’s assets and business;

(b) Acknowledging that the corporation is indebted to the parties in the agreed amounts of their respective interests in the partnership; and

(c) Authorizing the officers of the corporation to make, execute, and deliver to the parties its promissory notes in the usual form for the agreed amounts.

In the event that the Secretary of State for the State of Texas should arrive at a lower fair monetary value to the corporation of the assets and business of the partnership than that set forth on Exhibit A, the parties hereto agree to accept proportionately less shares of stock in full satisfaction and discharge as to above.

9. **Issuance of Stock; Discharge of Indebtedness**

The parties hereto, as the first directors, shall immediately authorize the officers of the corporation to seek permission from the Secretary of State for the State of Texas to issue shares of stock in this corporation in satisfaction and discharge of this indebtedness of the corporation to the parties hereto as follows:

<table>
<thead>
<tr>
<th>Shareholder Name</th>
<th>Number of Shares</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bill Bennett</td>
<td>10,0000</td>
</tr>
<tr>
<td>James Sakel</td>
<td>100,000</td>
</tr>
</tbody>
</table>

10. **Partnership Liabilities**

The parties hereto shall cause the corporation to assume all of the liabilities of the partnership, including without limitation those shown on Exhibit B, which is attached hereto and incorporated herein by reference, and to discharge such liabilities and indemnify the parties in respect thereto.

11. **Conduct of Corporate Affairs**

Each of the parties hereto agrees to devote his full time to the conduct of the business and affairs of the corporation.

12. **Competitive Activities**

Each of the parties hereto will occupy an important executive position with the corporation, and in such position will have access to information crucial to the success of the corporation as a business enterprise. In view of the foregoing, each of the parties agrees that for a period of two (2) years after he or she ceases to be an officer or director of the corporation (or if such period is unenforceable by appropriate legal action, then for such period as may be enforceable), he or she will not engage in the same or any similar kind of business in Texas, or if such area is too broad to be enforceable by appropriate legal action, then in such area as may be enforceable.

13. **Employment of Attorney; Expenses of Incorporation**

The parties hereto shall employ The Law Firm of Dewey, England and Smith as legal counsel for the purpose of drafting articles of incorporation, bylaws, and any other documents related to the formation of the corporation under the laws of the State of Texas, and for the purpose of advising the parties hereto and the corporation as necessary in connection with each step in this organization. It is further agreed that charges for these legal services and all fees of the Secretary of State and all other costs, including franchise taxes, shall be expenses of incorporation to be paid for by the corporation, it being understood, however, that each of the parties, as copartners, shall be obligated to advance such sums as may be required out of partnership funds.
Executed at 425 Elm St, Dallas, TX  77250 on the date first above written.

By: ________________________________
    Bill Bennett

STATE OF TX   )
COUNTY OF DALLAS    )
This instrument was acknowledged before me on this _____ day of ______________________,___
by Bill Bennett.

_______________________________

Notary Public
My Commission Expires: __________________________

By: ________________________________
    James Sakel

STATE OF TX   )
COUNTY OF DALLAS    )
This instrument was acknowledged before me on this _____ day of ______________________,___
by James Sakel.

_______________________________

Notary Public
My Commission Expires: __________________________
Module 7 - Quick Check

1. True or False: There can be only one default answer set.

2. During the installation of ProDoc, where is the default directory for completed documents?

3. True or False: You are limited to a total of 6 custom fields for both clients and cases.
Module 8 - Saving Time with QuickText

A. MODULE DESCRIPTION

QuickText is a time saver for pasting text into fill in the blank answers. It can speed up the document assembly process by eliminating the need to retype frequently used blocks of text. This feature is native to ProDoc and only works within the program.

B. OBJECTIVES

Upon successful completion of this module, you will be able to:

1. Demonstrate the procedure used to add QuickText entries for both text and dates.
2. Demonstrate how to use the Copy QuickText feature.
3. Demonstrate the use of the QuickText feature by using it to insert a block of text into a document.
4. Demonstrate how to delete a QuickText entry.

Complete the steps in the sections that follow.

C. PROCEDURE

1. **Adding a QuickText entry (text)**
   
   a. Click the Customize menu item and select QuickText.
   
   b. The QuickText dialog box will appear. Click the New button to begin entering the QuickText information.
   
   c. In the Adding a QuickText Record dialog box, type the words Attorney Name in the Name field. Each name field can contain up to 35 characters.
   
   d. Assign a hot key to the QuickText entry by clicking the drop-down menu next to the HotKey field and selecting the desired key(s).
   
   e. You can use both text and dates for QuickText. You can choose which to use by clicking the appropriate radio button in the QuickText Type section. Ensure Text is selected for this exercise.
   
   f. Type John Q. Attorney P.C. in the Text field. The Text field can contain over 3,000 characters.
   
   g. Click the OK button to close the dialog box. Leave the QuickText dialog box open.

2. **Adding a QuickText entry (date)**

   This feature is useful for inserting the current date, in a specific format, in any field requiring it.
   
   a. Click New to open the Adding a QuickText Record box. Click the Date radio button in the
section.

1. Type **Today’s Date Text Style** in the Name field.

2. Click the Date field. Note that there are many choices you can make to format the date entry. Select the **Mmmmmmmmm.dd.yyyy** format, which is appropriate for a date entry in a line of text.

3. Click **OK** to close the dialog box. Click Close to close the **QuickText** dialog box.

3. **Using the Copy QuickText feature**

   This feature allows you to copy other users’ **QuickText** records for your own use.

   a. Close ProDoc. Open ProDoc and use the initials **XYZ** to log in.

   b. Click **Customize > QuickText**. Click the **Copy QuickText** button. The **Copy QuickText** window appears.

   c. The **Select QuickText to Copy** box on the left side of the window displays a tree with your regular user login initials and each entry you’ve created. The right side of the window displays the actual text used in the entry. Click the **Attorney Name** entry, then click **Select** to adopt it for use. Note that you could also use the **Select All** and **Deselect All** buttons to perform the indicated actions.

   d. Click **OK**. The **Copy QuickText** window appears to inform you about which records were copied and the fact that any new hot keys will take effect when you move to the next question window.

   e. Click **Close**. The copied entry appears in the **QuickText** window.

   f. Click **Close**. Close ProDoc, then open it and log in with your normal initials.

4. **Using QuickText in the document assembly process**

   a. Click the **Assemble** icon.

   b. Click the **Select case** button.

   c. Select **John H. Doe, Jr.** and the **Criminal Defense** case.

   d. Click the **Select forms** button and select the **Attorney-Client Matters** volume.

   e. Select form number **3-16 Receipt for Client’s Documents**.

   f. Click the **OK** button.

   g. Click the **Start Assembling** button.

   h. Answer the questions by clicking **Next**. When the document is previewed on the screen, tab down to the line that asks for the **Name of John H. Doe, Jr.’s PRIMARY ATTORNEY**.

   i. Notice that the default answer set up earlier appears in the field. Delete this name so you can change the name of the primary attorney.
j. Press the **HotKey** you chose earlier. If you forgot the **HotKey**, you can click the **QuickText** button at the top of the screen, click Attorney’s Name and then click the **Select** button. Either action will paste the attorney’s name in the blank.

k. Finish assembling the form by pressing the **Tab** key until you reach the end of the document.

l. At the **Completed Documents** window, click the **Continue** button to finish the assembly process. The document will now be passed to the word processor. View and close the document.

m. Since you have now assembled a document with a different default answer set, click **Customize > Options** and change the default answer set back to the **Primary Set**, which will be used in succeeding modules.

5. **Deleting a QuickText record**

   1. From the **Customize** menu, click **QuickText**.
   2. From the **QuickText** dialog box, click the **QuickText** record **Attorney Name**.
   3. Click the **Delete** button. Click the **Yes** button to confirm the deletion of the record.

D. **ADDITIONAL RESOURCES**

   Additional ProDoc resources available to assist you in understanding more about the **QuickText** feature include:

   • **QuickText TechTip** ([tinyurl.com/pd-quick-text](tinyurl.com/pd-quick-text)): This TechTip provides step-by-step instructions with screen shots in use this feature.

E. **REVIEW**

   1. Explain the procedure for creating a **QuickText** record.

   2. Explain the procedure for deleting a **QuickText** record.

   3. True or False: Users cannot share each others’ **QuickText** entries.
Module 8 - Assignment

1. Assignment Description:

Defining QuickText shortcuts allows the user to save time while entering repetitive text. In this exercise, you will define QuickText entries and then use them during the document assembly process.

2. Directions:

You repetitively enter the county court’s address. You want to avoid doing this.

a. To enter the text into QuickText, complete the following steps. You will use both HotKeys and selection buttons.

1. From the Customize menu, click QuickText.
2. Click the New button.
3. In the Name field, type in Bexar Cty Ct Clk Street Add.
4. In the Text field, type Bexar County Court Clerk, 100 Dolorosa Street Suite 12. This address is in line style because this is the required format for applicable questions.

5. Specify a HotKey for the entry. To do this, click the HotKey field and select F3. If one is specified, you can simply press the HotKey when you are answering a question which calls for a text entry instead of clicking several buttons.

6. Click the New button.

7. In the Name field, type Bexar Cty Ct Mail Add.

8. In the Text field, type Bexar County Court Clerk, 100 Dolorosa Street Suite 12, San Antonio, Texas 78888.

9. Click the HotKey field and select F4.

10. Click OK to close the dialog box.

11. Click New again, and type District #1 Judge Address in the Name field.

12. In the Text field, type in the following (this is an example of block style text):

   The Honorable Billy-Joe Jim Bob
   District Court #1 Office
   1212 E. Houston Street
   San Antonio, TX 78111
   (210) 555-0090
   (210) 555-9009 (Fax)

13. Click OK to close the dialog box.

14. Click New again, and type Judge Roy Miller in the Name field.
15. In the Text field, type Roy Miller, Justice of the Peace for Precinct No. 6, Pecos County, Texas 77711.

16. Click OK to close the dialog box. Click Close to close the QuickText window.

b. To see how QuickText saves time, complete the following steps to insert QuickText into a document:

1. Click the Assemble icon on the main menu.
2. Click the Select case button.
3. Select Mr. John H. Doe, Jr. and the Criminal Defense case.
4. Select the Criminal Defense volume.
5. Select form number 13-10 Citation (Witness), then click OK.
6. Click the Start Assembling button.
7. Answer the questions using the following answers:
   i. Bexar
   ii. County Clerk
   iii. Bobby Kruger as the witness
   iv. 1001 Elm Street, San Antonio, Texas 77666
   v. District 2 County Court
   vi. San Antonio
   vii. Cause Number 03-01234
   viii. Clerk's name is Ima Clerk
8. At the question that asks for the Street Address for the Court Clerk, click the QuickText button.
9. Click the Bexar Cty Ct Clk Street Add entry and then click the Select button. ProDoc will paste the QuickText into the blank field. Press Tab to accept the entry.
10. At the next question, City, State and ZIP Code for the Clerk, type San Antonio, Texas 78888.
11. At the next question, Mailing Address of the Court Clerk, delete the entry if anything automatically appears. Press F4. This enters the full mailing address you entered in QuickText.
12. Tab through any remaining questions.
13. ProDoc will assemble the document and display a completed documents dialog box. Click OK.
14. ProDoc will pass the document to the word processor for your review. Compare it to the completed Citation (Witness) document in this module.
Citation (Witness)

THE STATE OF TEXAS
TO THE FOLLOWING:

Bobby Kruger
1001 Elm Street
San Antonio TX 77666

YOU ARE HEREBY COMMANDED to appear and answer before the Honorable JUDGE of the District 2 County Court, in San Antonio, Texas, at or before 10:00 a.m. on the Monday next following the expiration of twenty days after you were served this citation, to show cause why you should not be held in contempt for failure to appear and testify in Cause 0301234, styled “The State of Texas v. John H. Doe, Jr.” in the District 2 County Court as you were subpoenaed to do.

Your answer may be filed at the office of the County Clerk with Ima Clerk, at Bexar County Court Clerk, 100 Dolorosa Street Suite 12, San Antonio, Texas 78888, or by mailing it to Bexar County Court Clerk, 100 Dolorosa Street, San Antonio, TX 78888, which mailing must be postmarked prior to the expiration of the 20 days, Monday Next, from the date of service of this citation. You should carefully compute this date based on the day upon which you are served.

If this citation has not been served prior to the expiration of 90 days from the date of issuance, it shall be returned to the Clerk’s Office.

ISSUED AND GIVEN under my hand and seal of office on January 31, 2011, at San Antonio, Bexar County, Texas.

Ima Clerk
Bexar County, Texas

______________________________
By:

RETURN

CAME TO HAND on the _____________ at _____________ .m., _____________ and executed in County, Texas by delivering, in accordance with the requirements of law, to the within named Bobby Kruger, in person/by delivery to _____________ /by mailing/by certified mail return receipt requested, a true copy of this citation together with the accompanying copy of the pleadings, having first endorsed thereon the date of delivery.

And not executed as to the Witness, Bobby Kruger, the cause of failure to execute is . The Witness may be found at .

Total Fees: $ ________________

By: ______________________________
Module 8 - Quick Check

1. True or False: You can have an unlimited number of QuickText entries.

2. True or False: A QuickText entry can have over 3000 characters.

3. True or False: Hot keys in QuickText can be used to paste information in other programs besides ProDoc.
Module 9 - Texas Family Law PowerPack

A. MODULE DESCRIPTION

The Family Law PowerPack is a collection of powerful tools that allow fast and efficient entry of information for document assembly and information management. Using the PowerPack programs significantly reduces the amount of time it takes to assemble documents.

Note: The Family Law PowerPack is only available in the menu if the attorney subscribes to the Family Law volume.

B. OBJECTIVES

Upon successful completion of this module, you will be able to:

1. Demonstrate the use of the Child Support Calculator.
2. Demonstrate the use of the Delinquent Support Calculator.
3. Demonstrate the use of the Payment Splitter.
4. Demonstrate the use of the Obligation Amortizer.
5. Demonstrate the use of the Child Possession Calendar.
6. Demonstrate the use of the Divorce Inventory.
7. Demonstrate the use of the UCCJEA Affidavit.

C. PROCEDURE

Complete the steps for each section below.

1. Using the Child Support Calculator

This program provides you a simple method for quickly calculating child support obligations and delinquent balances according to the guidelines in the Texas Family Code.

a. Enter the following client and case information using the Client/Case Manager:

   1. Client’s name: Robert G. Hutton
   2. Client’s Address: 456 Main St., San Antonio, TX 78247
   3. Case description: Divorce

b. From the Power Packs menu, click Family Law and click Child support calculator.

c. Select Robert G. Hutton and the Divorce case from the client list.

d. Enter the following information:

   1. Obligor: Robert G. Hutton
   2. Describe Obligor: Respondent
3. Obligee: Judy Hutton
4. Obligee’s total children: 2
5. Children before the court: 1
7. Obligor’s average (taxable) gross monthly income: $3000

e. Press the Tab key or click a later entry field.
f. Notice that ProDoc has calculated the support obligation based on the numbers in the calculator. To print a copy of the calculations, click the Print button.
g. Click OK to accept the printer destination.
h. Click No to previewing the report. Once the report prints, note that an information sheet which explains how the calculations were obtained prints with it.
i. Click Save and Close to close the program. Submit the report to your instructor.

2. Using the Delinquent Support Calculator

This tool is designed to track the obligations, payments, and judgments for child support.

a. From the PowerPacks menu, click Family Law, then click Delinquent support calculator.
b. Select Robert G. Hutton and the Divorce case from the client list.
c. Verify that the Obligor is Robert G. Hutton and the Obligee is Judy Hutton.
d. Click the Obligations tab.
e. Click the Add Multiple Obligations button to insert a series of obligations within a specified date range.
f. In the Inclusive dates box, type 11/01/2008 in the From: field.
g. In the To: field, enter today’s date.
h. The Amount of each obligation is $500.
i. The payments are due on the 1st day of each month.
j. Click OK. ProDoc will create a series of obligations and list them in the window.
k. Click the Save and Continue button.
l. Click the Payments tab.
m. Click the New button to insert a payment.
n. The client made a payment of $500 on November 1, 2008. After entering this, click OK.
o. Click the Save and Continue button.
p. Click the Judgment tab.

q. A judgment was rendered on 10/31/2009 in the amount of $6000 at the default interest rate shown (use simple interest type) and has incurred an attorney’s expense of $1000 (no interest). After entering this information, click the Save and Continue button.
r. To view a summary report of the obligations, click the **Print** button. Select **Summary** from the pop-up window. Click **OK** to accept the date shown. Click **OK** for the printer destination and **Yes** to preview the report.

s. ProDoc will display a one-page summary of the delinquent support report. Notice that ProDoc calculates for you what the client owes based on payments made, the total remaining obligation and the total obligation to date.

t. To view a full report of the obligations, payments and judgments, click the **Print** button and select the **Full report** option from the pop-up window. Enter today's date and click **OK** to accept today's date. Click **OK** for the printer destination and click **Yes** to preview the report.

u. ProDoc will display a multi-page report showing the obligations, payments, judgments, how the calculator calculates the delinquent support, and tables of remaining balances and payments applied to the obligation.

v. Exit the report without printing.

w. Click **Save** and **Close** to close the program.

3. **Using the Payment Splitter**

   Use the **Payment Splitter** to calculate payments other than monthly when the child support ordered varies from that amount determined by the **Child Support Calculator**.

   a. On ProDoc’s main menu, click **PowerPacks>Family Law>Payment splitter (semi-monthly, biweekly, weekly)**.

   b. Enter the amount of the monthly child support obligation, **500**, and click **Calculate**.

   c. The **Semi-monthly, Weekly** and **Biweekly payment** amounts appear. Click **Close**.

4. **Using the Obligation Amortizer**

   The **Obligation Amortizer** allows the user to calculate how long it will take to pay off an obligation. Once the blanks are filled in, ProDoc will produce an amortization table for an obligation.

   a. From the **PowerPacks** menu, click **Family Law** and click **Obligation Amortizer**.

   b. Type the following information:
      1. Calculate interest from: **10/31/2009**
      2. Total obligation: **$10,000**
      3. Amount of each payment: **$500**
      4. Interest rate: **6%**
      5. Payment will be monthly on the **1st** day of each month.

   c. Click the **Calculate** button. ProDoc will now display the calculated number of payments, date of last payment, and amount of last payment. Click the **Print** button and print a copy of the report. Submit the report to the instructor.

   d. Click **Close**.
5. **Print and Preview Functions**

After clicking the **OK** button in the **Report Destination** window, ProDoc asks you if you want to preview the report. If you click **Yes**, the printing is interrupted while you view the document in the **Report Preview** window. You must click the printer icon in order to complete the print process. If you choose **No** when asked if you want to preview the document, the printing process proceeds with no interruption.

6. **Using the Child Possession Calendar**

The **Child Possession Calendar** allows the user to gather information and print a visitation calendar. Certain information must be entered on the **Client Information** tab before the user will be allowed to access the **Date and Time** or **Calendar** tabs. The child visitation calendar and/or specific forms in the Family Law library that are created with ProDoc use the information entered on the **Client Information** screen.

   a. From the **Power Packs** menu, click **Family Law** and click **Child possession calendar**.
   
   b. Select **Robert G. Hutton** and the **Divorce** case from the client list, then click the **Select Case** button.

   c. In the **Client** section, select **Petitioner**. Your client’s name will be entered into the appropriate section.

   d. Select **Male**. Next, enter the respondent’s name (**Judy Hutton**) and select **Female**.

   e. The **Petitioner** is the **Primary/Sole Managing Conservator** and this will be a **Joint Managing Conservatorship**. After you make this entry, you now have access to the **Date and Time** and **Calendar** tabs.


   g. Click the **Dates** tab and make the following selections:

      1. Year: **2010**. Month: **November 2010**.
      2. Check the box next to **Parties currently reside within 100 miles of each other**.
      3. Enter the **Date Begins** and **Ends** section fields as the following:

         i. Spring break: **3/15/11 to 3/22/11**
         ii. Summer vacation: **5/15/11 to 8/15/11**
         iii. Thanksgiving: **11/20/11 to 11/26/11**
         iv. Christmas: **12/12/11 to 12/30/11**
         v. First Period (under Secondary/Possessory Conservator’s Summer Possession): **7/01/11 to 7/31/11**

      4. Note the **Estimate** blocks. If checked, a footnote appears on the calendar which advises that the date(s) may need to be adjusted when the school schedule is known. Leave these unchecked.

   h. Click **Save** and **Continue**. Click the **Times** tab.

      1. Set the **Day** to **Thursday**.
2. Leave the remaining fields on the tab as the defaults.

i. Click the Calendar tab and view the results. If you wish to change the schedule for a specific date on the calendar, you can double-click the appropriate day to open the Change Calendar Information on (Date) window. Modify the Message and Detail fields as needed.

j. Click the Next button to view the next month. Click the Print button and the appropriate buttons to view and/or print one or more months of the calendar. Close the Report Preview window.

k. Click the Save and Close button to save your data.

7. Using the Divorce Inventory

The Divorce Inventory has five tabs. The General and Property tabs are the first two. The General tab asks for information regarding the client, court, and attorney. The Property tab is used to gather information regarding marital property and how it is to be divided between the couple.

a. From the Power Packs menu, click Family Law and select Divorce Inventory.

b. Select Robert G. Hutton and the Divorce case from the client list.

c. ProDoc will load the previously entered data and display the General tab.

d. Verify the information on this tab. This information will be used later to assemble the divorce documents.

1. This form provides the opportunity to enter scenario descriptions, create and delete scenarios, load different scenarios and copy existing scenarios. You can also designate a different scenario to use in ProDoc’s forms while working with another scenario.

2. The scenario currently being used in the program is highlighted.

3. You should always verify that you are working with the desired scenario. You will be using the default scenario for this module.

e. Click the Property tab. Click the field Motor Vehicles, Boats, Airplanes, Cycles, etc.

1. a. Click the New button at the bottom and add the following:

   i. 2003 Harley Davidson Motorcycle.

   ii. Night Train model, Robert G.’s name is on the title and he possesses it.

   iii. Vehicle ID No. 123456789, value of $16,899.

   iv. No lien.

   v. The husband and the wife have agreed to sell the motorcycle and split the assets of the sale. With the motorcycle highlighted, click the Split button and place a check in the box next to Calculate asset by percentage. Enter 50 in the % to husband box. Click the down pointing triangle next to How to divide asset and select Split sale proceeds. Click OK. Upon the sale of the motorcycle, each party will receive the calculated amount.

   vi. Click the Save and Continue button.
2. Scroll down to the **Electronics and Computers in Possession of Wife** and highlight that entry. Click the **New** button and add the following:

   i. **Dell laptop computer** valued at $800.

   ii. Click **OK** to save the entry.

   iii. Click the **Dell laptop computer** line to highlight it, then click the **Wife** button to assign the property to the wife

   iv. Click **Save** and **Close**.

8. **Importing and Exporting Data**

   With ProDoc, the user has the ability to export the **Divorce Inventory** data to another attorney who has ProDoc. For instance, if you are working for the Petitioner's attorney (who is acquainted with the Respondent's attorney), you can export the divorce inventory data and give it to the other attorney for review. This saves time and possible data errors. The Respondent’s attorney can view and edit the same file and respond to that data. This feature will be used in the Assignment exercise for this module.

9. **Using the UCCJEA Affidavit**

   The **UCCJEA Affidavit** has four tabs, the **General**, **Children**, **Nonparty** and **Other Proceedings** tabs.

   - The **General** tab asks for information regarding the client, court, and request for nondisclosure.

   - The **Children** tab is used to gather information regarding all children affected by the proceeding and their address(es) for the previous five years.

   - The **Nonparty** tab asks for name(s), address(es), and type of claim for any nonparty who may have actual physical custody of a child, or are otherwise claiming visitation or custody rights of a child in the action.

   - The **Other Proceedings** tab asks for a listing of any other child proceedings that the affiant was a participant in and which would concern a child subject to the instant proceeding.

   a. From the **PowerPack** menu select **Family Law** and then select **UCCJEA Affidavit**.

   b. Select **Robert G. Hutton** and the **Divorce** case from the client list.

   c. ProDoc will open the program and display the **General** tab.

   d. Verify the information on this tab. This information will be used later to assemble the divorce documents.

   e. Indicate whether to include or not include a request for nondisclosure.

   f. Fill in the appropriate **Court Information**.

      1. County: **Bexar**
      2. Select the Court: **County Court at Law (numbered)**
      3. Court No.: **2**
      4. Cause No.: **12345**
g. Click the Save and Continue button and select the Children tab.

h. Verify the current information and make sure there is a check mark in the box to the left of Check here if all children have lived at the same address(es) for the previous five years.

i. Select Grace Hutton and click the Update button.

j. Click the Update button in the Changing Child Information window.

k. The Changing Child’s Current Address window will open. Fill in the address information as follows:
   - 998 Winding Way
   - an Antonio
   - TX
   - 78654

l. Once the information is entered, click the OK button and then click the OK button in the Changing Child Information window (because you indicated that both children have lived at the same address for the past five years, no address information needs to be entered for Robert J. Hutton).

m. Click the Save and Continue button to save your information.

n. Click the Assemble button. On the Starting Document Assembly window, ensure the Review prior answers box is unchecked. Click the Start Assembling button.

o. ProDoc will assemble the Affidavit for UCCJEA Information (Section 152.209) based on the answers from the Family Law PowerPack and the information that you provided during the assembly process.

p. Answer the question NUMBER of places the children have lived for the past five years with 1. Answer any questions which appear and click Continue on the Completed Documents window. Close the word processor window when you are finished viewing the UCCJEA Affidavit.

10. Assembling Documents

You have completed entering the data into the Family Law PowerPack. Now you will assemble the Original Divorce Petition, Waiver of Service and Affidavit for UCCJEA Information (Section 152-209) documents.

a. Click the Assemble icon.

b. Select the Hutton, Robert G. Divorce case.

c. Click the Select forms button. Select the Family Law, 3rd Edition volume. Select forms 3-1, 3-13 and 56-1 from the list. Click OK.

d. Ensure the Review prior answers box is checked on the Starting Document Assembly window. In the future, you may want to uncheck this box to avoid viewing the answers you have already completed within the PowerPack.

e. Click the Start Assembling button.
f. Once the assembly questions appear on the screen, accept suggested answers by clicking the Next button until you reach the question the next step. Your instructor may provide different answers. Notice that ProDoc inserts information from the PowerPack as needed. Many of these questions would not have appeared if you had unchecked the Review Prior Answers box. This illustrates one time-saving feature of the Power Packs.

g. Click the Next button to accept suggested answers until you reach the question INCLUDE UCCJEA AFFIDAVIT containing information required under TFC 152.209? Choose or ensure the answer is Yes.

h. Keep clicking the Next button until you reach the merge phase questions. Answer the merge questions with the following information.

1. Press the Tab key to accept the cause number for this case.
2. Parties were married on 1/3/2000.
4. Enter the sex of each child.
5. Enter Exhibit A and press the Tab key for Exhibit Letter/Number of UCCJEA Affidavit.
6. Enter Exhibit B and press the Tab key for Exhibit Letter/Number of Health Insurance Statement.
7. Enter Exhibit C and press the Tab key for the Exhibit Letter/Number of Marital Property Agreement.
8. For the permanent injunction request, enter None requested and press the Tab key.
9. Accept the firm information and mailing address by pressing the Tab key.
10. Enter the primary attorney’s name, Allen Attorney.

i. Enter as the attorney’s state bar number as 1234 and press the Tab key. ProDoc begins assembling the Original Petition for Divorce document.

j. In the next merge document (the Waiver of Service), accept the copy of the Original Petition for Divorce by pressing the Tab key.

k. Fill in the Respondent’s address as follows:

• 998 Winding Way.
• San Antonio, Texas 78654.
• Telephone is 210-999-9999.
• Social Security Number is 123-45-6789.
• Driver’s license number is 09876543.

l. In the next merge document (Affidavit for UCCJEA Information (Section 152.209), Tab through and accept the answers that ProDoc provides.

m. When the Completed Documents dialog window appears, click Continue.

n. ProDoc will assemble the documents based on the answers from the Family Law PowerPack and the information that you provided during the assembly process. A copy of
each assembled document is included in this module.

D. ADDITIONAL RESOURCES

Additional ProDoc resources available to assist you in understanding more about the PowerPacks features include:

- **PowerPacks TechTip** ([tinyurl.com/tx-pptips](tinyurl.com/tx-pptips)): This TechTip provides step-by-step instructions with screen shots in use this feature.

- **Child Support Calculator Video** ([tinyurl.com/pd-cs-calculator](tinyurl.com/pd-cs-calculator)): This self-running video demonstrates how to use this feature.

- **Delinquent Support Calculator Video** ([tinyurl.com/pd-delinquent](tinyurl.com/pd-delinquent)): This self-running video demonstrates how to use this feature.

- **Payment Splitter Video** ([tinyurl.com/pd-splitter](tinyurl.com/pd-splitter)): This self-running video demonstrates how to use this feature.

- **Obligation Amortizer Video** ([tinyurl.com/pd-amortizer](tinyurl.com/pd-amortizer)): This self-running video demonstrates how to use this feature.

- **Child Possession Calendar Video** ([tinyurl.com/pd-poss-calendar](tinyurl.com/pd-poss-calendar)): This self-running video demonstrates how to use this feature.

- **Divorce Inventory Video** ([tinyurl.com/pd-inventory](tinyurl.com/pd-inventory)): This self-running video demonstrates how to use this feature.

- **UCCJEA Affidavit Video** ([tinyurl.com/pd-uccjea](tinyurl.com/pd-uccjea)): This self-running video demonstrates how to use this feature.

E. REVIEW

1. True or False: To perform a quick child support calculation, you do **not** need to enter the obligee and obligor.

2. True or False: It is best to enter the client’s information into the Family Law PowerPack before assembling the documents.

3. True or False: When using the Payment Splitter tool, you can only calculate monthly and weekly payments.

4. True or False: Once the data has been entered into the Family Law PowerPack, the user must exit the PowerPack in order to start the document assembly process.
Module 9 - Assignment

1. Assignment Description:

As we discussed in the module, the PowerPack for Family Law is used to gather data about the divorce. In this assignment, you will make a number of changes to the PowerPack and update the final documents.

2. Directions:

The attorney has informed you that the following items need to be changed in the Family Law PowerPack (make the changes to the client Robert G. Hutton’s Divorce case). Save your work and close each program that you use.

a. The child’s monthly health insurance was raised to $600.

b. Obligor’s monthly gross income increased to $3400.

c. Two payments of $500 were made for delinquent support. Add two payments of $500 on 11/12/09 and 12/20/09.

d. The interest rate of the Obligation Amortizer changed to 7.5%. Print a new amortization schedule with the changes.

e. The child’s spring break for 2011 has changed to 3/22/11 to 3/29/11.

f. One parent has moved over 100 miles away. Change the Child Possession Calendar to reflect 1st, 3rd, and 5th weekends.

g. One specific day’s schedule has changed. The mother has to work late on March 22, 2011. The parties have agreed that the mother will begin custody that night at 9:00 p.m. instead of 6:00 p.m.

h. In the Divorce Inventory, allocate the following items:
   1. $100 cash on hand to wife
   2. $200 travelers checks to wife
   3. $300 money orders to husband

3. Using the Import/Export features

Work with another student on this part of the assignment. One student will represent the petitioner (Robert G. Hutton) and the other student will represent the respondent (Judy Hutton).

1. Open the Divorce Inventory.

2. Use the Export data button to export the data to the other student representing Judy Hutton. Check with the instructor on the availability of a network drive to use. Save the file in an appropriate location and share the name and location of the file with the other student.

3. The student representing Judy Hutton should add her as a client with a case of Divorce. Then the student should use the Import data button to load the data into the program.
Original Petition for Divorce

NO. 12345

IN THE MATTER OF § IN COUNTY COURT AT LAW
THE MARRIAGE OF §
§
ROBERT G. HUTTON
§
AND
§ NUMBER 2
JUDY HUTTON
§
§
AND IN THE INTEREST OF §
GRACE HUTTON AND ROBERT J.
§ BEXAR COUNTY, TEXAS
HUTTON, CHILDREN
§

ORIGINAL PETITION FOR DIVORCE

1. Discovery Level

Discovery in this case is intended to be conducted under level 2 of rule 190 of the Texas Rules of Civil Procedure.

2. Parties

This suit is brought by Robert G. Hutton, Petitioner. Judy Hutton is Respondent.

3. Domicile

Petitioner has been a domiciliary of Texas for the preceding six-month period and a resident of this county for the preceding ninety-day period.

4. Service

No service on Respondent is necessary at this time.

5. Protective Order Statement

No protective order under title 4 of the Texas Family Code is in effect, and no application for a protective order is pending with regard to the parties to this suit.

6. Dates of Marriage and Separation

The parties were married on or about January 3, 2000 and ceased to live together as husband and wife on or about January 1, 2011.

7. Grounds for Divorce
The marriage has become insupportable because of discord or conflict of personalities between Petitioner and Respondent that destroys the legitimate ends of the marriage relationship and prevents any reasonable expectation of reconciliation.

8. **Children of the Marriage**

Petitioner and Respondent are parents of the following children of this marriage who are not under the continuing jurisdiction of any other court:

- **Name:** Grace Hutton
  - **Sex:** Female
  - **Birth date:** February 2, 2002
- **Name:** Robert J. Hutton
  - **Sex:** Male
  - **Birth date:** September 23, 2000

There are no court-ordered conservatorships, court-ordered guardianships, or other court-ordered relationships affecting the children the subject of this suit.

Information required by section 154.181(b) of the Texas Family Code is provided in the statement attached as Exhibit A.

Information required by section 154.181(b) of the Texas Family Code is provided in the statement attached as Exhibit B.

No property of consequence is owned or possessed by the children the subject of this suit.

Petitioner believes that Petitioner and Respondent will enter into a written agreement containing provisions for conservatorship and support of the children. If such an agreement is not made, Petitioner requests the Court to make orders for conservatorship and support of the children.

9. **Marital-Property Agreement**

Petitioner and Respondent have entered into a marital-property agreement defining their rights to all their property, both community and separate. A copy of the agreement is attached to this pleading as Exhibit C. Petitioner requests the Court to enforce the agreement and divide the marital estate in accordance with its terms.

10. **Division of Community Property**

There is no community property for division.

11. **Post-divorce Maintenance**

Petitioner requests the Court to order that Petitioner be paid post-divorce maintenance for a reasonable period in accordance with chapter 8 of the Texas Family Code.

12. **Request for Permanent Injunction**

Petitioner requests the Court, after trial on the merits, to grant the following permanent
injunction:
  a. None requested.

13. Prayer

Petitioner prays that citation and notice issue as required by law and that the Court grant a divorce and all other relief requested in this petition.

Petitioner prays that, on final hearing, the Court enter a permanent injunction enjoining Respondent, in conformity with the allegations of this petition, from the acts set forth above.

Petitioner prays for general relief.

Respectfully submitted,

The Law Firm of Dewey, England and Smith
2222 S. Court St.
Dallas, Texas 77772
Tel: (972) 888-8888
Fax: (972) 888-7777

By: ________________________________
Allen Attorney
State Bar No. 1234
Attorney for Petitioner
Waiver of Service

NO. 12345

IN THE MATTER OF §  IN COUNTY COURT AT LAW
THE MARRIAGE OF §
§
ROBERT G. HUTTON §
AND §  NUMBER 2
JUDY HUTTON §
AND IN THE INTEREST OF §
GRACE HUTTON AND ROBERT J. §  BEXAR COUNTY, TEXAS
HUTTON, CHILDREN §

WAIVER OF SERVICE

Judy Hutton appeared in person before me today and stated under oath:

“I, Judy Hutton, am the person named as Respondent in this case.

“I acknowledge that I have been provided a copy of the Original Petition for Divorce filed in this case. I have read and understand the contents of that document.

“I understand that the Texas Rules of Civil Procedure require, in most instances, that a party or respondent be served with citation. I do not want to be served with citation, and I waive the issuance and service of citation.

“I enter my appearance in this case for all purposes.

“I do not waive any rights that I may have with regard to the division of my interest in my spouse’s and my property.

“I do not waive any rights that I may have with respect to the terms and conditions of conservatorship, support, and parental rights and duties related to the children born of my relationship with Petitioner.

“I further state that the following information is correct and that my-
Mailing address is: 998 Winding Way, San Antonio, Texas 78654
Telephone number is: 210-999-9999
Social Security number is: 123-45-6789
Texas driver’s license number is: 09876543

“I further understand that I have a duty to notify the Court if my mailing address changes during this proceeding.”

______________________________________________
Judy Hutton

SIGNED under oath before me on _________________________________________________

______________________________________________
Notary Public, State of Texas

I, the notary public whose signature appears above, certify that I am not an attorney in this case.
Robert G. Hutton appeared in person before me today and stated under oath:

“My name is Robert G. Hutton. I am competent to make this affidavit. The facts stated in this affidavit are within my personal knowledge and are true and correct.

“I am the Petitioner in this case.

“The children's present address is 998 Winding Way, San Antonio, TX 78654.

“For the past five years immediately preceding the date of this affidavit, the children have lived at the following address with the following person:

Address: 998 Winding Way, San Antonio, TX 78654
Persons lived with: Robert Hutton and Judy Hutton

Date: 02/05/2002 - 2/05/2011.

“The present address of Robert Hutton is 998 Winding Way, San Antonio, TX 78654.

“The present address of Judy Hutton is 998 Winding Way, San Antonio, TX 78654.

“I have not participated, as a party or as a witness or in any other capacity, in any other proceeding concerning the custody of or visitation with the children in Texas or any other state.
“I do not know of any proceeding that could affect this proceeding, including proceedings for enforcement and proceedings relating to domestic violence, protective orders, termination of parental rights, and adoptions.

“I do not know of any person not a party to this proceeding who has physical custody of the children or claims rights of legal custody or physical custody of, or visitation with, the children.”

______________________________
Robert G. Hutton

SIGNED under oath before me on ________________________________ .

______________________________
Notary Public, State of Texas
Module 9 - Quick Check

1. 1. True or False: The Family Law PowerPack is available to every subscriber.

2. 2. If the court decides to deviate from the child support guidelines and allow for an adjustment, where would you make this adjustment?

3. 3. True or False: In the Delinquent Support Calculator, the summary report includes a list of all payments made.

4. 4. How do you customize the child possession calendar to add specific child possession dates and times?
Module 10 - Document Formatting

A. MODULE DESCRIPTION

This module will cover how to change the final look of your ProDoc documents. You will learn how to change all formatting of global documents, volume documents, and specific documents.

B. OBJECTIVES

Upon successful completion of this module, you will be able to:

1. Explain how to modify the document formatting in each of the following areas:
   a. Global Settings (all documents)
   b. All documents in a volume
   c. Specific documents

2. Select one of the four different font types found in ProDoc.

3. Demonstrate how to adjust the font size, margins, line spacing and justification for each of the document types.

4. Explain how the priority for formatting works for the different documents in ProDoc.

C. PROCEDURE

The process for formatting a document is essentially the same for each type of document. Formatting preferences are stored in CIF files (a .cif file is a configuration file) that are created.

Three different kinds of CIF files can be created in ProDoc:

- **Global.cif** – These formatting preferences apply to every document you generate in every volume in ProDoc and they are saved in the ProDoc root directory.

- **Volume.cif** – These formatting preferences apply to every document you generate in the specific volume for which you created them in ProDoc and they are saved in the volume directory.

- **Specific document CIF files, e.g. FAM001.cif** – These formatting preferences apply only to the specific form for which they were created and they are saved in the appropriate volume directory.

1. Changing document formatting for all documents

Complete the following steps:

a. Click **Customize > Document Formatting. Global Settings** will be highlighted by default. Click the **Update Settings** button at the bottom center of the window.

b. To change the font format in the **Global Format Options** window, click the **Set font** checkbox. Click the **Name** field and choose the font name you want to use from the four
choices there. To change the size of the font, click the **Size** field and select a new font size.

c. To change margins, select the margin by clicking the appropriate checkbox, then enter the size of the margin in inches in the adjacent field.

d. To change line spacing, click the **Line Spacing** checkbox and enter the spacing you desire (e.g. 1.00 for single, 1.50 for space and a half).

e. To change the justification of the text, click the **Justification** checkbox and select the desired type of justification from the drop-down arrow field.

**Note:** The above procedure can be used for Global, Volume and Document formatting. Global formatting affects all ProDoc documents, Volume formatting affects only specified volumes and Document formatting affects only specific documents.

2. **Advanced Formatting Options**

Headers, footers, limited page numbering, and other formatting items can be created in your word processor and used by ProDoc. In this section, students will create a header in the word processor and save it for use in all the documents in a volume. Complete the following steps:

a. Click **Customize > Document Formatting**. Select the **Litigation** volume and click the **Update Settings** button.

b. Click the **Advanced** tab. A message will inform you that no configuration file exists for the volume. Click the **Create** button to create the file.

c. If the word processor is not running, a message will appear on the screen asking if you would like to run it now. Select **Yes**.

d. The word processor will now start and open a file named **volume.cif**. This file is where you enter changes that will affect all ProDoc documents produced from the volume’s forms.

   1. **WordPerfect Users:** Different versions use different menu selections to create the header. From either the Format menu or the **Insert** menu, select **Header/Footer**, select **Header A** and then select **Create**. Type **The Law Offices of [*_insert your name here___*]**. Apply the center justification format.

   2. **Microsoft Word Users (pre-Word 2007):** From the **View** menu, select **Headers/Footers**. Type **The Law Offices of [*_insert your name here___*]**. Apply the center justification format. Click **Close** on the Header and Footer toolbar.

   3. **Microsoft Word Users (Word 2007 and later):** From the **Insert** menu, select **Headers**. Type **The Law Offices of [*_insert your name here___*]**. Apply the center justification format from the **Home** menu.

e. Click the **File** menu and select **Save As**...

f. Change the file type to:

   1. **WordPerfect 5.1/5.2 (for WordPerfect users)**
   2. **WordPerfect 5.1 for Windows (for pre-Word 2007 users)**.

g. Change the file name to “**volume.cif**” (place quotes around the name so the word processor will not add the .wpd or .doc extension). The word processor may add its
extension to “volume.cif” so delete that before the next step.

h. Click the Save button. Close the word processor. In the assignment, you will be assembling documents which will display similar changes.

i. Click OK on the Volume Formatting Options window, then click Close on the Default Formatting window.

Note: The formatting changes that are created in the volume.cif file will be applied to every ProDoc document for the volume that was selected at the beginning of this procedure.

3. Formatting Priorities

a. Global formatting values have the highest priority. ProDoc looks for the global.cif file first. If ProDoc finds the global.cif file, it uses the formatting changes in the file.

b. If a global.cif file does not exist, or the Ignore the global formatting settings box is checked on the Volume Formatting Options dialog window, ProDoc uses the volume.cif file for formatting. Therefore, volume formatting has the second highest priority.

c. If ProDoc does not find the global.cif or volume.cif file, or the Ignore global and volume formatting settings checkbox is checked on the Document Formatting Options dialog window, ProDoc will use the document.cif file for formatting changes if it exists. Therefore, document formatting has the lowest priority.

Note: Each volume.cif file must be saved under the appropriate volume folder under ProDoc. For example, Family Law .cif files must be saved under the TXFAM volume folder.

D. ADDITIONAL RESOURCES

Additional ProDoc resources available to assist you in understanding more about Document Formatting Feature include:

• Customize Default Format Settings TechTip (tinyurl.com/pd-default-formatting): This TechTip provides step-by-step instructions with screens shots in use this feature.

• Basic ProDoc Formatting Video (tinyurl.com/pd-doc-formatting): This self-running video demonstrates how to use this feature.

• Advanced ProDoc Formatting Video (tinyurl.com/pd-advanced-formatting): This self-running video demonstrates how to use this feature.

E. REVIEW

1. True of False: Specific document formatting has the highest priority for the formatting priorities scheme.

2. When you save a .cif file, in what directory does it need to be saved?

3. In what word processing format does a .cif file need to be saved?
Module 10 - Assignment 1

A. ASSIGNMENT DESCRIPTION:

Often the attorney wants to have a specific document or series of documents look a certain way. By using the document formatting option, you have control over how the finished documents will look.

B. DIRECTIONS:

You will now learn how to change the formatting of a single document. This module contains two copies of the assembled document; one assembled before the formatting changes are made and one assembled afterward. Complete the following steps:

1. Click Customize > Document Formatting.

2. Click the plus sign next to the Probate volume entry. Click the plus sign next to the Obtaining the Will entry.

3. Locate and double-click the form 1-060 Motion and Order to Open Safe Deposit Box and Examine. Note that you can also click the form title, then click the Update Settings button.

4. On the Document Formatting Options window, set the following formatting changes:
   a. Set the font to Arial.
   b. Size to 10 point.
   c. Line Spacing to 1.00.
   d. Justification to Left.
   e. Choose Ignore global and volume formatting settings.
   f. Click the Advanced tab.
   g. Click OK. Click Close on the Default Formatting window.

5. Assemble and print a copy of the document with these changes. Use the following information:
   a. Create a new case, Probate, for Robert J. Smith, Jr.
   b. Type of court is Statutory Probate Court, and the County is Harris.
   c. Decedent is Bobby Ray Smith.
   d. Robert is the only client.
   e. The box contains an insurance policy on the life of the decedent.
   f. Tab through the merge phase questions. Print a copy of the completed document and submit it to your instructor.

6. Copies of the document are included in this module for comparison, one assembled before formatting changes and one assembled after.
Motion to Open Safe Deposit Box - Before

No. _____

IN THE ESTATE OF § IN THE PROBATE COURT

BOBBY RAY SMITH, § NO. _____

DECEASED § HARRIS COUNTY, TEXAS

MOTION TO OPEN SAFE DEPOSIT BOX AND TO EXAMINE PAPERS

TO THE HONORABLE JUDGE OF SAID COURT:

Robert J. Smith, Jr., Movant, furnishes the following information to the Court for authorization to examine the safe deposit box of Bobby Ray Smith, Deceased:

1. Decedent died on _____.

2. This Court has jurisdiction and venue of the estate of the Decedent.

3. Decedent had leased a safe deposit box from _____, Respondent.

4. The box may contain the following:

Insurance policy issued in Decedent's name and payable to a beneficiary named in the policy.

Movant prays that Respondent be ordered to permit Movant to examine the box and remove those items as may be directed by the Court.

Respectfully submitted,

Robert J. Smith, Jr., Movant

Sue R. Settle
Attorney for Movant
State Bar No.: 84516
2222 S. Court St.
Dallas, Texas 77772
Telephone: (972) 888-8888
Facsimile: (972) 888-7777
ORDER GRANTING MOTION TO OPEN SAFE DEPOSIT BOX AND TO EXAMINE PAPERS

On this day came on to be heard the foregoing Motion, and the Court, having heard the evidence finds that the allegations contained in such Motion are true and that it should be granted.

IT IS THEREFORE ORDERED that Respondent, ____, permit Movant to examine such safe deposit box in the presence of an officer of the Respondent, who is appointed as an agent of this Court, and if such document is found therein, upon proper receipt, Respondent is directed to deliver an insurance policy issued in Decedent’s name to a beneficiary named in the policy.

SIGNED on the ____________ day of __________________, 2011.

JUDGE PRESIDING

APPROVED AS TO FORM:

Sue R. Settle
Attorney for Movant
State Bar No.: 84516
2222 S. Court St.
Dallas, Texas 77772
Telephone: (972) 888-8888
Facsimile: (972) 888-7777
IN THE ESTATE OF § IN THE PROBATE COURT
§
BOBBY RAY SMITH, § NO. ____
§
DECEASED § HARRIS COUNTY, TEXAS

MOTION TO OPEN SAFE DEPOSIT BOX AND TO EXAMINE PAPERS

TO THE HONORABLE JUDGE OF SAID COURT:

Robert J. Smith, Jr., Movant, furnishes the following information to the Court for authorization to examine the safe deposit box of Bobby Ray Smith, Deceased:

1. Decedent died on ____.
2. This Court has jurisdiction and venue of the estate of the Decedent.
3. Decedent had leased a safe deposit box from ____, Respondent.
4. The box may contain the following:

   Insurance policy issued in Decedent’s name and payable to a beneficiary named in the policy.

Movant prays that Respondent be ordered to permit Movant to examine the box and remove those items as may be directed by the Court.

Respectfully submitted,

_________________________________________________
Robert J. Smith, Jr., Movant

Sue R. Settle
Attorney for Movant
State Bar No.: 84516
2222 S. Court St.
Dallas, Texas 77772
Telephone: (972) 888-8888
Facsimile: (972) 888-7777
IN THE ESTATE OF    § IN THE PROBATE COURT

BOBBY RAY SMITH, § NO. _____

DECEASED § HARRIS COUNTY, TEXAS

ORDER GRANTING MOTION TO OPEN SAFE DEPOSIT BOX 
AND TO EXAMINE PAPERS

On this day came on to be heard the foregoing Motion, and the Court, having heard the evidence finds that the allegations contained in such Motion are true and that it should be granted.

IT IS THEREFORE ORDERED that Respondent, _____, permit Movant to examine such safe deposit box in the presence of an officer of the Respondent, who is appointed as an agent of this Court, and if such document is found therein, upon proper receipt, Respondent is directed to deliver an insurance policy issued in Decedent’s name to a beneficiary named in the policy.

SIGNED on the _______________ day of ______________________ , 2011.

_________________________________________________
JUDGE PRESIDING

APPROVED AS TO FORM:

_________________________________________________
Sue R. Settle
Attorney for Movant
State Bar No.:  84516
2222 S. Court St.
Dallas, Texas 77772
Telephone: (972) 888-8888
Facsimile: (972) 888-7777
ASSIGNMENT DESCRIPTION:

Often law office staff would like to have a certain look to their printed forms that is different than what ProDoc forms look like by default. In this assignment, you will learn and demonstrate how to add a header to volume forms using the Advanced tab on the Document Formatting Options window.

DIRECTIONS:

To add a header to a form, complete the following steps. This module contains two copies of the assembled document: one assembled before the formatting changes are made and one assembled afterward.

1. Click Customize > Document Formatting.
2. Double-click the Attorney-Client Matters volume. This opens the Volume Formatting Options window.
3. Click the Advanced tab. Click the Create button and click Yes to start your word processor.
4. The word processor will now start and open a file named VOLUME.CIF.
   a. WordPerfect Users: Different versions use different menu selections to create the header. From either the Format menu or the Insert menu, select Header/Footer, select Header A and then select Create. Type The Law Offices of [*_insert your name here___*]. Apply the bold format and center justification format.
   b. Microsoft Pre-Word 2007 Users: From the View menu, select Headers/Footers. Type The Law Offices of [*_insert your name here___*]. Apply the bold format and center justification format. Click Close on the Header and Footer toolbar.
   c. Microsoft Word Users (Word 2007 and later): From the Insert menu, select Headers. Type The Law Offices of [*_insert your name here___*]. Apply the center justification format from the Home menu.
5. Click the File menu and select Save As...
   a. Change the file type to WordPerfect 5.1/5.2 (for WordPerfect users), WordPerfect 5.1 for Windows (for Word users), or Word 97 -2003 Document (.doc) (for Word 2007 and later users).
   b. Edit the file name to appear as “VOLUME.CIF” (place quotes around the name so the word processor will not add the .wpd or .doc extension).
   c. Click the Save button. Close the word processor. Click OK to close the Volume Formatting Options window and click Close to close the Default Formatting window.

TESTING THE FORMATTING SETTINGS:

1. Click the Assemble icon.
2. Click the Don’t use a case file check box.
3. Click the Select forms button. Select the Attorney-Client Matters volume.
4. Click form number 2-10 Client Information Form. Click the OK button.
5. Click the Start Assembling button.

6. After the document is assembled, you will see a Completed Documents dialog box. Click Continue to accept the default location where the file will be saved.

7. The document will now be sent to the word processor. Note that the header you added is now shown in this document. This header would be applied to every form you assemble in the volume.

8. Copies of the completed document are included in this module for comparison, one assembled before formatting changes and one assembled after. Close the word processor when you are finished reviewing the document.

D. REMOVING ADVANCED FORMATTING CHANGES

To do this:

1. Navigate to the Default Formatting window and the Advanced tab as covered in steps 1 through 3 in the Directions section of this assignment, then click the Delete button instead of the Create button.

2. Answer Yes to the confirmation window. The formatting changes are removed.

3. Click OK to close the Volume Formatting Options window and click Close to close the Default Formatting window.
CLIENT INFORMATION FORM

INSTRUCTIONS: Answer all questions truthfully and completely. The information you enter in this questionnaire is confidential and protected by Attorney-Client Privilege. The information will not be disclosed to anyone outside of this office, except in the course of rendering legal services on your behalf, or unless otherwise required by law.

Date: __________________________

CLIENT INFORMATION

Your Name: ________________________________
Home Address: ________________________________
City: __________________ State: ___________ Zip Code: ___________
County of Residence: ___________________________ You have lived at current address since: __________

Home Phone: ____________________________ Home Facsimile No: ____________________________
Cell Phone No: ____________________________ Pager/Beeper No: ____________________________
E-mail Address: ____________________________
Soc. Sec. No: ____________________________ Driver’s License No: ____________________________
Date of Birth: __________________ State/Country of Birth: __________________
Other names you have been known by: __________________________________________________________

EMPLOYER: ____________________________
Work Address: ________________________________
City: __________________________________ State: ___________ Zip Code: ___________
Work Phone: ____________________________ Work Facsimile No: ____________________________
Work E-mail Address: ____________________________

How long have you worked at this employer? ____________________________
Position: ____________________________ Salary/Earnings: $ ____________

Name of Emergency Contact, and Relation to You: ____________________________
Home Address: ________________________________
City: __________________ State: ___________ Zip Code: ___________
Home Phone: ____________________________ Work Phone: ____________________________

Nature of case / reason for seeking consultation with our office: __________________________________________________________

How did you hear about our office? __________________________________________________________________________

OTHER PARTY INFORMATION

Name: ____________________________
Home Address: ________________________________
City: __________________ State: ___________ Zip Code: ___________
County of Residence: __________________________ Other party has lived at this address since: __________


Is other party represented by an ATTORNEY in this matter? ______ Yes  ______ No

If YES, please answer the questions below:

Name of Attorney/Firm: ________________________________ Phone: ________________________________

City where office located: ________________________________ Phone: ________________________________

Indicate if this or any other attorney has:

Represented other party in other matters (besides this case)? ______ Yes  ______ No
Provided advice or other services to you regarding this case? ______ Yes  ______ No
Provided advice or other services to you regarding other matters? ______ Yes  ______ No
Talked with you in person or by telephone regarding this case? ______ Yes  ______ No
Sent a letter or other written communications to you related to this case? ______ Yes  ______ No
Served papers (by a sheriff or process server) upon you in this case? ______ Yes  ______ No
Client Information Form - Before

The Law Offices of {Student’s Name}

CLIENT INFORMATION FORM

INSTRUCTIONS: Answer all questions truthfully and completely. The information you enter in this questionnaire is confidential and protected by Attorney-Client Privilege. The information will not be disclosed to anyone outside of this office, except in the course of rendering legal services on your behalf, or unless otherwise required by law.

Date: ____________________________

CLIENT INFORMATION

Your Name: ____________________________________________________________

Home Address: __________________________________________________________

City: __________________________ State: __________________ Zip Code: ____________

County of Residence: __________________________ You have lived at current address since: ____________

Home Phone: __________________________ Home Facsimile No: __________________________

Cell Phone No: __________________________ Pager/Beeper No: __________________________

E-mail Address: __________________________________________________________

Soc. Sec. No: __________________________ Driver’s License No: __________________________

Date of Birth: __________________________ State/Country of Birth: __________________________

Other names you have been known by: ____________________________________________

EMPLOYER: __________________________

Work Address: __________________________

City: __________________________ State: __________________ Zip Code: ____________

Work Phone: __________________________ Work Facsimile No: __________________________

Work E-mail Address: __________________________________________________________

How long have you worked at this employer? __________________________

Position: __________________________ Salary/Earnings: $____________________________

Name of Emergency Contact, and Relation to You: __________________________________

Home Address: __________________________________________________________

City: __________________________ State: __________________ Zip Code: ____________

Home Phone: __________________________ Work Phone: __________________________

Nature of case / reason for seeking consultation with our office: __________________________

________________________________________________________________________

________________________________________________________________________

How did you hear about our office? ____________________________________________

________________________________________________________________________
OTHER PARTY INFORMATION

Name: _____________________________________________ _____________________________________________________________
Home Address:  _____________________________________________ ____________________________________________________
City: ____________________________________________________________________ State: _______________ Zip Code: ____________
County of Residence: __________________________________ Other party has lived at this address since: __________________

Home Phone: _________________________ Home Facsimile No: _________________________
Cell Phone No: _________________________ Pager/Beeper No: _________________________
E-mail Address: __________________________________________________________________________________________

Soc. Sec. No: _____________________________________________ Driver’s License No: _________________________________
Date of Birth: __________________________________________________________________________ State/Country of Birth: __________________________
Other names you have been known by: __________________________________________________________________________

EMPLOYER: ________________________________ ____________________________________________________________________
Work Address: ________________________________ ________________________________ _________________________________
City: ____________________________________________________________________ State: _______________ Zip Code: ____________
Work Phone: _________________________ Work Facsimile No: _________________________
Work E-mail Address: __________________________________________________________________________________________

How long have you worked at this employer? __________________________________________________________________________
Position: __________________________________________________________________________ Salary/Earnings: $

Is other party represented by an ATTORNEY in this matter? ________ Yes ________ No

If YES, please answer the questions below:

Name of Attorney/Firm: ____________________________________________________________________________________________
City where office located: _____________________________ Phone: ____________________________________________________________________________________________
Indicate if this or any other attorney has:

Represented other party in other matters (besides this case)? ________ Yes ________ No
Provided advice or other services to you regarding this case? ________ Yes ________ No
Provided advice or other services to you regarding other matters? ________ Yes ________ No
Talked with you in person or by telephone regarding this case? ________ Yes ________ No
Sent a letter or other written communications to you related to this case? ________ Yes ________ No
Served papers (by a sheriff or process server) upon you in this case? ________ Yes ________ No
Module 10 - Quick Check

1. True or False: Once the document formatting for a specific volume has been changed, the changes cannot be removed.

2. True or False: You have an unlimited number of fonts to choose from in ProDoc for document formatting.

3. True or False: There are three types of document formatting: global, volume, and specific document.
Module 11 – Graphic Forms

A. MODULE DESCRIPTION

Up to this point you have been working only with word processor forms. Now you will learn about a different kind of form that ProDoc calls graphic forms. A good example of a graphic form is the 1040 A federal tax return. Graphic forms are government produced forms generally containing fill-in-the-blank fields. The major difference you will find is that, when you are completing a graphic form, ProDoc does not ask any assembly questions since the language is already fixed on the form. Instead, you will be answering questions directly related to the data to be entered into the form, in addition to entering much of the data directly on the form.

However, ProDoc still saves all the data from the form in the main database so it can be used in future forms assembly for the case. This includes both future graphic forms and future word processor forms.

B. OBJECTIVES

Upon successful completion of this module, you will be able to:

1. Explain the difference between a word processor form and a Graphic Form.
2. Demonstrate how to create a Graphic Form.
3. Demonstrate how to use the graphic engine features in order to adjust the text and data fields on a Graphic Form.

C. PROCEDURE

1. Creating a Graphic Form

Complete the following steps:


b. ProDoc already knows that the volume for this case is the Family Law volume so you go immediately to the Select Forms window.

c. Click the Alphabetical tab and begin typing Civil Ca... and you will be taken to the Civil Case Information Sheet (NOT SBOT) form. Select it and click OK.

d. Make sure Review prior answers is checked.

e. Select Ima Student as the Default Answer Set.

f. Start assembling the form and accept the suggested answers.

g. After you confirm the names of the parties you are taken to the Graphic Engine.
2. **Understanding the Graphic Engine Features**

Review the graphic engine features:

- **Page Navigator** – If the document has multiple pages, use this feature to go to a specific page.
- **Zoom** – The Zoom feature enables you to enlarge and later reduce the page view.
- **Add Blank Page** – Click this button (available in California only) to add additional pages to the end of the document with these formatting options for the page: Additional Page (blank page with the short title and case number), attached declaration, attachment page, and pleading paper (no title or case number at the top).
- **Remove Current Page** – Use this feature to remove any pages you manually added with the Add Blank Page feature.
- **Print Document** – Click here to print the document.
- **Save Document to PDF** – Clicking here causes the document to be saved and opened as a PDF document.
- **Font** – Use these two features to set the font type and size in the field in which you are working.
- **Squish** – The Squish feature compresses the font in the selected field closer together.
- **Bold/Indent/Underline** – Use these three features to make these special font attributes.
- **Applies Current Font to All Fields on Page** – Click here and the font settings you made in 7, 8, and/or 9 above are applied to the data in all fields on the current page.
- **Undo** – The Undo function reverses any changes you make. It works just like the Undo command in your word processor.
- **Explanation** – This feature shows you the question for that field. It also shows you the question number—the token number in ProDoc lingo—which enables you to more quickly locate the question and change the answer using the **Edit Case Answers** feature.
- **Ad Hoc** – This feature is covered in detail below in the next section.
- **Default** – Click this button after entering data in a field to make the data the default for this field. The default data is automatically suggested in that field for future documents.
- **QuickText** – ProDoc’s QuickText feature is a language library in which you can store your favorite clauses and other language.
- **Save and Continue** – If you’ve made numerous changes with more to go, it’s sometimes a good idea to use this feature to save your work so you don’t lose it if something happens to your computer. After the save is complete you can continue working on the page.
- **Save and Close** – When you’re done you can save and close this page. This will generate the final document to a PDF for you to view and print.
r. **Cancel** – This closes the document without saving the changes.

s. **Page Navigator** – This is the second feature that enables you to navigate to a specific page of a multiple page document.

3. **Using the Ad Hoc Feature**

You can create ad hoc fields, move them around the page, and lengthen or shorten them using the **Ad Hoc** Button. The field height automatically resizes based on the font size.

Click on the **Ad Hoc** button and view the drop down with the options to:

a. **Add** – Create a field anywhere on the page shown,

b. **Move/Resize** – Used to move the field around the page or shorten/lengthen the field,

c. **Edit** – Enables you to edit the text when you have Move/Resize selected, and

d. **Delete** – Permanently removes the selected field.

4. **Finishing the Form in the Graphic Engine**

Complete the following steps:

a. Your cursor is in the first file to be filled (colored in turquoise) so enter **IMOMO Robert G. Hutton and Judy Hutton**.

b. Click the **Tab** key to be taken to the **Name** field for the person completing the form. Enter your name.

c. Assuming that you will be the person completing this form in the future, click the **Default** button and confirm that this is the default answer for this field for the **Ima Student Default Answer Set**.

d. **Tab** to the **Address** field and enter **123 Broadway** and again set this as the **Default** answer.

e. **Tab** to the **City** field and enter **San Antonio**. However, you cannot enter it because the field is too small. Go to the **Font Size** feature and reduce the font size from **12** to **10** and continue entering the remaining letters for the city. However, San Antonio is still too large for the field so change the font size to **8**. Now you can fully enter **San Antonio** into the field. Set this answer as the **Default**.

f. **Tab** to the **State** and **Zip** fields, and set your answers as the defaults while you are still in each field.

g. **Tab** to the **Email** field and enter **sally.jones@topdoglawfirm.com**. It is also too long for the field. Go to the **Squish** feature and set it to **60**. You can now enter the entire email address but it is squished too badly and is barely readable. You could elect to reduce the font size but let’s stay with the **Squish** feature for this example. While your cursor is still in the **Email** field, click the up arrow in the **Squish** field one click at a time. Notice that the text separates slightly with each click. When you reach **70**, you suddenly lose the m in **.com**. Click the down arrow to reduce the **Squish** to **69**.

h. **Tab** to the **Telephone** and **Fax** fields respectively, enter a number and set each number as the **Default** while in that field.
ProDoc Student Manual - Texas

Module 11 - Graphic Forms

5. **Revising the Graphic Form**

After closing the document you realize that you should have entered your attorney’s name and address info and you want to change some of the font sizes. Complete the following steps:

a. You could use the **Editing Case Answers** feature that you covered in **Module 6** to change the attorney information. But since you also want to change font sizes, we will reassemble the document to enable us to do both at the same time.

b. Click the **Document** icon on the ProDoc toolbar and choose the **Robert B. Hutton Divorce** case.

c. Click **Civil Case Information Sheet (NOT SBOT)** and then click the **Reassemble** button. Choose **Overwrite the same Document** and deselect **Do you want to review prior answers?**

d. When the **Graphic Engine** opens, you find that the fields you have previously answered are locked because you selected **Review Prior Answers**.

e. Click the **Cancel** button, select to **Return to Document Manager**. Click **No** to not save your answers since you made no changes.

f. Click the **Civil Case Information Sheet (NOT SBOT)** again and click the **Reassemble** button. Choose **Overwrite the same Document**.

g. This time leave **Do you want to review prior answers?** selected.

h. The graphic engine opens and the **Answers too Long For Display** window alerts you that the answer(s) in one or more fields cannot properly display and it highlights those fields in red. Click **OK** to close this window.
i. ProDoc does not save some of the data in this particular form that you previously entered so use the cursor to move to the fields that require data entry.

j. After entering the case style again (IMOMO Robert G. Hutton and Judy Hutton), and while your cursor is still in that data field, go up to the Font Feature and select @Ariel Unicode MS as the Font and 10 as the size.

k. Click the Apply Current Font to All Fields on Page feature and wait until the graphic engine completes the changes. However, two fields are too small for the data.

l. Click the Change All Fields Anyway button.

m. Click into the City field and select a Font Size of 8. Since the field is still too small, Squish the font until it fits.

n. Click the Email field and change the Font Size to 8.

o. Since the email address still does not completely fit in the allotted field, Squish the text until the email address fits in the field.

p. Click the Save & Close button.

q. Review the PDF of the document and close.

D. ADDITIONAL RESOURCES

Additional ProDoc resources available to assist you in understanding more about the Graphic Forms feature include:

- Graphic Engine TechTip (tinyurl.com/pd-graphic-engine): This TechTip provides step-by-step instructions with screens shots in use this feature.

E. REVIEW

1. True or False: The process for generating word processor documents and graphic forms is the same.

2. Why do you want to choose to Review Answers when you use the Reassemble feature to change answers in the form?

3. What are your options for fitting an answer into a field when it is too large for the field?
Module 11 - Assignment

A. ASSIGNMENT DESCRIPTION:

In the following assignment you will modify the default settings for the Graphic Engine, create a Graphic Form, and modify the content as necessary to fit the data in the appropriate field(s).

B. DIRECTIONS:

1. Change the Graphic Engine Default Settings

   The default font settings for the Graphic Engine are Size 12 Times New Roman. You will now learn how to change these default settings:

   To change the Graphic Engine default settings, complete the following steps:

   1. Using the instructions from Module 7, navigate to the Graphic Forms area in the Personal Settings section of the Options and Settings window.
   2. Change the Typeface from Times New Roman to Ariel Unicode MS.
   3. Change the Point Size to 10.
   4. Click OK.

2. Generating a HUD-1 Graphic Form:

   a. Click the Client/Case icon on the ProDoc toolbar.
   b. Create a new client called Paul Bradley. Don’t bother to enter any additional information about the client at this point.
   c. Create a new case for Paul Bradley called Home Closing.
   d. Close the Client/Case Manager window.
   e. Click the Assemble Document icon.
   f. Select the Paul Bradley Home Closing client and case.
   g. Click the Select Forms button and choose the Real Estate volume.
   h. Click the Alphabetical tab and type “hud”.
   i. Select the HUD-1 [Borrower Information Only] form.
   j. Review prior answers is not important in this situation since this is a new case with no prior answers so accept the default.
   k. Choose the Allan A Attorney Default answer set.
   l. Begin the assembly session. Enter information as per the Worksheet for this assignment.

   **Note:** There is a lot of data to enter on these pages. Don’t stress over which field is the correct one for the data. This assignment is about using the Graphic Engine, not about correctly completing a HUD-1 Settlement Statement – that will come another time. Do the best you can without asking for your instructor’s guidance over the correct fields to enter the data.
m. Since this is a 4-page document, you may need to use the page navigator to go from page to page.

n. When done, go back to page 1 and, using the Ad Hoc feature, add an Ad Hoc field at the top of the page and type into it: **This is an initial draft only.** Increase the font size to 20.

o. The text no longer fits within the field so use the Move/Resize function of the Ad Hoc feature to increase the size of the field.

p. Now use the Move/Resize function of the Ad Hoc feature to center the field underneath **Settlement Statement (HUD-1)**

q. Click the Save & Close button.

r. Review the document in your PDF viewer.

s. A copy of the completed HUD-1 is included for you to compare against.
## MODULE 11, ASSIGNMENT WORKSHEET

<table>
<thead>
<tr>
<th>Item</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Describe your client:</td>
<td>Buyer</td>
</tr>
<tr>
<td>SELECT TYPE of LOAN:</td>
<td>Conv. Ins.</td>
</tr>
<tr>
<td>Any parties acting as ATTORNEY-IN-FACT?</td>
<td>No</td>
</tr>
<tr>
<td>How Many Borrowers?</td>
<td>1</td>
</tr>
<tr>
<td>NAME of Borrower/Maker/Debtor:</td>
<td>Paul Bradley</td>
</tr>
<tr>
<td>DESCRIBE Paul Bradley:</td>
<td>Individual</td>
</tr>
<tr>
<td>MAILING ADDRESS of borrower:</td>
<td>10206 Grand Court, San Antonio, TX 78239</td>
</tr>
<tr>
<td>How Many Sellers?</td>
<td>1</td>
</tr>
<tr>
<td>NAME of SELLER:</td>
<td>Sal Seller</td>
</tr>
<tr>
<td>DESCRIBE Sal Seller:</td>
<td>Individual</td>
</tr>
<tr>
<td>MAILING ADDRESS of Sal Seller:</td>
<td>4839 Chalmers Blvd, San Antonio, TX 78247</td>
</tr>
<tr>
<td>Number of Lenders:</td>
<td>1</td>
</tr>
<tr>
<td>NAME of LENDER:</td>
<td>Tip Top Lending</td>
</tr>
<tr>
<td>DESCRIBE Tip Top Lending:</td>
<td>Entity</td>
</tr>
<tr>
<td>MAILING ADDRESS of Lender:</td>
<td>12 Peachtree Lane, San Antonio, TX 78222</td>
</tr>
<tr>
<td>SELECT TAXES or Assessments PAID by Seller IN ADVANCE:</td>
<td>Assessments</td>
</tr>
<tr>
<td>FILE NUMBER:</td>
<td>2011-12-398</td>
</tr>
<tr>
<td>LOAN NUMBER:</td>
<td>TX-1452897</td>
</tr>
<tr>
<td>MORTGAGE INSURANCE CASE NUMBER:</td>
<td>345-4733-82</td>
</tr>
<tr>
<td>PROPERTY LOCATION:</td>
<td>1515 Lone Star Trail, Selma, TX 78244</td>
</tr>
<tr>
<td>SETTLEMENT AGENT:</td>
<td>Holly McBrice</td>
</tr>
<tr>
<td>SETTLEMENT DATE:</td>
<td>March 23, 2012</td>
</tr>
<tr>
<td>PLACE of SETTLEMENT:</td>
<td>San Antonio, TX</td>
</tr>
<tr>
<td>CONTRACT SALES PRICE:</td>
<td>215,000</td>
</tr>
<tr>
<td>TOTAL (Annual) Amount of ASSESSMENTS:</td>
<td>2,000</td>
</tr>
<tr>
<td>BEGINNING DATE of Assessments paid in advance by Seller:</td>
<td>03/01/2012</td>
</tr>
<tr>
<td>ENDING DATE of Assessments paid in advance by Seller:</td>
<td>12/31/2012</td>
</tr>
<tr>
<td>AMOUNT of Deposit or Earnest Money:</td>
<td>5,000</td>
</tr>
<tr>
<td>PRINCIPAL AMOUNT of New Loan:</td>
<td>200,550</td>
</tr>
<tr>
<td>TOTAL (ANNUAL) AMOUNT of City/Town taxes:</td>
<td>5,000</td>
</tr>
<tr>
<td>BEGINNING DATE of City/Town taxes unpaid by the seller:</td>
<td>01/01/2012</td>
</tr>
<tr>
<td>ENDING DATE of City/Town taxes unpaid by the seller:</td>
<td>03/23/2012</td>
</tr>
<tr>
<td>TOTAL (Annual) Amount of COUNTY Taxes:</td>
<td>800</td>
</tr>
<tr>
<td>BEGINNING DATE of County taxes unpaid by the seller:</td>
<td>01/01/2012</td>
</tr>
<tr>
<td>ENDING DATE of County taxes unpaid by the seller:</td>
<td>03/23/2012</td>
</tr>
<tr>
<td>Our Loan Origination charge:</td>
<td>1.0%</td>
</tr>
<tr>
<td>AMOUNT of ORIGINATION CHARGE, before applying credits or charges:</td>
<td>2,005.50</td>
</tr>
<tr>
<td>Amount of CREDIT CHARGE (points):</td>
<td>1.5%</td>
</tr>
<tr>
<td>AMOUNT of CREDIT or CHARGE (points) for the interest rate chosen:</td>
<td>3,008.25</td>
</tr>
<tr>
<td>Amount of Adjusted Origination Charge:</td>
<td>3,008.25</td>
</tr>
</tbody>
</table>
### Loan Terms on Page 3

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LENGTH of LOAN TERM</strong>, in years:</td>
<td><strong>30</strong></td>
</tr>
<tr>
<td><strong>INITIAL INTEREST RATE:</strong></td>
<td><strong>4.00%</strong></td>
</tr>
<tr>
<td><strong>INITIAL MONTHLY PAYMENT:</strong></td>
<td><strong>2,837.51</strong></td>
</tr>
<tr>
<td><strong>SELECT ANY ITEMS INCLUDED in the monthly payment:</strong></td>
<td><strong>Principal, Interest, Mortgage insurance</strong></td>
</tr>
<tr>
<td>Can the <strong>INTEREST RATE</strong> on the loan <strong>RISE?</strong></td>
<td><strong>No</strong></td>
</tr>
<tr>
<td>Can the <strong>LOAN BALANCE</strong> <strong>RISE</strong>, even if payments are made on time?</td>
<td><strong>No</strong></td>
</tr>
<tr>
<td>Question</td>
<td>Answer</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Can the MONTHLY AMOUNT owed for principal, interest and mortgage insurance RISE, even if payments are made on time?</td>
<td>No</td>
</tr>
<tr>
<td>Does the loan have a PREPAYMENT PENALTY?</td>
<td>Yes</td>
</tr>
<tr>
<td>AMOUNT of MAXIMUM PREPAYMENT PENALTY:</td>
<td>2,150</td>
</tr>
<tr>
<td>Does the loan have a BALLOON PAYMENT?</td>
<td>No</td>
</tr>
<tr>
<td>Does the monthly payment INCLUDE an ESCROW PAYMENT for items such as property taxes and homeowner’s insurance?</td>
<td>Yes</td>
</tr>
<tr>
<td>Additional MONTHLY ESCROW PAYMENT:</td>
<td>657</td>
</tr>
<tr>
<td>INITIAL MONTHLY PAYMENT:</td>
<td>2,837.51</td>
</tr>
<tr>
<td>Additional EXCROW ITEMS: Property Taxes, Homeowner’s Insurance, Mortgage Insurance</td>
<td></td>
</tr>
</tbody>
</table>
# A. Settlement Statement (HUD-1)

This is an initial draft only

## B. Type of Loan

<table>
<thead>
<tr>
<th>1.</th>
<th>FHA</th>
<th>2.</th>
<th>RHS</th>
<th>3.</th>
<th>Conv. Loans</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>4.</th>
<th>VA</th>
<th>5.</th>
<th>X Conv. Ins.</th>
</tr>
</thead>
</table>

## C. Note:

This firm is furnished to give you a statement of actual settlement costs. Amounts paid to and by the settlement agent are shown. Items marked "(g.o.c.)" were paid outside the closing; they are shown here for informational purposes and are not included in the totals.

## D. Name & Address of Borrower:
Paul Bradley
10206 Grand Court
San Antonio, TX 78239

## E. Name & Address of Seller:
Sol Seller
4839 Chalmers Blvd
San Antonio, TX 78247

## F. Name & Address of Lender:
Tip Top Lending
12 Peachtree Lane
San Antonio, TX 78222

## G. Property Location:
1515 Lone Star Trail
Selma, TX 78244

## H. Settlement Agent:
Holly McBride
Place of Settlement: San Antonio, TX

## I. Settlement Date:
March 23, 2011

## J. Summary of Borrower's Transaction

| 100. Gross Amount Due from Borrower | 215,000 |
| 101. Contract sales price | 215,000 |
| 102. Personal property | 9,474.79 |
| 103. Settlement charges to borrower (line 1400) | 9,474.79 |
| 104. | |
| 105. | |

Adjustment for items paid by seller in advance

| 106. City/town taxes | to |
| 107. County taxes | to |
| 108. Assessments | 0.00 |
| 03/01/2011 | to 12/31/2011 |
| 109. | |
| 110. | |
| 111. | |
| 112. | |
| 120. Gross Amount Due from Borrower | 226,146.02 |
| 200. Amount Paid by or in Behalf of Borrower | 5,000 |
| 201. Deposit or earnest money | 5,000 |
| 202. Principal amount of new loan(s) | 200,550 |
| 203. Existing loan(s) taken subject to | 200,550 |
| 204. | |
| 205. | |
| 206. | |
| 207. | |
| 208. | |
| 209. | |

Adjustments for items unpaid by seller

| 210. City/town taxes | 01/01/2011 | to | 03/23/2011 | 1,123.29 |
| 211. County taxes | 01/01/2011 | to | 03/23/2011 | 179.73 |
| 212. Assessments | to |
| 213. | |
| 214. | |
| 215. | |
| 216. | |
| 217. | |
| 218. | |
| 219. | |
| 220. Total Paid by Borrower | 206,853.02 |

## K. Summary of Seller's Transaction

### 400. Gross Amount Due to Seller

| 401. Contract sales price |  |
| 402. Personal property |  |
| 403. | |
| 404. | |
| 405. | |

Adjustment for items paid by seller in advance

| 406. City/town taxes | to |
| 407. County taxes | to |
| 408. Assessments | to |
| 409. | |
| 410. | |
| 411. | |
| 412. | |
| 420. Gross Amount Due to Seller |  |

### 500. Reductions in Amount Due to Seller

| 501. Excess deposit (see instructions) |  |
| 502. Settlement charges to seller (line 1400) |  |
| 503. Existing loan(s) taken subject to |  |
| 504. Payoff of first mortgage loan |  |
| 505. Payoff of second mortgage loan |  |
| 506. | |
| 507. | |
| 508. | |
| 509. | |

Adjustments for items unpaid by seller

| 510. City/town taxes | to |
| 511. County taxes | to |
| 512. Assessments | to |
| 513. | |
| 514. | |
| 515. | |
| 516. | |
| 517. | |
| 518. | |
| 519. | |
| 520. Total Reduction Amount Due Seller |  |

### 600. Cash at Settlement to/from Seller

| 601. Gross amount due to seller (line 420) |  |
| 602. Less reductions in amounts due seller (line 520) |  |
| 603. Cash | To | From Seller |  |

The Public Reporting Burden for this collection of information is estimated at 35 minutes per response for collecting, reviewing, and reporting the data. This agency may not collect this information, and you are not required to complete this form, unless it displays a currently valid OMB control number. No confidentiality is assured; this disclosure is mandatory. This is designed to provide the parties to a RESPA-covered transaction with information during the settlement process.
## L. Settlement Charges

### 700. Total Real Estate Broker Fee

<table>
<thead>
<tr>
<th>Division of commission (line 705) as follows:</th>
<th>Paid From</th>
<th>Paid From</th>
</tr>
</thead>
<tbody>
<tr>
<td>701. $ x to x</td>
<td>Borrower’s Funds at Settlement</td>
<td></td>
</tr>
<tr>
<td>702. $ x to x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>703. Commission paid at settlement</td>
<td></td>
<td></td>
</tr>
<tr>
<td>704.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 800. Items Payable in Connection with Loan

#### P.O.C.

<table>
<thead>
<tr>
<th>Item</th>
<th>Amount</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>801.</td>
<td>$2005.50</td>
<td>Originating charge 1.0%</td>
</tr>
<tr>
<td>802.</td>
<td>$3008.25</td>
<td>Your credit charge for the specific interest rate chosen 1.5%</td>
</tr>
<tr>
<td>803.</td>
<td></td>
<td>Your adjusted origination charges (from GFE #A)</td>
</tr>
<tr>
<td>804.</td>
<td>400</td>
<td>Appraisal fee to A-1 Appraisals (from GFE #X)</td>
</tr>
<tr>
<td>805.</td>
<td>35</td>
<td>Credit report to TransUnion (from GFE #X)</td>
</tr>
<tr>
<td>806.</td>
<td>50</td>
<td>Tax service to A-1 Service (from GFE #X)</td>
</tr>
<tr>
<td>807.</td>
<td></td>
<td>Flood certification to (from GFE #X)</td>
</tr>
</tbody>
</table>

### 900. Items Required by Lender to be Paid in Advance

<table>
<thead>
<tr>
<th>Item</th>
<th>Amount</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>901.</td>
<td>$191.04</td>
<td>Daily interest charges from 3/23/2011 to 3/31/2011 @ $23.88/day (from GFE #B)</td>
</tr>
<tr>
<td>902.</td>
<td></td>
<td>Mortgage insurance premium for 3 months to Tip Top Lending (from GFE #X)</td>
</tr>
<tr>
<td>903.</td>
<td>657</td>
<td>Homeowner’s insurance for 1 year to State Farm (from GFE #H)</td>
</tr>
</tbody>
</table>

### 1000. Reserves Deposited with Lender

<table>
<thead>
<tr>
<th>Item</th>
<th>Amount</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1001.</td>
<td>$1,066.00</td>
<td>Initial deposit for your escrow account (from GFE #G)</td>
</tr>
<tr>
<td>1002.</td>
<td>$315.00</td>
<td>Homeowner’s insurance 3 months @ $105 per month (from GFE #G)</td>
</tr>
<tr>
<td>1003.</td>
<td>$81.00</td>
<td>Mortgage insurance 3 months @ $27 per month (from GFE #G)</td>
</tr>
<tr>
<td>1004.</td>
<td>$670.00</td>
<td>Property Taxes 2 months @ $335 per month (from GFE #G)</td>
</tr>
<tr>
<td>1005.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1006.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1007.</td>
<td></td>
<td>Aggregate Adjustment</td>
</tr>
</tbody>
</table>

### 1100. Title Charges

<table>
<thead>
<tr>
<th>Item</th>
<th>Amount</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1101.</td>
<td></td>
<td>Title services and lender’s title insurance (from GFE #A)</td>
</tr>
<tr>
<td>1102.</td>
<td>$300</td>
<td>Settlement or closing fee High Hat Title Company (from GFE #H)</td>
</tr>
<tr>
<td>1103.</td>
<td>2547</td>
<td>Owner’s title insurance High Hat Title Company (from GFE #H)</td>
</tr>
<tr>
<td>1104.</td>
<td></td>
<td>Lender’s title insurance</td>
</tr>
<tr>
<td>1105.</td>
<td></td>
<td>Lender’s title policy rate $</td>
</tr>
<tr>
<td>1106.</td>
<td></td>
<td>Owner’s title policy rate $</td>
</tr>
<tr>
<td>1107.</td>
<td></td>
<td>Agent’s portion of the total title insurance premium to</td>
</tr>
<tr>
<td>1108.</td>
<td></td>
<td>Underwriter’s portion of the total title insurance premium to</td>
</tr>
</tbody>
</table>

### 1200. Government Recording and Transfer Charges

<table>
<thead>
<tr>
<th>Item</th>
<th>Amount</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1201.</td>
<td></td>
<td>Government recording charges (from GFE #H)</td>
</tr>
<tr>
<td>1202.</td>
<td></td>
<td>Deed $25 Mortgage $35 Release $</td>
</tr>
<tr>
<td>1203.</td>
<td></td>
<td>Transfer taxes (from GFE #H)</td>
</tr>
<tr>
<td>1204.</td>
<td></td>
<td>City/County tax/stamps Dead $ Mortgage $</td>
</tr>
<tr>
<td>1205.</td>
<td></td>
<td>State tax/stamps Dead $ Mortgage $</td>
</tr>
</tbody>
</table>

### 1300. Additional Settlement Charges

<table>
<thead>
<tr>
<th>Item</th>
<th>Amount</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1301.</td>
<td></td>
<td>Required services that you can shop for (from GFE #H)</td>
</tr>
<tr>
<td>1302.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1303.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1304.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 1400. Total Settlement Charges (enter on lines 103, Section J and 502, Section K)

<table>
<thead>
<tr>
<th>Item</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>1400.</td>
<td>$9,474.79</td>
</tr>
</tbody>
</table>
## COMPLETED HUD-1, PAGE 3

### Comparison of Good Faith Estimate (GFE) and HUD-1 Charges

<table>
<thead>
<tr>
<th>Charges That Cannot Increase</th>
<th>HUD-1 Line Number</th>
<th>Good Faith Estimate</th>
<th>HUD-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Our origination charge</td>
<td># 801</td>
<td></td>
<td>2005.50</td>
</tr>
<tr>
<td>Your credit or charge (points) for the specific interest rate chosen</td>
<td># 802</td>
<td></td>
<td>3008.25</td>
</tr>
<tr>
<td>Your adjusted origination charges</td>
<td># 902</td>
<td></td>
<td>5,013.75</td>
</tr>
<tr>
<td>Transfer taxes</td>
<td># 1203</td>
<td></td>
<td>0.00</td>
</tr>
</tbody>
</table>

### Charges That In Total Cannot Increase More Than 10%

<table>
<thead>
<tr>
<th>Government recording charges</th>
<th># 1201</th>
<th>Good Faith Estimate</th>
<th>HUD-1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

### Charges That Can Change

<table>
<thead>
<tr>
<th>Initial deposit for your escrow account</th>
<th># 1001</th>
<th>Good Faith Estimate</th>
<th>HUD-1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>1,066.00</td>
<td></td>
</tr>
<tr>
<td>Daily interest charges</td>
<td>$ 23.88</td>
<td>Good Faith Estimate</td>
<td>HUD-1</td>
</tr>
<tr>
<td>Homeowner's insurance</td>
<td># 903</td>
<td>191.04</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>657.00</td>
<td></td>
</tr>
</tbody>
</table>

### Loan Terms

<table>
<thead>
<tr>
<th>Your initial loan amount is</th>
<th>$ 200,550</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your loan term is</td>
<td>30 years</td>
</tr>
<tr>
<td>Your initial interest rate is</td>
<td>4.00 %</td>
</tr>
</tbody>
</table>

Your initial monthly amount owed for principal, interest, and any mortgage insurance is $2,837.51 includes:

- Principal
- Interest
- Mortgage Insurance

### Can your interest rate rise?

- Yes
- No

- Yes, it can rise to a maximum of $ , after % . Every change date, your interest rate can increase or decrease by % . Over the life of the loan, your interest rate is guaranteed to never be lower than % or higher than %.

### Even if you make payments on time, can your loan balance rise?

- Yes
- No

- Yes, it can rise to a maximum of $ .

### Even if you make payments on time, can your monthly amount owed for principal, interest, and mortgage insurance rise?

- Yes
- No

- Yes, the first increase can be on and the monthly amount owed can rise to $ . The maximum it can ever rise to is $ .

### Does your loan have a prepayment penalty?

- Yes
- No

- Yes, your maximum prepayment penalty is $ 2,150 .

### Does your loan have a balloon payment?

- Yes
- No

- Yes, you have a balloon payment of $ due in years .

Total monthly amount owed including escrow account payments:

- You do not have a monthly escrow payment for items, such as property taxes and homeowner's insurance. You must pay these items directly yourself.
- You have an additional monthly escrow payment of $ 657 . This includes principal, interest, any mortgage insurance and any items checked below:
  - Property taxes
  - Homeowner's insurance
  - Flood insurance
  - Mortgage Insurance

**Note:** If you have any questions about the Settlement Charges and Loan Terms listed on this form, please contact your lender.
Addendum to Settlement Statement (HUD-1)
(Not an OMB approved form)

The HUD-1 Settlement Statement which I have prepared is a true and accurate account of this transaction. I have caused or will cause the funds to be disbursed in accordance with this statement.

Settlement Agent: _______________________________ Date: _______________________________

Holly McBrice
Module 11 - Quick Check

1. True or False: You are limited to entering data only in the official blanks on the form.

2. True or False: Once a graphic form has been created, it cannot be revised.

3. True or False: Unlike word processor forms, you have no control over the default font style and size for graphic forms.
Module 12 - Form Sets

A. MODULE DESCRIPTION

Form Sets are groups of forms that will be used on a frequent basis. For example, if the user consistently prepares a package for wills, that user may want to assemble a set for a Man’s Will. This set would probably contain the Will, Durable Power of Attorney, and Designation of Health Care Surrogate, among others. Once grouped as a set, these forms can be assembled as a set. This saves time needed to select each form individually and answer questions for each individual form. There is no practical limit to the number of forms you may have in a Form Set.

B. OBJECTIVES

Upon successful completion of this module, you will be able to:

1. Explain the function and use of Form Sets.
2. Demonstrate how to create a Form Set using more than two forms.
3. Demonstrate how to assemble a series of documents from an existing Form Set.

C. PROCEDURE

1. Creating a Form Set

Complete the following steps:

a. Click Customize > Form Sets.

b. Select the Small Estate Wills volume.

c. The Browse and Update Form Sets window appears. Click the New Set button.

d. Type Man’s Will and click the OK button.

e. Click the Update Forms button.

f. Select the following forms by clicking the titles: 1-01 Will (with pourover option for living trust) (Man); 1-10 Durable General Power of Attorney-Man (Long Form); 1-20 Directive to Physician (Man); 6-02 Revocable Living Trust for Married Settlors (Joint). Click the OK button.

g. Note that the form set name is listed on the left side of the window and the forms in the set are listed on the right side. Click the Close button.

2. Using the set for document assembly

Complete the following steps:

a. Click the Assemble icon

b. Click the Select case button.

c. Click the New Client button. Type Doe as the last name and James as the first name of the new client.
d. Click the New Case button. Enter 1 for the Case ID and Will for the Description. Click the OK button to close that window.

e. Click the Select Case button.

f. In the Starting Document Assembly window, click the Select Forms button. Select the Small Estate Wills volume.

g. Click the Form Sets tab. The form set Man’s Will appears in the window. Click the set name and click the Select button.

h. ProDoc will show the forms that are currently in that form set and give you the opportunity to remove one or more of the documents from the form set. Removing a form here only removes it from the assembly session; this does not modify the form set. Click the OK button to accept all of the forms.

i. Click the Start Assembling button.

j. ProDoc will start the assembly process and begin asking questions for all the forms in the set. Answer the questions however you wish. When all questions have been answered, ProDoc will assemble the document on the screen and give the user the opportunity to answer any remaining questions.

k. ProDoc will finish the assembly process and display a Completed Documents dialog window. Click the Continue button to accept the names of the documents.

l. ProDoc will now post the completed documents into the word processor. Note that each document will be listed in the word processor’s most recent documents menu (under the File menu). Each document will be listed separately and can be opened by selecting the desired document.

D. ADDITIONAL RESOURCES

Additional ProDoc resources available to assist you in understanding more about the Forms Sets feature include:

• Form Sets TechTip (tinyurl.com/pd-form-sets): This TechTip provides step-by-step instructions with screens shots in use this feature.

• Form Sets Video (tinyurl.com/pd-create-form-sets): This self-running video demonstrates how to use this feature.

E. REVIEW

1. True or False: You are limited to a maximum of four forms in a Form Set.

2. Under which tab will you be able to view existing Form Sets?

3. True or False: Once a Form Set has been created, you cannot remove any of the forms from the set.
### WILLS WORKSHEET

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Describe the Testator in Man’s Will:</td>
<td>Married Man</td>
</tr>
<tr>
<td>How many children of Testator are named in Man’s Will?</td>
<td>Two</td>
</tr>
<tr>
<td>Do you want to mention afterborn children in Man’s Will?</td>
<td>No</td>
</tr>
<tr>
<td>Is Man’s Will to be a POUROVER Will to be used with LIVING TRUST?</td>
<td>No</td>
</tr>
<tr>
<td>How many specific bequests are listed in Man’s Will?</td>
<td>Two</td>
</tr>
<tr>
<td>Who will receive the general bequest in Man’s Will?</td>
<td>Spouse/then Children</td>
</tr>
<tr>
<td>Do you want a no contest clause in Man’s Will?</td>
<td>No</td>
</tr>
<tr>
<td>How will this WILL be PROVED?</td>
<td>Self-proving affidavit included</td>
</tr>
<tr>
<td>Total number of Executors to be appointed in Man’s Will, including Alternates:</td>
<td>1</td>
</tr>
<tr>
<td>Describe Jane Doe named in Man’s Will:</td>
<td>Spouse</td>
</tr>
<tr>
<td>SELECT whether the Executor/Executrix will be COMPENSATED:</td>
<td>No</td>
</tr>
<tr>
<td>Do you want to include a provision regarding funeral arrangements?</td>
<td>Yes</td>
</tr>
<tr>
<td>Do you want to include CONTINGENT trust provisions in the Man’s Will?</td>
<td>No</td>
</tr>
<tr>
<td>DESCRIBE method for Testator’s verification of Man’s will</td>
<td>Initial each page</td>
</tr>
<tr>
<td>Do you want to appoint Guardians for Children named in Man’s Will?</td>
<td>No</td>
</tr>
<tr>
<td>Do you wish the Witnesses’ names and addresses to be left blank for later completion?</td>
<td>Yes</td>
</tr>
<tr>
<td>IS the Principal making Man’s Power of Attorney married?</td>
<td>Yes</td>
</tr>
<tr>
<td>Will Attorney-in-Fact be Granted SPECIAL POWERS in Man’s Long Form Power of Attorney?</td>
<td>No</td>
</tr>
<tr>
<td>When will Man’s Long Form Durable Power of Attorney become effective?</td>
<td>Upon disability or incapacity</td>
</tr>
<tr>
<td>Describe Successor Attorney(s)-in-Fact in Man’s Long Form Power of Attorney:</td>
<td>No Successors</td>
</tr>
<tr>
<td>Describe Types of Property included in Man’s Long Form Power of Attorney:</td>
<td>Both Real &amp; Personal Property</td>
</tr>
<tr>
<td>Does Man’s Long Form Power of Attorney authorize GENERAL REAL PROPERTY POWERS?</td>
<td>Yes</td>
</tr>
<tr>
<td>Does Man’s Long Form Power of Attorney authorize SALE of SPECIFIC REAL PROPERTY?</td>
<td>Yes</td>
</tr>
<tr>
<td>Will Man’s Long Form Power of Attorney be RECORDED with County Clerk?</td>
<td>Yes</td>
</tr>
<tr>
<td>BEFORE WHOM will the Man’s Directive to Physician be SIGNED?</td>
<td>Two witnesses</td>
</tr>
<tr>
<td>SELECT the TREATMENT PROVISION if the client is suffering with a TERMINAL CONDITION from which he is EXPECTED TO DIE WITHIN SIX MONTHS, even with available life-sustaining treatment:</td>
<td>Life-sustaining treatments discontinued</td>
</tr>
<tr>
<td>Question</td>
<td>Answer</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SELECT the TREATMENT PROVISION if the client is suffering with an IRREVERSIBLE CONDITION so that he CANNOT CARE for himself OR MAKE DECISIONS for himself and is expected to die without life-sustaining treatment:</td>
<td>Life-sustaining treatments discontinued</td>
</tr>
<tr>
<td>Do you wish to provide additional requests regarding particular treatments?</td>
<td>No</td>
</tr>
<tr>
<td>Has the client executed a Medical Power of Attorney?</td>
<td>No</td>
</tr>
<tr>
<td>NUMBER of persons authorized to make treatment decisions with the physician:</td>
<td>1</td>
</tr>
<tr>
<td>Do you wish to include a notary block with the Man’s Directive to Physicians?</td>
<td>No</td>
</tr>
<tr>
<td>Do you wish to include a notary block with the Man’s HIPAA Release?</td>
<td>No</td>
</tr>
<tr>
<td>NAME of Wife:</td>
<td>Jane Doe</td>
</tr>
<tr>
<td>NAME of Man signing document(s):</td>
<td>James Doe</td>
</tr>
<tr>
<td>James Doe’s COUNTY of residence:</td>
<td>Guadalupe</td>
</tr>
<tr>
<td>James Doe’s STREET ADDRESS:</td>
<td>1518 Savannah Oaks</td>
</tr>
<tr>
<td>James Doe’s CITY of residence:</td>
<td>Schertz</td>
</tr>
<tr>
<td>James Doe’s STATE of residence:</td>
<td>Texas</td>
</tr>
<tr>
<td>NAME of person to receive 1st specific bequest in James Doe’s Will:</td>
<td>Ray Bob Doe</td>
</tr>
<tr>
<td>Describe the 1st specific bequest in James Doe’s Will:</td>
<td>my 1893 Winchester 30-30 carbine</td>
</tr>
<tr>
<td>NAME of person to receive 2nd specific bequest in James Doe’s Will:</td>
<td>Geraldine Doe</td>
</tr>
<tr>
<td>Describe the 2nd specific bequest in James Doe’s Will:</td>
<td>my stuffed polar bear</td>
</tr>
<tr>
<td>NAMES of CHILDREN in James Doe’s Will:</td>
<td>Billy Bob Doe and Clara Belle Doe</td>
</tr>
<tr>
<td>NAME of the First Executor/Executrix named in James Doe’s Will:</td>
<td>Jane Doe</td>
</tr>
<tr>
<td>NAMES of AGENTS given authority under HIPAA to have access to Medical Records:</td>
<td>Jane Doe</td>
</tr>
<tr>
<td>ENTER any funeral arrangements requested:</td>
<td>Service at Mission Park</td>
</tr>
<tr>
<td>NAME of the PERSON designated to make treatment decisions with the physician:</td>
<td>Jane Doe</td>
</tr>
<tr>
<td>NAME of Attorney-in-Fact in James Doe’s Long Form Power of Attorney:</td>
<td>Jane Doe</td>
</tr>
<tr>
<td>Jane Doe’s COUNTY of residence in James Doe’s Long Form Power of Attorney:</td>
<td>Bexar</td>
</tr>
<tr>
<td>LEGAL DESCRIPTION of Specific Real Property to be sold under James Doe’s Long Form Power of Attorney:</td>
<td>Lot 16, Block 6, Savannah Oaks Subdivision, Guadalupe County TX</td>
</tr>
<tr>
<td>NUMBER of days used to define survival.</td>
<td>90</td>
</tr>
<tr>
<td>CITY where documents are signed:</td>
<td>Schertz</td>
</tr>
<tr>
<td>STATE where document will be signed:</td>
<td>TX</td>
</tr>
<tr>
<td>YEAR of EXECUTION of documents:</td>
<td>2011</td>
</tr>
<tr>
<td>COUNTY where document will be signed:</td>
<td>GUADALUPE</td>
</tr>
<tr>
<td>STATE where document will be signed:</td>
<td>TX</td>
</tr>
</tbody>
</table>
Module 12 - Assignment

A. ASSIGNMENT DESCRIPTION

In the following assignment you will create a Form Set, give it a name and select several forms that would typically be assembled at one time. This will allow you to find and assemble multiple forms by simply selecting a Form Set instead of continually selecting individual forms.

B. DIRECTIONS

To create and assemble a form set, complete the following steps:

1. Click Customize > Form Sets.
2. On the Volume Selection window, click the Family Law, 3rd Edition volume and click OK.
3. On the Browse and Update Form Sets window, click the New Set button.
4. On the Form Set Name window, type Simple Divorce and click OK.
5. Click the Update Forms button to select the forms for the form set.
6. When the forms list appears, select the following forms:
   a. 23-1 Final Decree of Divorce
   b. 100-1 Information on Suit Affecting Family Relationship - BVS
   c. 3-1 Original Petition for Divorce
   d. 3-13 Waiver of Service
7. Click OK to save the set. Click the Close button to close the Browse and Update Form Sets window.

C. USING THE SIMPLE DIVORCE FORM SET

1. Click the Assemble icon.
2. Click the Select case button.
3. Click the client Doe, Jane.
4. Click the Divorce case, then the Update Case button and enter 2 for the Case ID.
5. Click the OK button to close that window. Double-click Divorce to select the case.
6. In the Starting Document Assembly window, click the Select forms button. Select the Family Law volume.
7. Click the Form sets tab. The form set Simple Divorce will appear in the window. Click the set name and click the Select button. Click the OK button to accept all selected forms.
8. Uncheck the **Review prior answers** box and click the **Start Assembling** button.

9. Answer the questions. When you have finished answering the questions, ProDoc will assemble all of the documents at one time.

10. Click the **Continue** button to accept the names of the documents in the **Completed Documents** dialog window.

11. ProDoc will pass the first document to the word processor for review and printing. The other assembled documents are available in the **Document Manager** and in the **File** menu of your word processor.
## DIVORCE CASE WORKSHEET

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>DESCRIBE your CLIENT (see question help):</td>
<td>Petitioner</td>
</tr>
<tr>
<td>SELECT the COURT in which this matter is pending:</td>
<td>District Court</td>
</tr>
<tr>
<td>NUMBER of Petitioners:</td>
<td>1</td>
</tr>
<tr>
<td>SELECT the IDENTIFICATION NUMBERS that have been issued to Jane Doe:</td>
<td>Driver’s license number</td>
</tr>
<tr>
<td>NUMBER of Respondents:</td>
<td>1</td>
</tr>
<tr>
<td>STATUS of DRIVER’S LICENSE NUMBER of Jane Doe:</td>
<td>Issued</td>
</tr>
<tr>
<td>STATUS of SOCIAL SECURITY NUMBER of Jane Doe:</td>
<td>Issued</td>
</tr>
<tr>
<td>NUMBER of Applicants:</td>
<td>1</td>
</tr>
<tr>
<td>NUMBER of CHILDREN affected by this suit:</td>
<td>2</td>
</tr>
<tr>
<td>SELECT a DOMICILE provision:</td>
<td>Petitioner in county</td>
</tr>
<tr>
<td>SELECT type of SERVICE for Original Petition:</td>
<td>Personal service</td>
</tr>
<tr>
<td>Is Respondent to be SERVED at Residence?</td>
<td>Yes</td>
</tr>
<tr>
<td>SELECT type of LONG ARM JURISDICTION over Respondent:</td>
<td>Both</td>
</tr>
<tr>
<td>SELECT the DIVORCE JURISDICTION PROVISIONS for Long-Arm Jurisdiction</td>
<td>Statutory Ground</td>
</tr>
<tr>
<td>over Respondent.</td>
<td></td>
</tr>
<tr>
<td>SELECT any basis for the PARENT/CHILD LONG-ARM JURISDICTION over</td>
<td>Children reside in Texas because of nonresident</td>
</tr>
<tr>
<td>Respondent:</td>
<td></td>
</tr>
<tr>
<td>CHOOSE a PROTECTIVE ORDER clause:</td>
<td>No Order or Application Pending</td>
</tr>
<tr>
<td>Is Petitioner requesting a PROTECTIVE ORDER now?</td>
<td>No</td>
</tr>
<tr>
<td>SELECT any GROUNDS for divorce:</td>
<td>Living Apart</td>
</tr>
<tr>
<td>SELECT any applicable PROVISIONS for CHILD(REN) of the marriage:</td>
<td>None</td>
</tr>
<tr>
<td>NUMBER of persons with COURT-ORDERED Relationships with the children:</td>
<td>0</td>
</tr>
<tr>
<td>SELECT the applicable Conservatorship clause:</td>
<td>Agreement</td>
</tr>
<tr>
<td>SELECT whether the children's residence should be RESTRICTED in the FI-</td>
<td>No</td>
</tr>
<tr>
<td>NAL Orders:</td>
<td></td>
</tr>
<tr>
<td>SELECT ANY additional CONSERVATORSHIP, POSSESSION, SUPPORT and HEARING</td>
<td>Parenting coordinator</td>
</tr>
<tr>
<td>SELECT the REASON for the APPOINTMENT of a PARENTING COORDINATOR or</td>
<td>Best interest of the children</td>
</tr>
<tr>
<td>FACILITATOR:</td>
<td></td>
</tr>
<tr>
<td>REASON for requesting SECURITY for child support:</td>
<td>Employer not subject to Jurisdiction</td>
</tr>
<tr>
<td>SELECT the PROPERTY AGREEMENT that the parties currently have:</td>
<td>Marital-Property agreement</td>
</tr>
<tr>
<td>Will a COPY of the Marital Agreement BE ATTACHED?</td>
<td>Yes</td>
</tr>
<tr>
<td>SELECT whether a COPY of the Separate-Property Agreement will BE AT-</td>
<td>No</td>
</tr>
<tr>
<td>TACHED:</td>
<td></td>
</tr>
<tr>
<td>SELECT Community Property Division PROVISIONS:</td>
<td>No Community Property</td>
</tr>
<tr>
<td>Is Petitioner’s Separate Property to be CONFIRMED?</td>
<td>No</td>
</tr>
<tr>
<td>SELECT the appropriate provision regarding SPOUSAL MAINTENANCE:</td>
<td>Request spousal maintenance</td>
</tr>
<tr>
<td>Do you want any of the following ORDERS?</td>
<td>None</td>
</tr>
<tr>
<td>SELECT type of TEMPORARY Conservator requested in the TEMPORARY OR-</td>
<td>No temporary conservator</td>
</tr>
<tr>
<td>DERS after hearing in the Original Petition:</td>
<td></td>
</tr>
<tr>
<td>SELECT ANY additional requests Jane Doe is making:</td>
<td>Name Change</td>
</tr>
<tr>
<td>Question</td>
<td>Answer</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>NUMBER of permanent injunctions requested:</td>
<td>1</td>
</tr>
<tr>
<td>Is a WAIVER of the 60 day WAITING PERIOD requested?</td>
<td>No</td>
</tr>
<tr>
<td>Describe Respondent:</td>
<td>Adult</td>
</tr>
<tr>
<td>Select any person for which the Application seeks protection:</td>
<td>Applicant’s children</td>
</tr>
<tr>
<td>SELECT whether Jane Doe objects to the assignment of an ASSOCIATE JUDGE:</td>
<td>No</td>
</tr>
<tr>
<td>NUMBER of Applicant’s children who need protection:</td>
<td>2</td>
</tr>
<tr>
<td>SELECT how the Respondent will be served with the Application for a Protective Order:</td>
<td>Personal service</td>
</tr>
<tr>
<td>Is Billy Bob Doe the former spouse of Jane Doe?</td>
<td>No</td>
</tr>
<tr>
<td>Is any child the subject of the protective order under the continuing jurisdiction of any court?</td>
<td>No</td>
</tr>
<tr>
<td>Is Billy Bob Doe under the continuing jurisdiction of any court?</td>
<td>No</td>
</tr>
<tr>
<td>Do you want to include any additional facts regarding the relationship of the parties?</td>
<td>No</td>
</tr>
<tr>
<td>SELECT grounds for the Application for a Protective Order:</td>
<td>Both grounds</td>
</tr>
<tr>
<td>SELECT ANY ACTS of CHILD ABUSE committed by Billy Bob Doe:</td>
<td>None</td>
</tr>
<tr>
<td>Is the previously rendered protective order ATTACHED?</td>
<td>No</td>
</tr>
<tr>
<td>NUMBER of violations of the former protective order:</td>
<td>0</td>
</tr>
<tr>
<td>SELECT ANY PROVISIONS you want to include in the PROTECTIVE ORDER after notice and hearing</td>
<td>Prohibit threatening/harassing communication</td>
</tr>
<tr>
<td>SELECT ANY EX PARTE provisions you want to request in the Application for Protective Order</td>
<td>Prohibit threatening/harassing communication</td>
</tr>
<tr>
<td>NUMBER of Other acts you want to include in the ex parte relief:</td>
<td>0</td>
</tr>
<tr>
<td>Select from where Billy Bob Doe is prohibited from removing the children:</td>
<td>From the possession of Applicant</td>
</tr>
<tr>
<td>Describe Jane Doe:</td>
<td>Female</td>
</tr>
<tr>
<td>DESCRIBE your client:</td>
<td>Applicant</td>
</tr>
<tr>
<td>DESCRIBE Jane Doe:</td>
<td>Adult</td>
</tr>
<tr>
<td>Is Jane Doe UNDER the CONTINUING JURISDICTION of any COURT?</td>
<td>No</td>
</tr>
<tr>
<td>Describe Jane Doe:</td>
<td>Female</td>
</tr>
<tr>
<td>Describe Billy Ray Doe:</td>
<td>Male</td>
</tr>
<tr>
<td>DESCRIBE the PARTY ordered to pay child support:</td>
<td>Respondent</td>
</tr>
<tr>
<td>SELECT ANY additional Causes of Action:</td>
<td>Breach of fiduciary duty</td>
</tr>
<tr>
<td>SELECT ANY methods by which Billy Bob Doe breached a fiduciary duty to Jane Doe:</td>
<td>Actual fraud (transaction-based)</td>
</tr>
<tr>
<td>Was the actual fraud against Jane Doe’s SEPARATE ESTATE?</td>
<td>No</td>
</tr>
<tr>
<td>Is Jane Doe seeking prejudgment interest on the value of the property converted?</td>
<td>No</td>
</tr>
<tr>
<td>Is Jane Doe seeking EXEMPLARY DAMAGES for the invasion of privacy?</td>
<td>No</td>
</tr>
<tr>
<td>Is Jane Doe seeking EXEMPLARY DAMAGES for interference with business relations?</td>
<td>No</td>
</tr>
<tr>
<td>Is Jane Doe seeking EXEMPLARY DAMAGES for the interference with an existing contract?</td>
<td>No</td>
</tr>
<tr>
<td>SELECT the additional cause of action regarding INTERFERENCE WITH CUSTODY:</td>
<td>Neither</td>
</tr>
<tr>
<td>NUMBER of PERSONS who aided or assisted in the interference with custody:</td>
<td>0</td>
</tr>
<tr>
<td>Question</td>
<td>Answer</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Is the Interference With Custody cause of action brought under Chapter 42 of the Texas Family Code?</td>
<td>No</td>
</tr>
<tr>
<td>Is Jane Doe seeking EXEMPLARY DAMAGES for the interference with custody?</td>
<td>No</td>
</tr>
<tr>
<td>Is a PARENTAGE cause of action REQUESTED?</td>
<td>No</td>
</tr>
<tr>
<td>Do you want a temporary restraining order against the third-person trustee who holds title to property?</td>
<td>No</td>
</tr>
<tr>
<td>NUMBER of THIRD-PARTIES involved in the conspiracy:</td>
<td>0</td>
</tr>
<tr>
<td>Is Jane Doe seeking EXEMPLARY DAMAGES for the civil conspiracy?</td>
<td>No</td>
</tr>
<tr>
<td>Is Jane Doe seeking EXEMPLARY DAMAGES for the resulting personal</td>
<td>No</td>
</tr>
<tr>
<td>SELECT the appropriate DISCOVERY CONTROL PLAN level:</td>
<td>Level 2</td>
</tr>
<tr>
<td>Should discovery be conducted under level 2?</td>
<td>Yes</td>
</tr>
<tr>
<td>TYPE of ORDER:</td>
<td>Divorce/Annulment with Children</td>
</tr>
<tr>
<td>SELECT any FINDINGS of the Court:</td>
<td>Domestic Violence</td>
</tr>
<tr>
<td>DESCRIBE the PETITIONER:</td>
<td>Wife</td>
</tr>
<tr>
<td>DESCRIBE the OBLIGEE:</td>
<td>Husband</td>
</tr>
<tr>
<td>Describe the OBLIGOR:</td>
<td>Husband</td>
</tr>
<tr>
<td>DESCRIBE status of PRIOR protective order:</td>
<td>Current order of protection under criminal code</td>
</tr>
<tr>
<td>Include Parties’ ADDRESSES for Service of Process?</td>
<td>Yes</td>
</tr>
<tr>
<td>SELECT ANY applicable Reimbursement PROVISIONS:</td>
<td>To community from Respondent</td>
</tr>
<tr>
<td>INCLUDE Respondent’s ADDRESS for service of process?</td>
<td>Yes</td>
</tr>
<tr>
<td>DESCRIBE the parties’ DATING RELATIONSHIP, if any:</td>
<td>No dating relationship</td>
</tr>
<tr>
<td>SELECT ANY types of prohibited COMMUNICATIONS which are issues to be heard at the HEARING for Protective Orders:</td>
<td>Communicating directly in a threatening manner</td>
</tr>
<tr>
<td>SELECT ANY types of prohibited COMMUNICATIONS which are to be included in the temporary EX PARTE order:</td>
<td>Communicating directly in a threatening manner</td>
</tr>
<tr>
<td>SELECT DATE for PAYMENT of attorney’s FEES, CHARGES, or EXPENSES incurred in connection with the order:</td>
<td>Sixtieth day after date of order</td>
</tr>
<tr>
<td>Will the HEARING determine whether sealed IDENTIFYING INFORMATION should be DISCLOSED to Respondent?</td>
<td>No</td>
</tr>
<tr>
<td>INCLUDE UCCJEA AFFIDAVIT containing information required under TFC 152.209?</td>
<td>No</td>
</tr>
<tr>
<td>SELECT child information disclosure provision:</td>
<td>No Child Custody or Parties Reside in Texas</td>
</tr>
<tr>
<td>SELECT whether the Child Support Order requires the children to be ENROLLED in ANY available health COVERAGES OR in SPECIFIC COVERAGES:</td>
<td>All available coverages</td>
</tr>
<tr>
<td>Does the Child Support Order require the children to be ENROLLED in ANY available health COVERAGES OR in SPECIFIC COVERAGES:</td>
<td>Yes</td>
</tr>
<tr>
<td>Is the child’s ADDRESS the SAME as the Custodial PARENT’S?</td>
<td>Yes</td>
</tr>
<tr>
<td>SELECT whether the children's residence should be RESTRICTED in the TEMPORARY ORDERS after hearing:</td>
<td>No</td>
</tr>
<tr>
<td>COURT in which case is pending:</td>
<td>121st Judicial District Court</td>
</tr>
<tr>
<td>LAST three DIGITS of the DRIVER’S LICENSE NUMBER of Jane Doe:</td>
<td>857</td>
</tr>
<tr>
<td>Petitioner’s FULL NAME:</td>
<td>Jane Doe</td>
</tr>
<tr>
<td>Jane Doe’s STREET NAME and NUMBER:</td>
<td>1518 Savannah Oaks</td>
</tr>
<tr>
<td>Jane Doe’s CITY of residence:</td>
<td>Schertz</td>
</tr>
<tr>
<td><strong>Jane Doe’s STATE of residence:</strong></td>
<td>Texas</td>
</tr>
<tr>
<td><strong>Jane Doe’s ZIP code:</strong></td>
<td>78154</td>
</tr>
<tr>
<td><strong>Jane Doe’s ADDRESS (line style):</strong></td>
<td>1518 Savannah Oaks, Schertz, TX 78154</td>
</tr>
<tr>
<td><strong>Jane Doe’s DATE of BIRTH:</strong></td>
<td>07/21/1982</td>
</tr>
<tr>
<td><strong>Jane Doe’s PLACE of BIRTH:</strong></td>
<td>Abilene, TX</td>
</tr>
<tr>
<td><strong>Jane Doe’s SOCIAL SECURITY NUMBER:</strong></td>
<td>555-55-5555</td>
</tr>
<tr>
<td><strong>Jane Doe’s RACE:</strong></td>
<td>Caucasian</td>
</tr>
<tr>
<td><strong>Respondent’s FULL NAME:</strong></td>
<td>Billy Ray Doe</td>
</tr>
<tr>
<td><strong>Billy Bob Doe’s STATE of residence:</strong></td>
<td>Texas</td>
</tr>
<tr>
<td><strong>Billy Bob Doe’s ZIP CODE:</strong></td>
<td>78244</td>
</tr>
<tr>
<td><strong>NAME of Billy Bob Doe’s EMPLOYER:</strong></td>
<td>Hemispheric Systems</td>
</tr>
<tr>
<td><strong>Hemispheric Systems’ FULL ADDRESS (line style):</strong></td>
<td>6781 Jones Maltsberger Rd, San Antonio, TX 78244</td>
</tr>
<tr>
<td><strong>Billy Bob Doe’s DATE of BIRTH:</strong></td>
<td>10/21/1978</td>
</tr>
<tr>
<td><strong>Billy Bob Doe’s PLACE of BIRTH:</strong></td>
<td>Abilene, TX</td>
</tr>
<tr>
<td><strong>Billy Bob Doe’s SOCIAL SECURITY NUMBER:</strong></td>
<td>888-88-8888</td>
</tr>
<tr>
<td><strong>Billy Bob Doe’s RACE:</strong></td>
<td>Caucasian</td>
</tr>
<tr>
<td><strong>Applicant’s FULL NAME:</strong></td>
<td>Jane Doe</td>
</tr>
<tr>
<td><strong>NAME of First CHILD:</strong></td>
<td>Billy Ray Doe</td>
</tr>
<tr>
<td><strong>NAME of Second CHILD:</strong></td>
<td>Leslie Anne Doe</td>
</tr>
<tr>
<td><strong>SEX of Billy Ray Doe:</strong></td>
<td>Male</td>
</tr>
<tr>
<td><strong>SEX of Leslie Anne Doe:</strong></td>
<td>Female</td>
</tr>
<tr>
<td><strong>BIRTHDATE of Billy Ray Doe:</strong></td>
<td>01/21/1998</td>
</tr>
<tr>
<td><strong>BIRTHDATE of Leslie Anne Doe:</strong></td>
<td>06/15/2001</td>
</tr>
<tr>
<td><strong>Jane Doe’s COUNTY of residence:</strong></td>
<td>Guadalupe</td>
</tr>
<tr>
<td><strong>Street name and number of Billy Ray Doe mailing address:</strong></td>
<td>1518 Savannah Oaks</td>
</tr>
<tr>
<td><strong>Street name and number of Leslie Anne Doe’s mailing address:</strong></td>
<td>1518 Savannah Oaks</td>
</tr>
<tr>
<td><strong>CITY of Billy Ray Doe mailing address:</strong></td>
<td>Schertz</td>
</tr>
<tr>
<td><strong>CITY of Leslie Anne Doe’s mailing address:</strong></td>
<td>Schertz</td>
</tr>
<tr>
<td><strong>STATE of Billy Ray Doe’s mailing address:</strong></td>
<td>Texas</td>
</tr>
<tr>
<td><strong>STATE of Leslie Anne Doe’s mailing address:</strong></td>
<td>Texas</td>
</tr>
<tr>
<td><strong>ZIP CODE of Billy Ray Doe’s mailing address:</strong></td>
<td>78154</td>
</tr>
<tr>
<td><strong>ZIP CODE of Leslie Anne Doe’s mailing address:</strong></td>
<td>78154</td>
</tr>
<tr>
<td><strong>CITY OF BIRTHPLACE of Billy Ray Doe:</strong></td>
<td>Abilene</td>
</tr>
<tr>
<td><strong>CITY OF BIRTHPLACE of Leslie Anne Doe:</strong></td>
<td>Abilene</td>
</tr>
<tr>
<td><strong>COUNTY OF BIRTHPLACE of Billy Ray Doe:</strong></td>
<td>Taylor</td>
</tr>
<tr>
<td><strong>COUNTY OF BIRTHPLACE of Leslie Anne Doe:</strong></td>
<td>Taylor</td>
</tr>
<tr>
<td><strong>STATE OF BIRTHPLACE of Billy Ray Doe:</strong></td>
<td>Texas</td>
</tr>
<tr>
<td><strong>STATE OF BIRTHPLACE of Leslie Anne Doe:</strong></td>
<td>Texas</td>
</tr>
<tr>
<td><strong>Billy Ray Doe’s SOCIAL SECURITY NUMBER:</strong></td>
<td>444-44-4444</td>
</tr>
<tr>
<td><strong>Leslie Anne Doe’s SOCIAL SECURITY NUMBER:</strong></td>
<td>333-33-3333</td>
</tr>
<tr>
<td><strong>Date when the parties were married (on or about):</strong></td>
<td>December 10, 1995</td>
</tr>
<tr>
<td><strong>Date when the parties ceased to live together as husband and wife (on or about):</strong></td>
<td>November 18, 2010</td>
</tr>
<tr>
<td><strong>PERMANENT INJUNCTION requested:</strong></td>
<td>Prohibit Respondent from removing any personal property items being stored at ABC Storage, 200 Main St., San Antonio, Texas.</td>
</tr>
<tr>
<td><strong>Name change requested for decree:</strong></td>
<td>Jane Bowen</td>
</tr>
<tr>
<td><strong>GOOD CAUSE REASONS for the APPOINTMENT of a PARENTING COORDINATOR or FACILITATOR:</strong></td>
<td>the children display no behavior control</td>
</tr>
<tr>
<td><strong>CAUSE NUMBER in which the Order for Child Support was rendered:</strong></td>
<td>11-CIV-12345</td>
</tr>
<tr>
<td><strong>NAME of the First child who needs protection:</strong></td>
<td>Billy Ray Doe</td>
</tr>
<tr>
<td><strong>NAME of the Second child who needs protection:</strong></td>
<td>Leslie Anne Doe</td>
</tr>
<tr>
<td><strong>FULL ADDRESS where Billy Ray Doe will be served:</strong></td>
<td>6783 Wurzbach Parkway San Antonio, TX 78244</td>
</tr>
<tr>
<td><strong>RELATIONSHIP of Applicant to Respondent:</strong></td>
<td>respondents wife</td>
</tr>
<tr>
<td><strong>DESCRIBE Respondent’s Threats of harm:</strong></td>
<td>On January 1, 2000, the Respondent called the Applicant and threatened to physically harm her children.</td>
</tr>
<tr>
<td><strong>ADDRESS of courthouse at which hearing for Protective Order will be held:</strong></td>
<td>100 Dolorosa, Room L250, San Antonio</td>
</tr>
<tr>
<td><strong>COUNTY where the action is pending:</strong></td>
<td>Bexar</td>
</tr>
<tr>
<td><strong>ACTIONS of Billy Ray Doe which constitute a BREACH OF FIDUCIARY DUTY:</strong></td>
<td>selling 40% of a proprietorship, which was community property, to his father for only 10% of its value</td>
</tr>
<tr>
<td><strong>ACTIONS of Billy Ray Doe which constitute ACTUAL FRAUD (transaction-based):</strong></td>
<td>selling 40% of a proprietorship, which was community property, to his father for only 10% of its value</td>
</tr>
<tr>
<td><strong>WIFE’S MAIDEN NAME:</strong></td>
<td>Bowen</td>
</tr>
<tr>
<td><strong>NUMBER of MINOR CHILDREN:</strong></td>
<td>2</td>
</tr>
<tr>
<td><strong>DATE of MARRIAGE:</strong></td>
<td>12/10/1995</td>
</tr>
<tr>
<td><strong>CITY of MARRIAGE:</strong></td>
<td>Abilene</td>
</tr>
<tr>
<td><strong>STATE of MARRIAGE:</strong></td>
<td>TX</td>
</tr>
<tr>
<td><strong>DATE of ORDER:</strong></td>
<td>11/15/2011</td>
</tr>
<tr>
<td><strong>Obligee’s DRIVER LICENSE NO &amp; STATE:</strong></td>
<td>TX 019875643</td>
</tr>
<tr>
<td><strong>Obligee’s TELEPHONE NUMBER:</strong></td>
<td>555-5555</td>
</tr>
<tr>
<td><strong>Obligee’s AREA CODE:</strong></td>
<td>210</td>
</tr>
<tr>
<td><strong>OBLIGOR’S EMPLOYER:</strong></td>
<td>Hemispheric Systems</td>
</tr>
<tr>
<td><strong>Hemispheric Systems’ PAYROLL ADDRESS (line style):</strong></td>
<td>6781 Jones Maltsberger Rd, San Antonio, TX 78244</td>
</tr>
<tr>
<td><strong>LAST three DIGITS of the DRIVER’S LICENSE NUMBER of Jane Doe:</strong></td>
<td>867</td>
</tr>
<tr>
<td><strong>LAST three DIGITS of the SOCIAL SECURITY NUMBER of Jane Doe:</strong></td>
<td>532</td>
</tr>
<tr>
<td><strong>Billy Bob Doe’s Employer’s Federal EIN Number:</strong></td>
<td>222-22-2222</td>
</tr>
<tr>
<td><strong>Obligor’s Name (Last, First, MI):</strong></td>
<td>Doe, Billy B.</td>
</tr>
<tr>
<td><strong>Obligee’s Name (Last, First, MI):</strong></td>
<td>Doe, Jane</td>
</tr>
<tr>
<td><strong>Exhibit Letter/Number of Health Insurance Statement:</strong></td>
<td>A</td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
<td>---</td>
</tr>
<tr>
<td><strong>Exhibit Letter/Number of Marital Property Agreement:</strong></td>
<td>B</td>
</tr>
<tr>
<td><strong>NAME of Opposing Party’s Separate-Property Business:</strong></td>
<td>Hemispheric Systems</td>
</tr>
<tr>
<td><strong>COUNTY of RESIDENCE of the PARTIES for whom protection is sought:</strong></td>
<td>Guadalupe</td>
</tr>
<tr>
<td><strong>PHONE NUMBER of a Representative of the children:</strong></td>
<td>555-555-5555</td>
</tr>
<tr>
<td><strong>CASE NUMBER for the Notice to Withhold for Health Care coverage:</strong></td>
<td>02-50456</td>
</tr>
<tr>
<td><strong>COURT or ADMINISTRATIVE AUTHORITY which has jurisdiction:</strong></td>
<td>121st Judicial District</td>
</tr>
<tr>
<td><strong>ORDER IDENTIFIER for the Notice to Withhold for Health Care Coverage:</strong></td>
<td>02-50456</td>
</tr>
<tr>
<td><strong>MAXIMUM PERCENTAGE that can be withheld from employee’s earnings for both cash and medical EXPENSES:</strong></td>
<td>50</td>
</tr>
<tr>
<td><strong>DOCUMENT TRACKING IDENTIFIER for the Notice to Withhold for Health Care Coverage:</strong></td>
<td>025045678</td>
</tr>
<tr>
<td><strong>AMOUNT allowed for health insurance premiums by the child support order:</strong></td>
<td>$85</td>
</tr>
<tr>
<td><strong>METHOD by which EMPLOYER shall determine withholdings when funds are insufficient to meet the requirements of this notice and a separate notice:</strong></td>
<td>60% to cash contributions and 40% to medical support contributions</td>
</tr>
<tr>
<td><strong>NAME of the Substituted Official/Agency:</strong></td>
<td>Attorney General’s Office</td>
</tr>
<tr>
<td><strong>NAME and ADDRESS of the Substituted Official/Agency:</strong></td>
<td>Attorney General’s Office 43 Congress Ave, Austin, TX 78456</td>
</tr>
<tr>
<td><strong>DATE of the Order for Child Support:</strong></td>
<td>November 15, 2011</td>
</tr>
</tbody>
</table>
ORIGINAL PETITION FOR DIVORCE

NO. [*______*]

IN THE MATTER OF § IN THE DISTRICT COURT
THE MARRIAGE OF §
§
JANE JOE § 121ST JUDICIAL DISTRICT
AND §
BILLY BOB DOE §
§
AND IN THE INTEREST OF §
BILLY RAY DOE AND LESLIE ANNE § BEXAR COUNTY, TEXAS
DOE, CHILDREN §

ORIGINAL PETITION FOR DIVORCE

1. Discovery Level

Discovery in this case is intended to be conducted under level 2 of rule 190 of the Texas Rules of Civil Procedure.

2. Parties

This suit is brought by Jane Joe, Petitioner. The last three numbers of Jane Joe’s driver’s license number are 857. The last three numbers of Jane Joe’s Social Security number are 555.

Billy Bob Doe is Respondent.

3. Domicile

Petitioner has been a domiciliary of Texas for the preceding six-month period and a resident of this county for the preceding ninety-day period.

4. Service

Process should be served on Respondent at 2711 Wurzbach Parkway, Apt 34C, San Antonio, Texas.

5. Long-Arm Jurisdiction

Respondent is a nonresident of Texas. Petitioner is a resident or a domiciliary of Texas at the commencement of this suit. Texas is the last state in which marital residence between Petitioner and Respondent occurred, and this suit is filed before the second anniversary of the date on which marital residence ended.

The children the subject of this suit reside in Texas as a result of the acts or directives of the nonresident person.

6. Protective Order Statement
No protective order under title 4 of the Texas Family Code is in effect, and no application for a protective order is pending with regard to the parties to this suit.

7. Dates of Marriage and Separation

The parties were married on or about December 10, 1995 and ceased to live together as husband and wife on or about November 18, 2010.

8. Grounds for Divorce

Petitioner and Respondent have lived apart without cohabitation for at least three years.

9. Children of the Marriage

Petitioner and Respondent are parents of the following children of this marriage who are not under the continuing jurisdiction of any other court:

Name:  Billy Ray Doe
Sex:  Male
Birth date:  January 21, 1998

Name:  Leslie Anne Doe
Sex:  Female
Birth date:  June 15, 2001

There are no court-ordered conservatorships, court-ordered guardianships, or other court-ordered relationships affecting the children the subject of this suit.

Information required by section 154.181(b) of the Texas Family Code is provided in the statement attached as Exhibit A.

No property of consequence is owned or possessed by the children the subject of this suit.

Petitioner believes that Petitioner and Respondent will enter into a written agreement containing provisions for conservatorship of, possession of, access to, and support of the children. If such an agreement is not made, Petitioner requests the Court to make orders for conservatorship of, possession of, access to, and support of the children.

Petitioner requests the Court to appoint a parenting coordinator. There is good cause for appointment of a parenting coordinator in that the children display no behavior control, and the appointment would be in the best interest of the children.

10. Marital-Property Agreement

Petitioner and Respondent have entered into a marital-property agreement defining their rights to all their property, both community and separate. A copy of the agreement is attached to this pleading as Exhibit B. Petitioner requests the Court to enforce the agreement and divide the marital estate in accordance with its terms.

11. Division of Community Property

There is no community property for division.

12. Reimbursement
Petitioner requests the Court to reimburse the community estate for funds or assets expended by the community estate for the benefit of Respondent’s separate estate. Those expenditures resulted in a direct benefit to Respondent’s separate estate. The community estate has not been adequately compensated for or benefited from the expenditure of those funds or assets, and a failure by the Court to allow reimbursement to the community estate will result in an unjust enrichment of Respondent’s separate estate at the expense of the community estate.

13. Postdivorce Maintenance

Petitioner requests the Court to order that Petitioner be paid postdivorce maintenance for a reasonable period in accordance with chapter 8 of the Texas Family Code.

14. Request for Permanent Injunction

Petitioner requests the Court, after trial on the merits, to grant the following permanent injunction:

   a. Prohibit Respondent from removing any personal property items being stored at ABC Storage, 200 Main Blvd., San Antonio, Texas.”

15. Breach of Fiduciary Duty

Respondent, as Petitioner’s spouse, had a fiduciary relationship with and a fiduciary duty to Petitioner. As a result of their fiduciary relationship, Petitioner reposed a special confidence in Respondent, and Respondent had a duty in equity and good conscience to act in good faith and with due regard for Petitioner’s interests.

   Respondent, in violation of his duty to Petitioner, has breached his duty to Petitioner by selling 40% of a proprietorship, which was community property, to his father for only 10% of its value.

   a. Actual Fraud

   Respondent plotted and carried out a plan to actually defraud Petitioner and Petitioner’s separate estate. Respondent made material representations to Petitioner that were false. Respondent knew these representations were false, or Respondent made them recklessly without knowledge of their truth and as a positive assertion. Respondent made these representations with the intention that Petitioner would act on them. Petitioner acted in reliance on these representations and as a consequence suffered injury and damage as follows: selling 40% of a proprietorship, which was community property, to his father for only 10% of its value.

16. Request for Change of Name

Petitioner requests a change of name to Jane Boswell.

17. Prayer

Petitioner prays that citation and notice issue as required by law and that the Court grant a divorce and all other relief requested in this petition.

   Petitioner prays that, on final hearing, the Court enter a permanent injunction enjoining Respondent, in conformity with the allegations of this petition, from the acts set forth above.

   Petitioner prays for judgment against Billy Bob Doe in a sum within jurisdictional limits of this Court for her actual damages as alleged, for prejudgment and postjudgment interest as allowed by law, for costs of court, and for general relief.

   Petitioner prays that Petitioner’s name be changed as requested above.

   Petitioner prays for general relief.
Respectfully submitted,

Cass T. Lee Law Firm
123 Main Street
Attorneyville, TX 71111
Tel: (210) 5551212
Fax: (210) 5551212

By: _________________________________

Cass T Lee
State Bar No. 99999999999
Attorney for Petitioner
APPLICATION FOR A PROTECTIVE ORDER

IN THE INTEREST OF § IN THE DISTRICT COURT

BILLY RAY DOE AND LESLIE ANNE § 121ST JUDICIAL DISTRICT
DOE §

CHILDREN § BEXAR COUNTY, TEXAS

AN APPLICATION FOR A PROTECTIVE ORDER

1. Discovery Level

Discovery in this case is intended to be conducted under level 2 of rule 190 of the Texas Rules of Civil Procedure.

2. Parties

This Application for a Protective Order is brought by Jane Joe, Applicant, who is a resident of Guadalupe County, Texas. The last three numbers of Applicant’s driver’s license number are 867. The last three numbers of Applicant’s Social Security number are 532. This Application for a Protective Order is brought for the protection of Billy Ray Doe and Leslie Anne Doe, who are residents of Bexar County, Texas. Respondent is Billy Bob Doe, who resides in Bexar County, Texas.

3. Service

Process should be served on Respondent at 6783 Wurzbach Parkway San Antonio, TX 78244.

4. Relationship of Parties

Applicant is respondents wife.

Applicant is a former spouse of Respondent, and a copy of the decree dissolving the marriage is attached to this application as Exhibit A.

The children, Billy Ray Doe and Leslie Anne Doe, for whom a protective order is sought are not subject to the continuing jurisdiction of any court.

5. Grounds

Respondent has engaged in conduct that constitutes family violence.

Respondent committed acts that were intended by Respondent to result in physical harm, bodily injury, assault, or sexual assault or were threats that reasonably placed Billy Ray Doe and Leslie Anne Doe in fear of imminent physical harm, bodily injury, assault, or sexual assault. Respondent’s acts therefore constitute family violence.
Good cause exists for prohibiting Respondent from communicating with Billy Ray Doe and Leslie Anne Doe except through Respondent’s attorney or a person appointed by the Court, as requested below.

6. **Application Filed after Order of Protection Issued under Code of Criminal Procedure**

   This application is filed after an order of protection under the Code of Criminal Procedure was issued.

   The protective order is unavailable to Applicant. A copy of the order will be filed with the Court before the hearing on the application.

   Respondent has threatened to harm Applicant in the following manner: On January 1, 2000, the Respondent called the Applicant and threatened to physically harm her children.

7. **Request for Protective Order**

   Applicant requests the Court, after notice and hearing, to issue its protective order:

   Prohibiting Respondent from communicating directly with Billy Ray Doe and Leslie Anne Doe in a threatening or harassing manner.

   Applicant requests the Court to dispense with the necessity of a bond.

8. **Best Interest**

   The protective order requested is in the best interest of the family, household, or member of the family or household.

9. **Attorney’s Fees and Costs**

   The Court should assess against Billy Bob Doe a reasonable attorney’s fee as compensation for Cass T Lee, and judgment should be rendered in favor of this attorney against Billy Bob Doe.

   Applicant requests that Respondent be ordered to pay reasonable attorney’s fees, the $16 protective order fee, the cost of service of the protective order, the costs of court, and all other fees, charges, or expenses incurred in connection with the protective order before the sixtieth day after the date the order is rendered.

10. **Prayer**

    Applicant prays that notice of this Application for a Protective Order issue as required by law and that the Court enter the protective order as requested in this application.

    Applicant prays that a hearing be held no later than the fourteenth day after the date this application is filed; that, after notice and hearing, the Court grant the relief requested above; and that the Court dispense with the necessity of a bond.

    Applicant prays for attorney’s fees, costs, charges, and expenses.

    Applicant prays for general relief.

    Respectfully submitted,

    Cass T. Lee Law Firm

    123 Main Street
Attorneyville, TX 71111
Tel: (210) 5551212
Fax: (210) 5551212

By:____________________________________

Cass T Lee
State Bar No. 999999999999
Attorney for Applicant
NOTICE OF HEARING

IT IS FURTHER ORDERED that the clerk shall issue notice to Respondent, Billy Bob Doe, to appear, and Respondent is ORDERED to appear in person, before this Court in the courthouse at 100 Dolorosa, Room L250, San Antonio, Texas, on __________________ at _______ m. The purpose of this hearing is to determine whether the Court should issue a protective order in accordance with this application.

This hearing is also to determine whether the Court should assess reasonable attorney’s fees against Billy Bob Doe to be awarded to Cass T Lee.

SIGNED on _________________________________.

_________________________________________

JUDGE PRESIDING
CIVIL CASE INFORMATION SHEET

1. Contact Information for person completing case information sheet:
   - Name: Cass T Lee
   - Email: www.myfirm.com
   - Address: 123 Main Street 210-555-1212
   - City/State/Zip: San Antonio TX 75111 210-555-1212
   - Signature:

2. Indicate case type, or identify the most important issue in the case:

   Civil
   - Debt Contract
   - Injury or Damage
   - Real Property
   - Marriage Relationship
   - Other Contract:
   - Foreclosure
   - Other

   Family Law
   - Contract
   - Injury or Damage
   - Real Property
   - Marriage Relationship
   - Post-Judgment Actions

   Other
   - Employment
   - Other Civil
   - Tax

3. Indicate procedure or remedy, if applicable (may select more than 1):
   - Appeal from Municipal or Justice Court
   - Arbitration-related
   - Attachment
   - Bill of Review
   - Certiorari
   - Class Action
   - Declaratory Judgment
   - Dismissal
   - Exemption
   - Foreclosure
   - Garnishment
   - Interpleader
   - License
   - Mandamus
   - Post-judgment
   - Probate/Wills
   - Interstate Adoptions
   - Probate & Mental Health
   - Probation
   - Protective Order
   - Receiver
   - Receivership
   - Temporary Restraining Order
   - Turnover

Additional Parties in Child Support Case:
- Custodial Parent:
- Non-Custodial Parent:
- Presumed Father:
INFORMATION ON SUIT AFFECTING THE FAMILY RELATIONSHIP

<table>
<thead>
<tr>
<th>SECTION 1 GENERAL INFORMATION (REQUIRED)</th>
<th>STATE FILE NUMBER</th>
</tr>
</thead>
<tbody>
<tr>
<td>COUNTY: Bexar</td>
<td>COURT NO: 121st Judicial District Court</td>
</tr>
<tr>
<td>CAUSE NO:</td>
<td>DATE OF ORDER (mm/dd/yyyy) 11/15/2011</td>
</tr>
<tr>
<td>TYPE OF ORDER:</td>
<td>CHECK ALL THAT APPLY:</td>
</tr>
<tr>
<td>DIVORCE/ANNULMENT WITH CHILDREN (Sec 1.2,3,4)</td>
<td>DIVORCE/ANNULMENT WITHOUT CHILDREN (Sec 1.2)</td>
</tr>
<tr>
<td>PATERNITY WITH CHILD SUPPORT (Sec 1.3,4,5)</td>
<td>PATERNITY WITHOUT CHILD SUPPORT (Sec 1.3,4,5)</td>
</tr>
<tr>
<td>CHILD SUPPORT OBLIGATION/MODIFICATION (Sec 1.3,4)</td>
<td>TERMINATION OF RIGHTS (Sec 1.3,6)</td>
</tr>
<tr>
<td>CONSERVATORSHIP (Sec 1.3)</td>
<td>OTHER (Specify)</td>
</tr>
<tr>
<td>TRANSFER TO:</td>
<td>STATE COURT ID:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SECTION 2 IF APPLICABLE REPORT OF DIVORCE OR ANNULMENT OF MARRIAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>HUSBAND:</td>
</tr>
<tr>
<td>FIRST NAME: Billy Bob D.</td>
</tr>
<tr>
<td>PLACE OF BIRTH: Abilene, TX</td>
</tr>
<tr>
<td>USUAL RESIDENCE: 2711 Wurzbach Parkway, Apt 34C</td>
</tr>
<tr>
<td>DATE OF BIRTH: 10/21/1978</td>
</tr>
<tr>
<td>WIFE:</td>
</tr>
<tr>
<td>FIRST NAME: Jane Joe</td>
</tr>
<tr>
<td>PLACE OF BIRTH: Abilene, TX</td>
</tr>
<tr>
<td>USUAL RESIDENCE: 1518 Savannah Oaks</td>
</tr>
<tr>
<td>DATE OF BIRTH: 07/21/1982</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SECTION 3 IF APPLICABLE CHILDREN AFFECTED BY THIS SUIT</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHILD 1:</td>
</tr>
<tr>
<td>FIRST NAME: Billy Ray D.</td>
</tr>
<tr>
<td>SOCIAL SECURITY NUMBER: 444-44-4444</td>
</tr>
<tr>
<td>PLACE OF BIRTH: Abilene, TX</td>
</tr>
<tr>
<td>DATE OF BIRTH: 01/21/1998</td>
</tr>
<tr>
<td>CHILD 2:</td>
</tr>
<tr>
<td>FIRST NAME: Leslie Anne D.</td>
</tr>
<tr>
<td>SOCIAL SECURITY NUMBER: 333-33-3333</td>
</tr>
<tr>
<td>PLACE OF BIRTH: Abilene, TX</td>
</tr>
<tr>
<td>DATE OF BIRTH: 06/15/2001</td>
</tr>
</tbody>
</table>

WARNING: This is a governmental document. Texas Penal Code, Section 37.10, specifies penalties for making false entries or providing false information in this document.
### SECTION 4 (IF APPLICABLE) OBLIGEE/OBLIGOR INFORMATION

<table>
<thead>
<tr>
<th>Field</th>
<th>Information</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>25. OBLIGEE</td>
<td>First Name</td>
<td><strong>NAME</strong></td>
</tr>
<tr>
<td>26. Middle Name</td>
<td>LAST NAME</td>
<td><strong>LAST NAME</strong></td>
</tr>
<tr>
<td>27. Date of Birth (mm/dd/yyyy)</td>
<td>CITY</td>
<td><strong>CITY</strong></td>
</tr>
<tr>
<td>28. Place of Birth</td>
<td>STATE</td>
<td><strong>STATE</strong></td>
</tr>
<tr>
<td>29. Usual Residence</td>
<td>CITY</td>
<td><strong>CITY</strong></td>
</tr>
<tr>
<td>30. Social Security Number</td>
<td>COUNTY</td>
<td><strong>COUNTY</strong></td>
</tr>
<tr>
<td>31. Driver's License No. &amp; State</td>
<td>STATE</td>
<td><strong>STATE</strong></td>
</tr>
<tr>
<td>32. Telephone Number</td>
<td>ZIP</td>
<td><strong>ZIP</strong></td>
</tr>
</tbody>
</table>

### SECTION 5 (IF APPLICABLE) FOR ORDERS CONCERNING PATERNITY ESTABLISHMENT OF BIOLOGICAL FATHER

<table>
<thead>
<tr>
<th>Field</th>
<th>Information</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>55. Biological Father's Name</td>
<td>First Name</td>
<td><strong>NAME</strong></td>
</tr>
<tr>
<td>56. Date of Birth (mm/dd/yyyy)</td>
<td>CITY</td>
<td><strong>CITY</strong></td>
</tr>
<tr>
<td>57. Social Security Number</td>
<td>STREET NAME &amp; NUMBER</td>
<td><strong>STREET NAME</strong></td>
</tr>
<tr>
<td>58. Current Mailing Address</td>
<td>CITY</td>
<td><strong>CITY</strong></td>
</tr>
</tbody>
</table>

### SECTION 6 TERMINATION OF RIGHTS — INFORMATION RELATED TO THE INDIVIDUAL (S) WHOSE RIGHTS ARE BEING TERMINATED IN THIS SUIT

<table>
<thead>
<tr>
<th>Field</th>
<th>Information</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>60a. First Name</td>
<td>MIDDLE NAME</td>
<td><strong>NAME</strong></td>
</tr>
<tr>
<td>60b. Relationship</td>
<td>LAST NAME</td>
<td><strong>LAST NAME</strong></td>
</tr>
</tbody>
</table>

**COMMENTS:**

---

I CERTIFY THAT THE ABOVE ORDER WAS GRANTED ON THE DATE AND PLACE AS STATED.

SIGNATURE OF THE CLERK OF THE COURT.
NATIONAL MEDICAL SUPPORT NOTICE

This Notice is issued under section 466(a)(19) of the Social Security Act, section 609(a)(5)(C) of the Employee Retirement Income Security Act of 1974 (ERISA), and for State and local government and church plans, sections 401(e) and (f) of the Child Support Performance and Incentive Act of 1998. Receipt of this Notice from the Issuing Agency constitutes receipt of a Medical Child Support Order under applicable law. The information on the Custodial Parent and Child(ren) contained on this page is confidential and should not be shared or disclosed with the employee. NOTE: For purposes of this form, the Custodial Parent may also be the employee when the State opts to enforce against the Custodial Parent.

Issuing Agency: ____________________________
Issuing Agency Address: ________________________
Notice Date: ________________________________
CSE Agency Case Identifier: ______________________
Telephone Number: ____________________________
FAX Number: _________________________________

Court or Administrative Authority: 121st Judicial District
Order Date: November 15, 2011
Order Identifier: 02-58456
Document Tracking Identifier: 025045678
Employer web site: See NMSN Instructions: www.acf.hhs.gov/programs/csa/forms/

RE: Doc. Billy R
Employee’s Name (Last, First, Ml) 888-88-8888
Employee’s Social Security Number 2711 Warbach Parkway, Apt 34C, San Antonio, TX 78244
Employee’s Mailing Address

Attorney’s General’s Office
Substituted Official/Agency Name
43 Congress Ave, Austin, TX 78456

Substituted Official/Agency Address
(Requested if Custodial Parent’s mailing address is left blank)

Child(ren)’s Mailing Address (if different from Custodial Parent’s)
555-555-5555
Name and Telephone of a Representative of the Child(ren)
Mailing Address of a Representative of the Child(ren)

Child(ren)’s Name(s) Gender DOB SSN
Billy Ray Doe Male 01/21/1998 444-44-4444
Leslie Anne Doe Female 06/15/2001 333-33-3333

Child(ren)’s Name(s) Gender DOB SSN

The order requires the child(ren) to be enrolled in ☐ all health coverages available; or only the following coverage(s): ☐ Medical; ☐ Dental; ☐ Vision; ☐ Prescription drug; ☐ Mental health; ☐ Other specify: __________________________

THE PAPERWORK REDUCTION ACT OF 1995 (P.L. 104-13) Public reporting burden for this collection of information is estimated to average 10 minutes per response, including the time reviewing instructions, gathering and maintaining the data needed, and reviewing the collection of information. An agency may not conduct or sponsor, and a person is not required to respond to, a collection of information unless it displays a currently valid OMB control number. OMB control number: 0970-0222 Expiration Date: 03/31/2014.
LIMITATIONS ON WITHHOLDING

The total amount withheld for both cash and medical support cannot exceed ________ % of the employee’s aggregate disposable weekly earnings. The employer may not withhold more under this National Medical Support Notice than the lesser of:

1. The amounts allowed by the Federal Consumer Credit Protection Act (15 U.S.C., section 1673(b));

2. The amounts allowed by the State of the employee’s principal place of employment; or

3. The amounts allowed for health insurance premiums by the child support order, as indicated here: $___

The Federal limit applies to the aggregate disposable weekly earnings (ADWE). ADWE is the net income left after making mandatory deductions such as State, Federal, local taxes; Social Security taxes; and Medicare taxes. As required under section 2.b.2 of the Employer Responsibilities on page 4, complete item 5 of the Employer Response to notify the Issuing Agency that enrollment cannot be completed because of prioritization or limitations on withholding.

PRIORITY OF WITHHOLDING

If withholding is required for employee contributions to one or more plans under this notice and for a support obligation under a separate notice and available funds are insufficient for withholding for both cash and medical support contributions, the employer must withhold amounts for purposes of cash support and medical support contributions in accordance with the law, if any, of the State of the employee’s principal place of employment requiring prioritization between cash and medical support, as described here: 60% to cash contributions and 40% to medical support contributions. As required under section 2.b.2 of the Employer Responsibilities on page 4, complete item 5 of the Employer Response to notify the Issuing Agency that enrollment cannot be completed because of prioritization or limitations on withholdings.
Module 12 - Quick Check

1. True or False: Form sets can have a maximum number of 5 documents as part of the set.

2. True or False: Once a form set has been created, it cannot be deleted.

3. True or False: A form can be temporarily removed from the form set before the document assembly process.
Module 13 - Editing Master Forms

A. MODULE DESCRIPTION

Editing a master form allows the user to modify the form itself, the captions, and signature blocks that ProDoc uses to create a document. While ProDoc includes a vast library of legal documents, some attorneys prefer to modify the language in a document to fit their particular needs. Users can always edit the finished documents in the word processor, but ProDoc gives users the ability to edit the master forms so that the documents produced will always contain the desired language or format.

B. OBJECTIVES

Upon successful completion of this module, you will be able to:

1. Demonstrate how to edit the body text of a master form.
2. Describe the procedure used to save a modified master form.
3. Restore the original master form for use.

C. PROCEDURE

1. Modifying the master form body text

Complete the following steps:

a. From the Customize menu, select Edit Forms.

b. Select the Attorney-Client Matters volume.

c. This will display the Select a Form to Open window. Select form 2-10 Client Information Form and click OK.

d. ProDoc will ask if you would like to make a backup copy of the master form. Click Yes.

e. ProDoc will now open the master form in the word processor for editing.

1. Word users: click the cursor before the ~FFONTV token on the top line of the page.

2. WordPerfect users: press Alt+F3 to reveal codes, then press the left arrow key once.

f. Press the Enter key twice to make room for the line you will add.

g. Press the up arrow key twice to position the cursor at the beginning of the line.

h. Type The Law Office of Larry L. Laffer (or your name).

i. Highlight the line and apply the center alignment format.

2. Saving the master form

ALWAYS change the file extension as detailed below. ProDoc updates forms often to ensure subscribers have the latest approved form language. The update program will locate any affected forms that you have changed by finding file extensions. You will be given options to save, use or overwrite modified forms. If you don’t change the file extension, modified forms
that need updates will be automatically overwritten.

a. Click **File > Save As**.

b. Verify that the document is being saved into the correct volume folder, in this case, **TXATTY**.

c. Enter **DOC0210.DOC** as the file name. **WordPerfect** users should use `.wpd` instead of `.doc`, and put a quotation mark ("”) at the beginning and the end of the file name. In the **Save as type** field:

1. **WordPerfect** users should select **WordPerfect 5.1/5.2**,
2. Microsoft **Word Pre-2007** users should select **WordPerfect 5.X for Windows**.

d. Click **Save**.

e. If a dialog box displays a warning that you may lose features if you save in that format, click **OK**. Close the document.

3. **Assembling a document using the new master form**

a. Click the **Assemble** icon.

b. Select a client and a case.

c. Click the **Select Forms** button.

d. Select the **Attorney-Client Matters** volume.

e. Select form **2-10**. Assemble the form by clicking the **Start Assembling** button.

f. Click **Continue** to close the **Completed Documents** window.

g. **ProDoc** will pass the document to the word processor and open it.

h. Notice that the modified master form is now displayed with the change. Before and after copies of the assembled **Client Information Form** are included in this module for comparison

4. **Modifying a master form to add a confidentiality statement**

a. Click **Customize > Edit Forms**. Select the **Foreclosures, 2nd Edition** volume and form **1-5 Foreclosure Questionnaire**. Save a backup copy of the form.

b. Scroll to the end of the document, to the very bottom, press **Enter** twice, and type the following paragraph. Convert it to single space if necessary:

> “The information contained in this document is intended by the attorney for the use of the named individual or entity to which it is directed and may contain information that is confidential or privileged.”

C. Click **File > Save As**. Ensure the target folder for the file is **TXFOR**. Enter **FOR01005.DOC** as the file name. **WordPerfect** users should use `.wpd` instead of `.doc`, and put a quotation mark ("”) at the beginning and the end of the file name. In the **Save as type** field:

1. **WordPerfect** users should select **WordPerfect 5.1/5.2**,
2. Microsoft **Word Pre-2007** users should select **WordPerfect 5.X for Windows**.

d. Close the document in the word processor.

5. **Assembling a document showing the changes**

a. Switch to ProDoc and click the Assemble icon. Create a Landlord case for John H. Doe, Jr. and select it.


c. Select form 1-5 Foreclosure Questionnaire.

d. Click OK to continue with the process.

e. Ensure the Review prior answers box is checked. Click the Start Assembling button.

   Click Next to accept any suggested assembly answers.

f. Answer merge questions. Use the following data:

   1. The property subject to foreclosures is **single family home rental**.
   2. The date the questionnaire must be returned is today’s date.
   3. **Tab** through the remaining merge questions.

g. Click Continue at the Completed Documents dialog box.

h. Scroll to the bottom of the last page to view the modified document with the new confidentiality statement. A copy of the assembled document is included in this module.

6. **Restoring the original form from the backup**

a. Use Windows Explorer to browse to the TXFOR folder.

b. Perform the following steps:

   1. Right click the file FOR01005 and rename it to FOR01005.OLD.
   2. Delete the file FOR01005.DOC (or FOR01005.WPD).
   3. Right click the file FOR01005.BAK and rename it to FOR01005.

c. Repeat b.1. through b.3. in the TXATTY folder with the file names beginning with DOC0210. ProDoc will now use the original forms.

D. **ADDITIONAL RESOURCES**

Additional ProDoc resources available to assist you in understanding more about the Editing Master Forms feature include:

- **Modify Master Templates TechTip** ([tinyurl.com/pd-modify-templates]): This TechTip provides step-by-step instructions with screens shots in use this feature.
E. REVIEW

1. Why should you change the file extension when saving a modified master form?

2. Explain the reason why you should make a backup copy of a master form before editing.

3. True or False: To make a modification to a form, you must modify the token codes.
Module 13 - Assignment

A. ASSIGNMENT DESCRIPTION

In this assignment, you will edit the master form of the Employment Contract.

B. DIRECTIONS

1. Changing font formatting in a paragraph
   a. Open the master form 1-1 Employment Contract in the Criminal Defense volume. Be sure to make a backup copy.
   b. Move your cursor to the paragraph that starts with ~FRMARV ~D0001V Client agrees to pay. Highlight the paragraph with your mouse through ...bill is received.~E003V.
   c. Click the B for bold formatting in the toolbar. Once saved properly, future copies of this document will have this text bolded.
   d. The next sentence starts with ~FLMARV ~FRMARV ~NA001V. Apply the underline format to the words It is expressly agreed and understood that the above fee does not include:
   e. Highlight the paragraph that starts with ~NA001V Client agrees to attend any and all court dates. Apply the italic font format to this paragraph.

2. Changing the position of a paragraph
   Highlight the paragraph that starts with ~NA001V. It is expressly agreed and understood. Click and drag it to the beginning of the previous paragraph. Make sure you have the paragraph returns inserted to make it a paragraph by itself.

3. Saving the modified form
   a. Click File > Save As. Ensure the target folder for the file is TXCRIM. Enter DOC0210.DOC as the file name. WordPerfect users should use .wpd instead of .doc, and put a quotation mark (") at the beginning and the end of the file name. In the Save as type field:
      1. WordPerfect users should select WordPerfect 5.1/5.2,

4. Viewing the results
   a. Now that the form has been modified, assemble the document using the John H. Doe, Jr. Criminal Defense case. Answer the assembly and merge questions however you wish to answer them.
   b. Print and submit a finished copy of the document to your instructor. Notice where you made the changes in the master form. These changes are now reflected in the final draft of the form.
   c. A copy of the assembled document (with suggested answers accepted during assembly) is included in this module which displays the editing changes.
5. Restoring the original form from the backup

Follow the procedures in the first section of this module to restore the original form from the backup. The folder is TXCRIM and the filenames begin with QOC0027.
CLIENT INFORMATION FORM BEFORE EDITING

CLIENT INFORMATION FORM

INSTRUCTIONS: Answer all questions truthfully and completely. The information you enter in this questionnaire is confidential and protected by Attorney-Client Privilege. The information will not be disclosed to anyone outside of this office, except in the course of rendering legal services on your behalf, or unless otherwise required by law.

Date: ___________________________________

CLIENT INFORMATION

Your Name: ____________________________________________________________________________________________
Home Address: __________________________________________________________________________________________
City: ___________________________ State: ___________ Zip Code: ___________
County of Residence: ___________________________ You have lived at current address since: ___________
Home Phone: ___________________________ Home Facsimile No: __________________________
Cell Phone No: ___________________________ Pager/Beeper No: __________________________
E-mail Address: __________________________________________________________________________________________
Soc. Sec. No: ___________________________ Driver’s License No: __________________________
Date of Birth: ___________________________ State/Country of Birth: __________________________
Other names you have been known by: __________________________________________________________________________

EMPLOYER: __________________________________________________________________________________________
Work Address: __________________________________________________________________________________________
City: ___________________________ State: ___________ Zip Code: ___________
Work Phone: ___________________________ Work Facsimile No: __________________________
Work E-mail Address: __________________________________________________________________________________________
How long have you worked at this employer? ___________________________________________________________________
Position: ___________________________________________________________________________ Salary/Earnings: $ ___________
Name of Emergency Contact, and Relation to You: ___________________________________________________________________
Home Address: __________________________________________________________________________________________
City: ___________________________ State: ___________ Zip Code: ___________
Home Phone: ___________________________ Work Phone: __________________________
Nature of case / reason for seeking consultation with our office: __________________________________________________________________________________________
_____________________________________________ ___________________________________________________________________________
_____________________________________________ ___________________________________________________________________________
How did you hear about our office? _____________________________________________________________________________
_____________________________________________ ___________________________________________________________________________
_____________________________________________ ___________________________________________________________________________

OTHER PARTY INFORMATION

Name: __________________________________________________________________________________________
Home Address: __________________________________________________________________________________________
City: __________________________________ State: __________________ Zip Code: ________________
County of Residence: __________________________ Other party has lived at this address since: ____________
Home Phone: ___________________________ Home Facsimile No: ___________________________
Cell Phone No: ___________________________ Pager/Beeper No: ___________________________
E-mail Address: __________________________________________
Soc. Sec. No: ___________________________________ Driver’s License No: ___________________________
Date of Birth: ___________________________ State/Country of Birth: ___________________________
Other names you have been known by: ____________________________________________
EMPLOYER: ________________________________ ____________________________________________________________________
Work Address: ________________________________ ________________________________ ________________________________
City: __________________________________ State: __________________ Zip Code: ________________
Work Phone: __________________________________ Work Facsimile No: ___________________________
Work E-mail Address: _____________________________
How long have you worked at this employer? ________________________________
Position: ________________________________ Salary/Earnings: $ ___________________________
Is other party represented by an ATTORNEY in this matter? ______ Yes ______ No

If YES, please answer the questions below:
Name of Attorney/Firm: __________________________
City where office located: ____________________________ Phone: __________________________
Indicate if this or any other attorney has:

Represented other party in other matters (besides this case)? ______ Yes ______ No
Provided advice or other services to you regarding this case? ______ Yes ______ No
Provided advice or other services to you regarding other matters? ______ Yes ______ No
Talked with you in person or by telephone regarding this case? ______ Yes ______ No
Sent a letter or other written communications to you related to this case? ______ Yes ______ No
Served papers (by a sheriff or process server) upon you in this case? ______ Yes ______ No
CLIENT INFORMATION FORM AFTER EDITING

The Law Office of Larry L. Laffer

CLIENT INFORMATION FORM

INSTRUCTIONS: Answer all questions truthfully and completely. The information you enter in this questionnaire is confidential and protected by Attorney-Client Privilege. The information will not be disclosed to anyone outside of this office, except in the course of rendering legal services on your behalf, or unless otherwise required by law.

Date: ___________________________________

CLIENT INFORMATION

Your Name: ___________________________________ _________________________________________________________________

Home Address:  ___________________________________ ______________________________________________________________

City:  ____________________________________________________  State:  _____________________ Zip Code:  ________________

County of Residence:  ___________________________________  You have lived at current address since: _______________

Home Phone:  __________________________________________ Home Facsimile No: ___________________________________

Cell Phone No:  ________________________________________  Pager/Beeper No:  ___________________________________

E-mail Address:  _________________________________________________________________________________________________

Soc. Sec. No: _____________________________________________ Driver’s License No:  _________________________________

Date of Birth:  ___________________________________________  State/Country of Birth: _______________________________

Other names you have been known by: __________________________________________________________________________

EMPLOYER: __________________________________________________________________________________________________

Work Address:  _________________________________________________________________________________________________

City:  ____________________________________________________  State:  _____________________ Zip Code:  ________________

Work Phone:  ____________________________________________  Work Facsimile No:  _________________________________

Work E-mail Address:  _____________________________________________ _____________________________________________

How long have you worked at this employer? ____________________________________________________________________

Position:  __________________________________________________________ Salary/Earnings:  $ _________________________

Name of Emergency Contact, and Relation to You: _______________________________________________________________

Home Address: _________________________________________ ________________________________________________________

City:  ____________________________________________________  State:  _____________________ Zip Code:  ________________

Home Phone:   ___________________________________________  Work Phone:   ________________________________________

Nature of case / reason for seeking consultation with our office: _________________________________________________

_________________________________________________________________________________________________________

_________________________________________________________________________________________________________

How did you hear about our office? _____________________________________________________________________________

_________________________________________________________________________________________________________

OTHER PARTY INFORMATION
Name: _____________________________________________ _____________________________________________________________

Home Address:  _____________________________________________ ____________________________________________________

City:  ____________________________________________________  State:  _____________________ Zip Code:  ________________

County of Residence:  ___________________________ Other party has lived at this address since:  ____________________

Home Phone:  __________________________________________ Home Facsimile No: ___________________________________

Cell Phone No:  ________________________________________  Pager/Beeper No:  _________________________________

E-mail Address:  _________________________________________________________________________________________________

Soc. Sec. No: _____________________________________________ Driver’s License No:  _________________________________

Date of Birth:  ___________________________________________  State/Country of Birth: _______________________________

Other names you have been known by: __________________________________________________________________________

EMPLOYER: ________________________________ ____________________________________________________________________

Work Address:  ______________________________________________________  ________________________________

City:  ____________________________________________________  State:  _____________________ Zip Code:  ________________

Work Phone:  ____________________________________________  Work Facsimile No:   _________________________________

Work E-mail Address:  _____________________________________________ _____________________________________________

How long have you worked at this employer? ____________________________________________________________________

Position: __________________________________________________________ Salary/Earnings:  $

Is other party represented by an ATTORNEY in this matter? ________ Yes ________ No

If YES, please answer the questions below:

Name of Attorney/Firm:  _________________________________________________________________________________________

City where office located: __________________________________________________________ Phone:  _____________________

Indicate if this or any other attorney has:

Represented other party in other matters (besides this case)?   ________ Yes   ________ No

Provided advice or other services to you regarding this case?  ________ Yes   ________ No

Provided advice or other services to you regarding other matters?  ________ Yes   ________ No

Talked with you in person or by telephone regarding this case?   ________ Yes   ________ No

Sent a letter or other written communications to you related to this case?   ________ Yes   ________ No

Served papers (by a sheriff or process server) upon you in this case?   ________ Yes   ________ No
FORECLOSURE QUESTIONNAIRE

Pursuant to your request that our firm represent you in foreclosing on the single family home rental property, please complete this questionnaire and return it by July 13, 2011.

A. Loan Documents. Enclose copies of all loan documentation, correspondence, file memoranda, reports, reports to other officers or committees of John H. Doe, Jr., UCC searches, workout negotiations, appraisals, and valuations contained in your records. Indicate enclosures by checking in the space provided; if an item does not exist, leave the space blank.

( ) Previous demands for payment
( ) Notice of acceleration
( ) Note
( ) Recorded deed of trust
( ) Security agreements
( ) Financing statements
( ) Continuing guaranty agreement
( ) Renewal and extension of note and lien agreements
( ) Partial releases and UCC-3 forms
( ) Assignment of leases and rents
( ) Mortgagee title policy and all endorsements
( ) Tax statements
( ) Hazard insurance policy
( ) Other documents, such as assumption agreements, title transfer documents, loan modifications, transfers of liens (list): ________________________________

If any of the above spaces are not checked but a document of such nature exists, please provide any information you have: ________________________________

If the present note is a renewal or aggregation of previous debts or notes, please describe prior debts or notes by note number, date, original principal amount, amount carried forward to the present note, and other information: ________________________________

B. Notice Information. Please list all names and addresses shown on loan documents in
your files or of which you are aware and indicate (by checking) the most recent address. Also, please indicate the type of address (for example, business or residence) and if a party has died or been involved in a divorce.

**Note Makers:**

Names and Addresses

1. ________________________________  ( ) Bus.  ( ) Death  
   ________________________________  ( ) Res.  ( ) Divorce
   ________________________________

2. ________________________________  ( ) Bus.  ( ) Death  
   ________________________________  ( ) Res.  ( ) Divorce
   ________________________________

3. ________________________________  ( ) Bus.  ( ) Death  
   ________________________________  ( ) Res.  ( ) Divorce
   ________________________________

4. ________________________________  ( ) Bus.  ( ) Death  
   ________________________________  ( ) Res.  ( ) Divorce
   ________________________________

**Guarantors (if any):**

Names and Addresses

1. ________________________________  ( ) Bus.  ( ) Death  
   ________________________________  ( ) Res.  ( ) Divorce
   ________________________________

Grantor of Deed of Trust and Security Agreement (if different from above):

Names and Addresses

1. ________________________________  ( ) Bus.  ( ) Death  
   ________________________________  ( ) Res.  ( ) Divorce
   ________________________________
Persons Assuming Debts:

Names and Addresses

1. ____________________________  ( ) Bus.  ( ) Death  
   ____________________________  ( ) Res.  ( ) Divorce

2. ____________________________  ( ) Bus.  ( ) Death  
   ____________________________  ( ) Res.  ( ) Divorce

Are any of the above persons in the armed services?  Y/N

Current Owner or Occupant of Property:

Names and Addresses

1. ____________________________  ( ) Bus.  ( ) Death  
   ____________________________  ( ) Res.  ( ) Divorce

2. ____________________________  ( ) Bus.  ( ) Death  
   ____________________________  ( ) Res.  ( ) Divorce

Other Lienholders:

Names and Addresses
Other Persons to Whom Notice Should Be Given:

Names and Addresses

1. ________________________________________ ( ) Bus. ( ) Death 
   ________________________________________ ( ) Res. ( ) Divorce
   ________________________________________

2. ________________________________________ ( ) Bus. ( ) Death 
   ________________________________________ ( ) Res. ( ) Divorce
   ________________________________________

Debtors under Security Agreements (if different from above):

Names and Addresses

1. ________________________________________ ( ) Bus. ( ) Death 
   ________________________________________ ( ) Res. ( ) Divorce
   ________________________________________

2. ________________________________________ ( ) Bus. ( ) Death 
   ________________________________________ ( ) Res. ( ) Divorce
   ________________________________________

C. Debt and Default Description. Describe all defaults that have occurred in the payment or performance of the loan documents described in item A. above.

Known Defaults: __________________________________________________________
Debt (use additional sheet of paper if necessary):

Note number: _____________________________________________________________

Date of note: _____________________________________________________________

Installment payment: $ ________________________________

Installments Delinquent (use additional sheet of paper if necessary):

<table>
<thead>
<tr>
<th>Month/Year</th>
<th>Principal</th>
<th>Interest</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$</td>
<td>$</td>
</tr>
<tr>
<td></td>
<td>$</td>
<td>$</td>
</tr>
<tr>
<td></td>
<td>$</td>
<td>$</td>
</tr>
</tbody>
</table>

Total Delinquent:

As of ______ / ______ / ______ $ ______________________ $ _____________________

Principal: $ ______________________ Interest: $ _____________ Daily accrual: $ _____________

Escrow balance: $ ______________________

Last date of payment: ______________________

Other information:________________________________________________________________________
_______________________________________________________________________________________

D. Mortgaged Property and Collateral

1. Has the mortgaged property ever been the debtor’s or other party’s (residential or business) homestead? Y/N

2. Have any of the parties (any maker, guarantor, or past or present owner) ever resided at the mortgaged property? Y/N

3. List the street address of the mortgaged property.

4. Please describe any personal property collateral.

5. Please describe any portion of the mortgaged property or collateral that has been released.

6. Has the mortgaged property been replatted since the closing of the loan? Y/N
7. Has the lender consented to any easements, restrictive covenants, leases, or other agreements affecting the mortgaged property or collateral?  Y/N

8. Are you aware of any current or previous use of the property that would indicate the need for an environmental audit?  Y/N  Describe any such use.

9. If you are aware of any of the following matters affecting the mortgaged property or collateral, please indicate by checking in the space provided. Enclose copies of all agreements and lease-related documents in your possession, including the lease, rent roll, and nondisturbance agreement. List all known addresses of tenant on a separate sheet.

   ( ) Broker agreements
   ( ) Leasing agent agreements
   ( ) Management agreements
   ( ) Service agreements
   ( ) Utility service agreements
   ( ) Pending or considered sales agreements
   ( ) Leases
   ( ) Security deposits
   ( ) Other agreements or permits

10. **Description of Liens.** Please indicate if you are aware of any of the following and enclose a copy of the document or describe the lien:

    **Deed-of-Trust Liens:**
    Date: _______________________________
    Recording
    County: _______________________________
    Type of records: ____________________________
    Volume and page: ____________________________
Grantor: _________________________________
Trustee: _________________________________

Beneficiary (name/address): _________________________________
_________________________________ _____________________________
_________________________________ _____________________________
_________________________________ _____________________________

Debt secured: _________________________________

Posted for foreclosure: _________________________________
Other comments: _________________________________

( ) Subordination agreements (either subordination of lender’s lien or subordination of other creditor’s lien)
( ) Notice agreements (agreements to give notice of any default or foreclosure or to afford cure privileges)
( ) Notice of claims (UCC; mechanic’s, materialmen’s, or supplier’s; unpaid creditors)
( ) Federal tax liens (description):
( ) Franchise tax liens (description):
( ) Inferior liens (description):
( ) Superior liens (description):

11. Insurance. Review the hazard (fire, flood, comprehensive loss, etc.) policies and indicate which of the following apply:
   ( ) Notice of the foreclosure sale to be sent to the insurer
   ( ) Notice of change of ownership to be sent to the insurer
   ( ) Notice of vacancy to be sent to the insurer
   ( ) Premiums have been paid to continue coverage through ____________

12. Foreclosure Procedure
   a. If loan documents cover both real and personal property, would separate foreclosure sales possibly bring a higher bid price? Y/N
   b. If the loan documents cover more than one tract of real property, would separate sales of the tracts possibly bring a higher bid price? Y/N
   c. If the loan documents cover more than one tract of real property, would sale of less than all of the tracts possibly be sufficient to recoup the borrower’s debt? Y/N
   d. Will the lender be able to gain peaceable repossession of the personal property so that the foreclosure sale may be held after the lender gains possession of the collateral? Y/N
   e. Describe location of all personal property collateral. _________________________________

   ________________________________________________________________________________
   ________________________________________________________________________________
f. If you are aware of any potential buyers or bidders for the mortgaged property or collateral, please list.  
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________


g. What means do you suggest to identify and notify potential buyers of any of the personal property collateral?  
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________


h. Has a substitute trustee ever been appointed for the trustee in the deed of trust?  Y/N

Form completed by: ___________________________________________

Date: ___________________________________________
Title: ___________________________________________
Address: ___________________________________________ ___________________________________________

Phone number: ___________________________________________

Please return to:
The Law Firm of Dewey, England and Smith
222 S. Court St.
Dallas, Texas 77772
(972) 888-8888
(210) 659-7777

“The information contained in this document is intended by the attorney for the use of the named individual or entity to which it is directed and may contain information that is confidential or privileged.”
CONTRACT OF EMPLOYMENT

This agreement is between John H. Doe, Jr. (“Client”) and Ima Student (“Attorney”), Attorney at Law.

1. Client hereby employs Ima Student for representation in the matter of State of Texas v. John H. Doe, Jr., wherein Client is charged with the offense of _____.

2. In consideration of the representation provided by Attorney in this case, Client agrees to pay a fee as set out below:

   Client agrees to pay a fee of $_____, payable now.

3. It is expressly agreed and understood that the above fee does not include:
   a. Any appeal which may be taken to a Court of Appeals or to the Court of Criminal Appeals, nor does it include a petition for discretionary review to the Court of Criminal Appeals or any other form of appellate review, whether in state or federal court;
   b. Any expenses necessary to prepare and investigate the case and does not include any of the expenses of preparing the record for appeal;
   c. A retrial of the case if, for any reason, the case must be retried.

4. It is expressly agreed and understood that the above fee does include:
   a. A preliminary investigation into the facts and circumstances of the case, legal research, and advice to Client regarding the case;
   b. A plea of guilty or no contest to the charges or to some lesser included offense that disposes of the charges;
   c. Preparing for and defending Client in a trial before a jury on the charges.

5. Attorney may employ experts and investigators to assist in the defense of the case. All such experts and investigators shall report directly and exclusively to Attorney.

6. It is agreed and understood that various expenses may be incurred in the defense of the case. These may include, but are not limited to, photocopying charges, long distance telephone charges, travel expenses, fees paid to investigators and experts, witness fees, costs of preparing a reporter’s record, and other court costs. These costs and expenses will always remain the ultimate responsibility of Client. Attorney may pay any of these costs, but all costs advanced by Attorney will be promptly repaid to Attorney by Client and are payable when billed to Client, in addition to the fee set out in this agreement.

7. Attorney may, at Attorney’s discretion, employ associate counsel at no additional charge to Client.

8. Client agrees to promptly inform Attorney of all changes in Client’s address or telephone number, as soon as such changes occur.
9. Client further agrees to keep all appointments with Attorney and, if an unexpected event occurs that prevents Client from keeping any appointment, agrees to immediately notify Attorney when an appointment cannot be kept.

10. **Client agrees to attend any and all court dates, court hearings, and other official appearances in connection with the charges in this matter. Client further agrees to immediately inform Attorney of anything that will prevent Client from attending scheduled court dates or appearances.**

11. It is agreed that, in the event payment is not made as specified in this agreement, Attorney may withdraw from representation of Client and will owe no further duty as attorney for Client. It is further agreed that in the event Client fails to appear for one or more appointments with Attorney or fails to appear on time or fails to appear at all for one or more court appearances or hearings, Attorney may withdraw from representation of Client and will owe no further duty as attorney for Client. Notice of intent to withdraw and a copy of any motion to withdraw filed with any court shall be given by certified mail, return receipt requested, 14 days in advance to Client at Client’s address set out below.

12. It is expressly agreed and understood that **NO PROMISES OR GUARANTEES** as to the outcome of the case have been made to Client by Attorney. It is further expressly agreed and understood that no other representations have been made to Client, except for those set out in this Employment Contract.

13. Attorney agrees to use Attorney’s best professional judgment in advising Client in regard to this matter. Attorney further agrees to represent Client to the best of Attorney’s ability, within the limits of the law and professional ethics.

14. Client acknowledges receiving a copy of this Employment Contract on the date shown below.

**SIGNED ___________________________**

John H. Doe, Jr.
123 Main Street
Anytown, TX, 71111

Client

The Law Firm of Dewey, England and Smith
2222 S. Court St.
Dallas, Texas 77772
Tel: (972) 888-8888
Fax: (972) 888-7777

By: ___________________________
Ima Student
State Bar No. 12345
Attorney for John H. Doe, Jr.
Module 13 - Quick Check

1. True or False: It is a good practice to make a backup copy of your master form before editing it.

2. True or False: ProDoc® forms are in WordPerfect format.

3. True or False: You can modify the codes that are found in a document without worrying about the consequences to the finished document.
Module 14 - eFiling from ProDoc

A. MODULE DESCRIPTION

eFiling usage is growing as a way to file legal documents in state courts of Texas. ProDoc is one of several eFile service providers authorized to provide eFiling service through the eFiling for Courts system (the state eFiling system). This module describes how to use your ProDoc menu and case files to help you more easily eFile.

Limitations of this module. Instructors should inform students that, in order to complete eFiling, users must first create an account with the Texas state eFiling system (eFiling for Courts). Those students who wish to submit a practice eFiling may do so and instructions are included below for them to do so. The ProDoc website has a complete tutorial on eFiling which you can show the class.

B. OBJECTIVES

After successful completion of this module, you will be able to:

1. Demonstrate how to eFile from the ProDoc program.

2. Demonstrate general knowledge of eFiling options.

1. Discussion

a. Signatures

Documents created by your firm do not need to be signed to be eFiled. eFiling for Courts uses your eFile account to establish that the firm documents you file are valid without a signature. Signatures are normally only required for documents that are signed by a third party. If you don’t have an electronic version of this type of document, the scanning process helps you convert a paper document to a format for eFiling.

b. Advantages of eFiling from ProDoc

Users can eFile online with or without using ProDoc software. Using ProDoc to eFile provides the following advantages:

• ProDoc’s client and case files can be the source of the document and the source of other information required for the filing.

• Your eFiling is automatically started and your document(s) are automatically attached.

• Participants in the case will be available for eService if the case answers contain the needed information.

• An easy-to-use scanner interface is provided for adding third party documents to your eFilings as attachments.

Step-by-step help is available throughout the process.
C. PROCEDURE

1. eFiling Menu Choices

There are two choices on the ProDoc eFile menu: eFiling Manager and eFile Documents.

a. The eFiling Manager choice opens the ProDoc eFile website and prompts the user to log in. This choice does not allow you to use the ProDoc program and case files to begin eFiling.

   a. The eFile Documents choice allows you to use case files.

b. **Filing online with the eFile Documents menu choice**

   Complete the following steps:
   
   1. On the ProDoc main menu, click eFile > eFile Documents.
   2. The Preparing for eFiling window appears.

2. **Click the Select Client/Case button**

   Documents may be eFiled without first specifying a contact or case, but we don’t recommend doing that. If you don’t select a client/case, you’ll have to work through extra steps and additional data entry, and it will be difficult to later determine how to bill the filing charges.

   1. The Select a Case window appears.
   2. Highlight the Robert G. Hutton, Divorce case.
   3. Click Select Case.

a. **Choosing the Lead Document**

   You will now choose your Lead Document. Documents do not need to be converted to pdf format for filing. The following formats are acceptable to the system: pdf, doc, wpd, rtf, bmp, jpg, and tif. You can use the buttons on the window to:

   1. Browse for a document on your computer or network,
   2. Scan documents to be filed, or
   3. Open your case folder for the selected case and choose Case Documents to file (if you’ve selected a case to use).

   **Browsing** and **Case Documents** methods will be covered. Since most classrooms do not have individual scanners attached to computers, scanning options will not be covered. Scanning is only necessary when filing documents containing 3rd party signatures such as verified pleadings and affidavits.

   4. Click the Case Documents button to choose a Lead Document. The Select a document screen appears. Note that you can only search in ProDoc’s case documents with this option.

   5. Highlight the title Petition for Divorce and click Select.

   6. You will be returned to the Preparing for eFiling window. The document’s path will appear in the Document Being Filed field.
b. Attachments to the document being filed

Filings may require attachments to your lead document. Note that the procedures for the Lead Document and for Attachments are exactly the same. Since you used the Case Documents button for your Lead Document, you will use the Browse button to choose your attachment.

1. Click Browse to locate the Document Being Filed on your computer or network.

2. The Select the Document Being Filed window appears.

3. Browse to C:\Clients\Hutton, Robert G and click the file name Waiver of Service. Click Open. The document appears in the Document Being Filed field. Note that it would have been more efficient to use the Case Documents button to do this.

4. Click OK - go to eFiling website. At this time you will be taken to the ProDoc eFiling website to log in and finish eFiling. When you log in, your documents are already attached and relevant information is already entered, depending upon the information present in your case file answers.

Note: You cannot eFile into the live system (www.prodocfile.com) so you will not be able to complete the eFiling from ProDoc. In the Module 14 Assignment you will find instructions on how to access the training site where you can register and submit eFilings without incurring any fees for doing so.

c. Demonstration

At this point, the website asks for log in information. As the instructor you can log in to the ProDoc website and can show a tutorial on eFiling from start to finish.

You can show the class the eFiling computer-based tutorial if you desire. Since different schools will have different bandwidth limitations, it would be best to simply display the tutorial on a common screen. Go to www.prodocfile.com, click Resources > Training > 24/7 Training Online > ProDoc eFiling training videos. The tutorials cover eFiling from start to finish.

D. ADDITIONAL RESOURCES

Additional ProDoc resources available to assist you in understanding more about the ProDoc eFiling application include:

• eFile From ProDoc TechTip (tinyurl.com/pd-efile): This TechTip provides step-by-step instructions with screens shots in use this feature.

• Register Your Firm Video (tinyurl.com/efile-register-firm): This self-running video demonstrates how to use this feature.

• Register a New User Video (tinyurl.com/efile-register-user): This self-running video demonstrates how to use this feature.

• Notification Options Video (tinyurl.com/efile-notify-optns): This self-running video demonstrates how to use this feature.

• Edit Your Information Video (tinyurl.com/efile-edit-personal): This self-running video demonstrates how to use this feature.
• **eFiling from ProDoc Video** ([tinyurl.com/efile-from-prodoc](http://tinyurl.com/efile-from-prodoc)): This self-running video demonstrates how to use this feature.

• **eFiling Online Video** ([tinyurl.com/efile-online](http://tinyurl.com/efile-online)): This self-running video demonstrates how to use this feature.

• **My Filings Video** ([tinyurl.com/my-filings](http://tinyurl.com/my-filings)): This self-running video demonstrates how to use this feature.

• **Submit eService Video** ([tinyurl.com/eservice-submit](http://tinyurl.com/eservice-submit)): This self-running video demonstrates how to use this feature.

• **My eService Video** ([tinyurl.com/my-eservice](http://tinyurl.com/my-eservice)): This self-running video demonstrates how to use this feature.

• **Firm Management Video** ([tinyurl.com/efile-firm-mgt](http://tinyurl.com/efile-firm-mgt)): This self-running video demonstrates how to use this feature.

• **Registration Guide** ([tinyurl.com/register-for-efiling](http://tinyurl.com/register-for-efiling)): This booklet guides your through the process of creating a ProDoc eFiling Firm or Individual account and registering with the state eFiling system.

• **eFiling Guide** ([tinyurl.com/efile-guide](http://tinyurl.com/efile-guide)): This booklet walks you step-by-step through the eFiling process.

• **Appellate Filing Guide** ([tinyurl.com/appellate-guide](http://tinyurl.com/appellate-guide)): This booklet educates you on important differences between eFiling into the trial courts and eFiling into the Texas appellate courts.

• **eService Guide** ([tinyurl.com/eservice-guide](http://tinyurl.com/eservice-guide)): This booklet walks you step-by-step through the eService process.

• **Firm Management Guide** ([tinyurl.com/firm-manager](http://tinyurl.com/firm-manager)): This booklet guides you through all the options available to a ProDoc eFiling Firm Manager.

#### E. REVIEW

1. Describe how to begin the process of eFiling from ProDoc using the main menu.

2. What is the difference between using the Browse button and using the Case Documents button to choose documents for eFiling?
Module 14 - Assignment

A. ASSIGNMENT DESCRIPTION:

In this assignment, you will assemble a document and an attachment and prepare these documents for eFiling through the ProDoc eFile Documents feature.

B. DIRECTIONS:

Assemble the documents

1. Click the **Assemble** icon.
2. Select Jane Doe as the client and Divorce as the case.
3. Select and forms **3-1 Original Petition for Divorce** and **3-2 Petitioner’s Supporting Affidavit**. Ensure the **Review prior answers** box is not checked.
4. Assemble the forms. Use the following information to answer the questions:
   a. Select **Citation by Publication** as a provision for **Petitioner’s Supporting Affidavit**.
   b. Select **Residence Unknown** as a provision for **Citation by Publication**.
   c. **Tab** through the remaining questions until you reach the merge phase question asking you to insert the specific facts showing due diligence regarding attempts at personal service. Enter **Published notice of case in local newspaper of last known address area for the past three months**.
   d. **Tab** through the remaining questions.
5. Click **Continue** on the **Completed Documents** window. Close the word processor.

C. PREPARE THE DOCUMENTS FOR EFILING

Using the procedures you worked with in this module, prepare these documents for eFiling from ProDoc. Choose the **Original Petition for Divorce** document as the lead document and the **Petitioner’s Supporting Affidavit** as an attachment.

D. SUBMIT A PRACTICE EFILING

You will not be able to submit a practice eFiling through ProDoc because ProDoc points to the live eFiling site. You will be submitting your eFiling on our practice site so you don’t get in trouble with the clerk of court for the jurisdiction you select.

1. Go to **https://etxstage.prodoc.com**.
2. Go to **Resources > Getting Started**.
3. Following the instructions provided on this page:
4. Create a firm account and enter this **fictitious credit card number: 5499-9901-2345-6781**
5. Register yourself as an attorney using a **fictitious bar number of your choice**.
6. After registering yourself you can then submit an eFiling to the jurisdiction of your choice.

7. On page two of the eFiling process, upload the **Petition** first and then upload the **Affidavit**.

8. Because you are not eFiling through ProDoc, you will need to browse your computer to find the documents. You will find them under `C:\Clients\Hutton`. 
Module 14 - Quick Check

1. True or False: Signatures are required for every document that you eFile.

2. True or False: The eFile Documents menu option in the eFile menu enables you to automatically attach documents from your case files to your eFiling.
Module 15 - SOS Part I

A. MODULE DESCRIPTION

The Small Office Suite (SOS) add-on to ProDoc fully integrates all practice management functions utilizing a single database. This means that whichever action is being performed – contact (client) or case management, time management, billing management, or calendaring – information is entered into a single database once and is available to perform all small law firm operations.

B. OBJECTIVES

Upon successful completion of this module, you will be able to:

1. Demonstrate how to view the different attributes of a contact or case file.
2. Demonstrate how to add the following information to a contact or case file:
   a. Notes
   b. To Do’s
   c. Associations
   d. Appointments
3. Demonstrate how to view summary billing information about a contact/case.
4. Demonstrate how to add an e-mail document from Microsoft Outlook to SOS.
5. Demonstrate how to add and work with internal messages in SOS.

C. PROCEDURE

Start SOS by clicking the icon on the ProDoc toolbar or double clicking the SOS icon on the desktop. Enter your initials as a log-in ID and verify the date and time (if necessary).

a. Configuring basic SOS settings

   Complete the following steps to set up SOS.
   1. On the main menu, Click Setup>System manager>System settings.
   2. On the System tab, check the box titled Auto Backup at exit. Click OK.
   3. On the main menu, Click Setup>System manager>Staff members.
   4. On the Staff Members window, highlight the line with your initials. Click the Update button. The Changing a Staff Record window appears.
   5. Uncheck the box titled This person is an attorney if it is checked. Check the box titled This person is a timekeeper. Check the box titled Allow on calendar and To Do list (this activates the last two options). Finally, check the remaining three boxes on the lower right side of the window.
   6. Click OK to close the Changing a Staff Record window. Click Close on the Staff Members window.
7. Click **Setup>Personal Preferences**, then click the **Messages** tab. Message handling defaults and settings are customized here.
   
   i. Check the following sections/options: Notify me using - **Float**, Message Settings - **Phone** and Show only - **All**.
   
   ii. Note that you also have the option to play a sound to alert you to a new message.
   
   iii. Click the **OK** button.

b. **Updating contact information**

   Complete the following steps:

   1. Click the [icon](the Practice Manager) on the toolbar.
   
   2. If you have contacts, these will appear on the left side of the screen. On the right side of the screen is a series of tabs. These tabs allow you to view and edit details pertaining to the selected contact or case.
   
   3. Notice that if a contact has associated cases, a plus (+) sign appears to the left of the contact name in the **Contact Name** pane. Click any plus (+) sign next to a contact name to view the case(s).

   **Note:** There are several important concepts to remember regarding the difference between contact or client level and case level information. **SOS** significantly extends the client level management that is possible in ProDoc by allowing all contact information, for clients and non-clients, to be managed uniformly. One difference is that plain contacts typically might not have case level relationships; whereas, client type contacts could have many varying case level relationships.

   4. Click a contact in the list and then click the **Update** button. This allows you to update the contact’s information. Click **OK** to close the window.

c. **Adding a Note to a Contact/Case**

   1. Click the **Notes** tab and click the **New** button under the blank note area on the right side.

   Remember, if a contact is selected, a note will be added at the contact level. If a case is selected, the note will be added at the case level.

   2. A **Note Will Be Added** window will display. Type **Spoke with contact on phone about PI case**. The reference button at the top allows you to switch to a different **Contact/Case** if needed.

   3. Click **OK**. A note will now appear on the note screen. As you click other contacts and cases, their notes will appear here also (if they have any notes).

   4. Alternatively, you could have clicked the [icon](on the toolbar to enter a case note using the instructions above.

d. **Adding To Do’s**

   1. Click the **To Do** tab and click the **New** button.

   2. Notice that the **To Do** can be added for each user that is in the **For** drop down menu. Change the date to **tomorrow’s** date.
3. Set the Priority to 1 (the default priority is 5). **Note:** SOS does not determine whether 1 or 10 is the highest priority. The user/law firm must decide this.

4. Type **Have certificate completed by 1:00 PM.**

5. Click the **OK** button. Notice that the **To Do** is now listed on the menu for that contact/case. These will be listed by priority from 1 to 10. As you finish the **To Do's,** you can remove them from the list by highlighting each one and then clicking the **Mark Done** button.

6. From this screen, you can also **Print,** **Update** and **Delete** the To Do's as needed.

7. Alternatively, you could have clicked the 📝 icon on the toolbar to enter a **To Do** using the instructions above.

e. **Adding Associations**

1. To use **Associations,** the feature must be turned on. To do this, click the **Setup** menu and click **Personal preferences.** Click the **Preferences** tab and ensure that all check boxes in the **Options** section in middle of the dialog window are checked. Close the dialog window.

2. To establish an association, you must have at least two contacts in the contact list. If you don't, add yourself to the **Practice Manager** contact list. First and last names and case description will be sufficient.

3. In the **Practice Manager,** click the **Associations** tab. Make sure one contact is selected from the contact list on the left. Click the **Update Associations** button.

4. When the **Associated Contacts** dialog window appears, click another contact in the list. Click the **Add** button to establish the association. Click **Close** to close the dialog window.

5. To test the association, click either name in the contact list and ensure the associated contact appears in the **Contact Associations** pane.

f. **Creating Appointments**

1. Click the **Appointments** tab, then click the **New** button at the bottom.

2. The **Appointment Will be Added** dialog window displays. In the **For** field, click the drop-down menu and select whom the appointment is for. In this example, choose your login initials. If the appointment is for more than one staff member, you would click the **Staff** button and select the member(s) from the list.

3. Set the **Date of the appointment** to a date in the future and set a **Time** for the appointment time.

4. Set the **Duration** to 1 hour and, in the **Description** field, type **Meet with contact at the courthouse.**

5. Click the checkbox **Alarm** for yourself to set a reminder. Set the time before the appointment to **15 minutes.** The appointment is out of the office, so click the radio button **Out.** Notice the **Reference** button at the top of the dialog window. By clicking this button, you can set the appointment for any contact/case in the list.

6. Click **OK.** Note that the appointment is added to the list of appointments for the
contact in the Practice Manager. At this point, you can click buttons to Delete the appointment or Update the appointment as needed.

7. Alternatively, you could have clicked the icon on the toolbar to create an appointment using the instructions above.

g. Handling Documents in SOS

Click the Docs tab. If a case is highlighted, nine icons are displayed below the tabs; only seven of these are displayed if a contact is highlighted.

All icons are only active when documents are stored and the highlighted document was assembled with ProDoc. You can view the functions by placing the mouse pointer on an active icon. A list of functions for the icons displayed when a case is selected follows, viewed from left to right:

- View a document.
- Windows Explorer.
- Search for a document.
- Assemble a document.
- Reassemble a document.
- Add a new document.
- Update currently selected document.
- Delete the currently selected document record (but not the document itself).
- Erase the currently selected document from the computer disk drive.

h. Verifying Billing Status

1. Click the Billing tab. Clicking this tab with a contact highlighted will provide you with an overview of the contact's billing status.

2. In the contact list, click a Case for a contact. Click the Billing tab. Notice that you now have a view of the billing status for the case. A contact may have different information at the contact level and different information for each case. You cannot change information on these billing tabs. These are present only for viewing the summary information. Billing will be covered in greater detail in Module 16.

i. E-Mail Rcvd

1. Click the E-Mail Rcvd tab. This tab allows you to drag and drop e-mail from Microsoft Outlook® and Outlook Express® into a contact or case folder in SOS. Once the e-mail has been copied to this location, SOS will keep a listing of all e-mails by contact and/or case.
2. Click the **Add Mail** button. The **Add E-Mail Messages** dialog window opens. Open either **Microsoft Outlook** or **Outlook Express** and browse to the e-mail you want to copy into SOS.

3. Click the e-mail and drag it to the **Add E-Mail Messages** dialog window. If you have a case under the contact where the e-mail needs to go, hover the mouse over the contact’s name and the cases will appear. Release the e-mail on to the folder/case for the desired contact. SOS will automatically copy the file to the selected location.

4. To verify that the file was copied correctly, switch back to SOS by clicking the **Close** button, then clicking the **E-mail Rcvd** tab. Click the **Contact** and then the **Case**. Check the list and the e-mail will appear in the list.

5. You can print or delete e-mail documents from this tab by clicking the document and selecting either print or delete.

**Note:** If the email being copied has attachments, you will be able to open the attachment, save the attachment to the Document Manager or save the attachment to another location on the computer. These options become available when the email is added to SOS. The user can access the options via the “Attachments” button.

j. **Creating SOS Messages**

1. Click the **Messages** tab. This tab allows you to send new messages to other staff members.

2. To create a new message, click the **New** button. The highlighted contact name or the highlighted case description and contact name will be listed next to the **Reference** button. Note that clicking the **Clear** button removes the reference. Clicking the **Reference** button allows you to change the reference.

3. Click the **To** field and select your initials or name from the menu to make it easy to access the message. Clicking the **Group** button allows you to select multiple staff members as recipients.

4. Enter “**Billing Inquiry**” in the **Subject** line and “**The client wants to talk about payment plans.**” in the **Message** field.

5. **Phone** is already selected as a default message type. Check the **Urgent** box. Check the **Private** box. This ensures that only the sender and listed recipient(s) are able to view the message.

6. From and **Phone** fields appear whenever **Phone** is checked. Click the ellipsis button (…) next to the **From** field and select the referenced client. If the client has phone numbers stored, these will appear in the field. You can edit these manually or clear the entire field by clicking the **Clear** button.

7. Click **Send**. The message appears on the **Messages** tab because the highlighted reference is applied to the message. The **Messages** float window will display the words **You have 1 new message**.

8. On the **Messages** tab, you can use the buttons to either **Print**, **Read** or **Delete** the highlighted message, depending on the recipients listed. Unread messages are designated as **N** for **New**. Once a message is read, its status will change to **P** for **Pending** or **D** for **Done** if that option is chosen by the reader.
k. **Working with the Message Center**

The **Created Date** and **Time, From** entry and **Subject** are displayed here for your **In Box** messages. **Sent** messages also display a **To** column. Non-urgent phone messages display a black phone; urgent phone messages display a red phone; and urgent messages not designated as phone messages will display a red exclamation mark.

1. Click the **View** button on the floating Messages window to see your **In Box**. Your default setting is to view **All** messages; you can change the type of messages to view on this tab by clicking the appropriate status. Messages you have not yet read are displayed in bold typeface.

2. Single-click the message you sent earlier (if it is not highlighted). The contents of the **Message** field are displayed in the lower section of the window. You can use the appropriate buttons to perform any of the indicated functions for a highlighted message without actually reading it.

3. Click the **Sent** tab. Highlight the message you sent earlier and click the **Read** button. Notice that you cannot change the status here, but you can perform a wide variety of other functions, explored in the next step. Click **Cancel**.

4. Click the **In Box** tab and double-click the same message. Click **Done** in the **Status** section to indicate this status for the message. Along with standard function buttons, you can use the appropriate buttons to copy the message contents to a new **Appointment**, **To Do**, **Note**, or **Reminder Alarm**. If a case is referenced, you can copy the contents to begin a **Charge** or **Timer** slip. The other buttons are self-explanatory.

5. Click the **OK** button to close the window. Note that in your **In Box**, you can use the buttons to **Delete All Done**, change the status of a highlighted message between **UnDone** and **Done** (the button renames itself as the status changes), or create a **New Msg**.

6. Click the **Close** button to close the **View Messages** window. Click the **Exit** button to close the **Practice Manager**.

**D. ADDITIONAL RESOURCES**

Additional ProDoc resources available to assist you in understanding more about the **Practice Management** features in SOS include:

- **SOS Practice Manager Tips**: ([tinyurl.com/pd-pm-grc](http://tinyurl.com/pd-pm-grc)): This **Quick Reference Sheet** is a “cheat sheet” for the most commonly used features in the **Practice Manager**.

- **Adding Appointments Video** ([tinyurl.com/sos-add-appts](http://tinyurl.com/sos-add-appts)): This self-running video demonstrates how to use this feature.

- **Adding Contacts and Cases Video** ([tinyurl.com/sos-add-contacts](http://tinyurl.com/sos-add-contacts)): This self-running video demonstrates how to use this feature.

- **Adding Notes Video** ([tinyurl.com/sos-add-notes](http://tinyurl.com/sos-add-notes)): This self-running video demonstrates how to use this feature.

- **Add ToDos Video** ([tinyurl.com/sos-add-ToDos](http://tinyurl.com/sos-add-ToDos)): This self-running video demonstrates how to use this feature.

- **Setting Up Categories Video** ([tinyurl.com/sos-categories](http://tinyurl.com/sos-categories)): This self-running video demon-
strates how to use this feature.

E. REVIEW

1. True or False: There is no difference between case level and contact level information.

2. True or False: SOS determines which priority is higher with a To Do; the user has no control over whether 1 is higher or 10 is higher.

3. True or False: To use associations, the feature must be activated in the setup menu and under personal preferences first.

4. True or False: The default duration time for an appointment is 1 hour.

5. True or False: The billing settings can be changed in the Practice Manager’s billing tab.
Module 15 - Assignment

A. ASSIGNMENT DESCRIPTION:

You will demonstrate how to add an Appointment, a To Do, a Note, and an Association.

B. DIRECTIONS:

1. **Adding an appointment**

Using the skills that you learned in this module, add the following Appointment for Mr. Robert Hutton (make sure the reference is set to Mr. Hutton):
   a. For: *Your initials*
   b. Date: Some future date
   c. Time: 1:00 PM
   d. Duration: **2 hours**
   e. Description: **Meet w/client at courthouse prelim hearing**
   f. Alarm for yourself: **20 minutes before appointment**
   g. In/Out of Office: **Out**

2. **Adding a To Do**

Use the following information to add a To Do for this client:
   a. For: *Your initials*
   b. Date: **Some date this week**
   c. Priority: **1**
   d. Task: **Prepare paperwork for prelim hearing**

3. **Adding a Note**

Use the following information to add a Note for this client:
   a. Date: **Yesterday’s (or previous day’s) date**
   b. Note: **Met with client at the courthouse, discussed pending trial**

4. **Adding an Association**

Use the following information to add an Association for this contact:
   a. Associate **Robert Hutton** with attorney **Jimmy Parks**.
   b. Add **Jimmy Parks** if needed. Remember that he is **not** a client.

5. **Test the Association**

a. Open the **Practice Manager** and locate the contact whose data you were just managing.

   b. Click the appropriate tabs to confirm that you entered the above information correctly.
Module 15 - Quick Check

1. True or False: When a plus sign (+) appears next to a client’s name in the client listing, it means that there are cases under that client’s name.

2. True or False: You can only transfer e-mails from Microsoft Outlook or Outlook Express to SOS.

3. True or False: A client cannot be associated with more than one client in the client list.

4. True or False: To delete a document from the documents tab window, click the document and then click the triangle icon.
Module 16 - SOS Part II

A. MODULE DESCRIPTION

The Small Office Suite (SOS) add-on allows users to manage their office practice more efficiently. In this exercise you will learn how to create a time slip charge and change the billing settings in ProDoc.

B. OBJECTIVES

Upon successful completion of this module, you will be able to:

1. Demonstrate how to set up the SOS billing rates in ProDoc.
2. Demonstrate how to create a charge slip.
3. Explain the difference between a flat fee and expense/markup charge.
4. Create a client rate, case rate, and timekeeper rate.
5. Configure and use the Timer Function to create a charge slip.

C. PROCEDURE

1. Setting up billing rates in ProDoc

You will now learn how to automatically bill the client for each document. Complete the following steps:

   a. In ProDoc, click Customize > Options. On the Options and Settings window, click the Small Office Suite (SOS) link on the left side of the window.

   b. Click the box at the top of the window to enable the generation of charge slips in SOS.

   c. Click the Volume field. Select the Criminal Defense volume from the list.

   d. Scroll down to the section Chapter 2-Attorney. Click form number 2-1 Appearance of Counsel. Click the Edit Amount button. Type $500 (or use the arrow keys) to set the amount to be charged. Click the OK button to save the entry.

   e. Click form number 2-6 Motion to Substitute and set the value to $750.

   f. Click form number 2-3 Motion to Withdraw and set the value to $500.

   g. Press the Enter key and click OK to close the Options and Settings window.

If the firm charges a flat fee for documents, you will normally set values for each document in volumes the attorney uses. You will find that some documents are used frequently. You should set values for these documents first.

2. Using the Automatic Charge Feature

ProDoc is now configured to automatically charge the client for these documents after the documents are assembled. Complete the following steps:

   a. Click the Assemble icon and select John H. Doe, Jr. and the Criminal Defense case from...
your client/case list. You must select a case in order to create a charge slip.

b. Select the Criminal Defense volume and click the form 2-1 Appearance of Counsel.

c. Uncheck the box to avoid reviewing prior answers. Click Start Assembling and accept the default answers. Click the Auto button to skip past the merge questions. Click Continue on the Completed Documents dialog window.

d. If you logged in with the same initials you used to designate yourself as a timekeeper at the beginning of Module 15, your initials will be used as the timekeeper on the Charges to Generate in SOS window. Follow steps d.1. through d.4. below ONLY if a message window appears requiring a timekeeper designation.

1. Click the Edit Charge button.

2. Choose your initials as a timekeeper using the drop-down field next to the Timekeeper field.

3. Click OK to close the window and return to the previous window.

e. The Charges to Generate in SOS dialog window will appear. If you assemble multiple documents at once, you will see a listing of all the documents on this screen. Notice the Appearance of Counsel document has a $500 charge. Any other documents assembled would also be listed with their respective charges (if these are defined).

f. To charge for any document that has no charge associated with it, click the document and then click the Edit Charge button. Type the value to charge for the document.

g. You can delete a charge by clicking the charge, then clicking the Delete Charge button.

h. After all of the changes have been made to this screen, click the Generate Charges button to process the information. ProDoc will automatically bill the customer’s account for the charges.

3. Creating a Charge Slip in SOS

In the previous section, you learned how to assign a cost to certain documents. In this section, you will learn how to set up SOS to charge for a Time Charge, Flat Fee, and Expense/Markup. Standard amounts need to be set up in SOS for each of the charges. Complete the following steps:

a. Click the icon (the Create a Charge Slip icon).

b. A Charge slip will be added dialog window appears. Click the Reference button at the top and select a client and case from the list. Verify the Client’s Name, the Date, and the Timekeeper (your initials) are correct.

c. Click the radio button next to Time charge. In the Fee field, set the hours to 1.5. Next to the Rate button, click the button that has three dots (...). The Select an Hourly Rate dialog window appears. Click the Edit button at the bottom. This allows you to enter values into each of the three fields.

d. In the Default Case Rate field, type $100. In the Default Client Rate field, type $75. In the Default Timekeeper Rate, type $75.

e. Click the Save button to save those values. You can now select the rate you wish to charge
this client. Click the **Default Timekeeper Rate** radio button to select it, then click **OK**.

f. Notice that by setting the hours and setting the timekeeper rate, the **Time Charge** is automatically calculated on the right side.

g. You must enter a description in order for it to print on the bill. Enter **Met with client at office, discussed divorce case**. Click **OK**.

h. To create a flat fee charge, click the $ icon, click the **Flat fee** radio button, type $150 as the fee amount, type the description and click **OK**.

i. To charge for **Expense/Markup**, click the $ icon, click the **Expense/Markup** button, enter $1.00 as the **Cost/Unit** of the item and enter 5 copies as the number of **Units**. SOS will automatically calculate the charge. Enter **Copies for case** as the description and click the **OK** button to process the charge.

j. To verify that the charges have been created, go to the client’s billing tab in the **Practice Manager** and verify that the charges appear on the right side. At this point, the customer has been charged but not billed.

**4. Setting up Markup Expenses**

If your practice has items such as copies, parking fees, etc. for which you charge a markup, SOS can calculate those automatically. In this section, you will learn how to set the markup on items that the attorney commonly uses. Complete the following steps:

a. In SOS, click the **Setup** menu, **System Manager** and **System settings**.

b. Click the **Billing Settings** tab. Click the checkbox next to **Markup** and click the **Set up Markup** button.

c. The **Enter the Items You Commonly Markup** dialog window displays. Click the **New** button. The **Add a Markup Description** dialog window displays. In the **Markup Description** field, type **Legal Document Copies**.

d. In the **Cost/Unit** field, type .10. Click the **Markup a Fixed Dollar Amount per Unit** and type .75. Alternatively, you can specify a markup by percentage of the cost and specify a certain percentage such as 200%. You can also type an **Optional Charge Description** in the box at the bottom for the screen that will appear on the bill. Click **OK** to complete adding the markup.

e. The markup will now appear on the **Enter the Items You Commonly Markup** screen. This screen allows you to add additional markup items, update existing items, and delete existing items. Click the **Close** button.

f. Click the $ icon and select a client and case. Notice that the **Charge slip will be added** box now has a section on **Markups**. Click the **Expense/Markup** radio button to activate **Markup** options.

g. Select **Legal Document Copies** from the **Markup Type** drop down field. Notice that the markup cost is already listed; enter the quantity. Type 20 in the **Units** field.

h. In the description field, type **legal documents copying charge**. Click **OK** to create the charge. To verify that the charge has been created, go to the client’s billing tab in the
**Practice Manager** and verify that the charge appears on the right side. If you used a client will no previous unbilled charges, you will see a charge for $17.00 for the copies. If there were previous unbilled charges, $17.00 will be added to the total amount for all unbilled charges and the total will be displayed here.

5. **Track Only Charges**

You may wish to track the performance of services or incurring of expenses for a particular contact or case, but not actually charge the customer. By selecting the **Track Only** option, the service or expense can be tracked and printed on the bill as a “no charge” item or not be printed on the bill at all.

For the following exercise, leave **Track Only** unchecked.

6. **Using the Timer Function**

Another way to charge a customer for services is by using the timer function. The timer icon has the watch with a dollar sign on it. It is normally used to track time when either talking on the phone with a client or working on a project for a client. The **Timer** is set up to bill in user definable timed increments. Most attorneys bill at .10 hours (6 minutes) or .25 hours (15 minutes). The default increment is set at .25 hours. Specify what the hourly charge is and start and stop the timer. The Timer will automatically bill the client for the amount that is calculated.

Complete the following steps:

1. Adjust the time increment by:
   a. Selecting **Setup** (from the menu bar)
   b. Selecting **System manager**
   c. Selecting **System settings**
   d. Clicking the **Billing Settings** tab
   e. Set the time in the field **Bill time in increments of (hrs):** to .10 and click **OK**.

2. Click the **icon** (Start a Timer). Verify that the date is correct and that your initials are in the **Timekeeper** field. Select a client/case from the list using the **Reference** button.

3. Select the rate to charge by clicking the **Ellipsis** button (or type a dollar per hour amount). If a rate is not entered, enter $75.

4. Type the following as the description: **Spoke with the client on the phone and discussed how to handle the final divorce decree.**

5. Ideally, you would start the timer once you start talking with the client. In this example, click the **Start Timer** button and wait a few minutes. If you need to pause the timer, click the **Pause** button. When you are ready to resume, click the **Start Timer** button again.

6. Click the **OK** button when you are finished timing. Click the **OK** button when SOS states that a charge will be added to the case.
D. ADDITIONAL RESOURCES

Additional ProDoc resources available to assist you in understanding more about the SOS Billing Manager features include:

- **Auto-Billing from ProDoc TechTip** ([tinyurl.com/pd-autobill](https://tinyurl.com/pd-autobill)): This TechTip gives you step-by-step instructions on how to set up and use automatic billing for ProDoc-generated documents.

- **Tips** ([tinyurl.com/pd-sos-bm](https://tinyurl.com/pd-sos-bm)): This Quick Reference Sheet is a “cheat sheet” for the most commonly used features in the Billing Manager.

- **Adding New Charges Video** ([tinyurl.com/sos-add-charges](https://tinyurl.com/sos-add-charges)): This self-running video demonstrates how to use this feature.

- **Entering Payments Video** ([tinyurl.com/sos-enter-payments](https://tinyurl.com/sos-enter-payments)): This self-running video demonstrates how to use this feature.

- **Generating Pre-Bills and Final Bills Video** ([tinyurl.com/sos-prebill](https://tinyurl.com/sos-prebill)): This self-running video demonstrates how to use this feature.

- **Using the Timer Slip Video** ([tinyurl.com/sos-use-timer](https://tinyurl.com/sos-use-timer)): This self-running video demonstrates how to use this feature.

- **Using the Certified Mailer Video** ([tinyurl.com/sos-mailer](https://tinyurl.com/sos-mailer)): This self-running video demonstrates how to use this feature.

- **Using the Letter Designer Video** ([tinyurl.com/sos-letter-designer](https://tinyurl.com/sos-letter-designer)): This self-running video demonstrates how to use this feature.

- **Using the Letter Generator Video** ([tinyurl.com/sos-letter-generator](https://tinyurl.com/sos-letter-generator)): This self-running video demonstrates how to use this feature.

E. REVIEW

1. True or False: You can set the value of each form in ProDoc under the Billing Setup menu.

2. True or False: Once a document’s value has been set, it cannot be overridden.

3. True or False: The three types of charges are Time, Flat Fee, and Expense/Markup.

4. True or False: You can use the Start a Timer feature to charge a flat fee for a case.
Module 16 - Assignment

A. ASSIGNMENT DESCRIPTION

In this assignment, you will demonstrate how to set up billing rates in ProDoc, create various charge slips and use the timer function in SOS.

B. DIRECTIONS

Setting up billing rates. Using the skills that you learned in the SOS Module - Part II, add the following charge rates in ProDoc to the Family Law volume documents listed below.

1. 3-1 Original Petition for Divorce, $850.
2. 3-13 Waiver of Service, $250.

1. Creating charge slips

Create a series of charge slips using the following information for the client Robert Hutchings:

a. First charge slip:
   1. Date: (Choose a work day this week)
   2. Timekeeper: Your initials
   3. 3 hour fee at the rate of: $175.00/hour
   4. Description: Represent client at first court appearance

b. Second charge slip:
   1. Date: (Choose a work day this week)
   2. Timekeeper: Your initials
   3. Flat fee charge: $1200
   4. Description: Prepare divorce paperwork

c. Third charge slip:
   1. Date: (Choose a work day this week)
   2. Timekeeper: Your initials
   3. Expense/Markup: 50 pages of copies, cost is .10 markup .50
   4. Description: Copying of legal documents

2. Setting a timer charge

Set a timer charge for a 15 minute phone call with the client at a rate of $100.00/hour.
Module 16 - Quick Check

1. 1. True or False: In order to use the Start a Timer charge function, you must specify a client and a case.

2. 2. True or False: To use the Expense/Markup charge, you must enter a description of the charge.

3. 3. True or False: When setting up the default timekeeper rate, you can only have one timekeeper listed at a time.
Appendix I - Extra Credit

A. MODULE DESCRIPTION

Your instructor may choose to offer you extra credit for successfully completing this module.

Even if you choose not to do so, this is a great challenge if you are bored with the pace of the class and looking for something more challenging. In this module you learn how to create a form template just like the ones have have been working with in ProDoc all semester.

Effectively, you will learn basic programming skills that you will be able to take into legal offices. The advantage you will have over others who merely complete the course is that you will have the knowledge and some basic skills to create entirely new volumes of proprietary automated forms for the firm.

Our experience is that many firms have proprietary forms that they use often but that must be assembled in the old fashioned way. Rather than paying thousands of dollars to one of our attorney-developers to do so, they can hire you and get your expertise with creating Supplemental Forms in ProDoc as a bonus.

B. OBJECTIVES

Upon successful completion of this module, you will be able to:

1. Add new Supplemental Volumes into ProDoc.
2. Add new automated supplemental forms into ProDoc.
3. Update as needed the supplemental forms as needed.

C. PROCEDURE

1. Your Three Options

You have three options to create supplemental forms in ProDoc

   a. Edit Existing Form Templates - You can completely revise existing form templates to be more customized to the specific needs of your attorney. You are not actually creating supplemental forms in this scenario but it provides the fastest and easiest way to create a more customized form template into ProDoc. You can learn about Editing Existing Form Templates at:

   b. Revise an existing automated form - While this is the fastest and easiest method to add new forms into ProDoc, it has limitations. You cannot add logic questions or looped answers, etc. While these terms mean nothing to you right now, what they do mean is that you are limited to very basic forms. Learn about revising existing forms to create supplemental forms at:

   c. Create an entirely new form from scratch - Using the knowledge you gain from our Supplemental Developer Course you will be able to add many advanced features into your Supplemental forms, including:
1. Loops to account for multiple parties,
2. Deletes to drop optional language in the document depending on your responses to questions,
3. Merges to add optional language in the document depending on your responses to questions
4. Operators to determine the pronouns and possessives in your form depending on your responses to questions,
5. Etc.

In addition to creating true Supplemental Forms you can also create new Supplemental Volumes.

2. Creating Supplemental Forms
   a. Edit Existing Form Templates - You can learn about Editing Existing Form Templates at: tinyurl.com/pd-modify-templates
   b. Revise an existing automated form - Learn about revising existing forms to create supplemental forms at: tinyurl.com/pd-suppforms
      We also provide a self-running video on creating supplemental forms that you will find at: tinyurl.com/pd-supplemental
   c. Create an entirely new form from scratch - Everything you need to learn how to create true supplemental forms you will find at www.prodoc.com/suppdev). From this page you can download the manual you will work from and download the Supplemental Developer Installation file. After installing ProDoc Supplemental Developer on your computer, follow the manual to create an automated residential lease form.

3. Receiving Credit for the Exercise
Appendix II - Additional Resources

Tech Tips
We created a number of TechTips, short articles about how to use many of the time-saving features we pack into ProDoc. They are extremely comprehensive and lead you step-by-step while showing you how to use each feature. We strongly encourage you to take a look at this, and perhaps even print them for future reference:

• Auto-bill to SOS: tinyurl.com/pd-autobill
• Backing Up ProDoc: tinyurl.com/pd-backup-files
• Certified Mailer: tinyurl.com/pd-cert-mailer
• Clients and Cases: tinyurl.com/pd-clients-cases
• Creating Supplemental Forms: tinyurl.com/pd-suppforms
• Custom Intake Form: tinyurl.com/pd-custom-intake
• Customize ProDoc Settings: tinyurl.com/pd-custom-settings
• Default Answer Sets: tinyurl.com/pd-default-answers
• Default Document Formatting: tinyurl.com/pd-default-formatting
• Edit Case Answers: tinyurl.com/pd-edit-answers
• eFile from ProDoc: tinyurl.com/pd-efile
• Finding Forms in ProDoc: tinyurl.com/finding-pd-forms
• Form Sets: tinyurl.com/pd-form-sets
• Graphic Engine: tinyurl.com/pd-graphic-engine
• Modify Master Templates: tinyurl.com/pd-modify-templates
• QuickText: tinyurl.com/pd-quick-text
• Print Case Data Sheets: tinyurl.com/pd-case-data
• Print Forms Lists: tinyurl.com/pd-forms-lists
• Revising Finished Documents: tinyurl.com/pd-revise-docs
• Texas PowerPack: tinyurl.com/tx-pptips

Quick Reference Sheets
These sheets provide succinct tips on using the various features in ProDoc and in SOS:

• ProDoc Tips: tinyurl.com/pd-qrs
• SOS Billing Manager Tips: tinyurl.com/pd-sos-bm
Self Running ProDoc Training Videos

The self-running training videos cover many of the basic features in ProDoc, ProDoc Power Packs and eFiling. You may find them to be extremely useful for review purposes.

1. **ProDoc**
   - Assembling a Document in ProDoc: tinyurl.com/pd-doc-assembly
   - Basic ProDoc Document Formatting: tinyurl.com/pd-doc-formatting
   - Advanced Document Formatting: tinyurl.com/pd-advanced-formatting
   - Printing Case Data Sheets: tinyurl.com/pd-print-case-data
   - Using Default Answers: tinyurl.com/pd-defaults
   - Edit Case Answers: tinyurl.com/pd-edit-case-answers
   - Form Sets: tinyurl.com/pd-create-form-sets
   - Search for Forms: tinyurl.com/pd-forms-search
   - Finding/Printing Blank Forms: tinyurl.com/pd-print-blank-forms
   - Customizing Firm Information: tinyurl.com/pd-settings-firm
   - Customizing Personal Information: tinyurl.com/pd-custom-personal
   - Creating Supplemental Forms: tinyurl.com/pd-supplemental

2. **SOS**
   - Adding Appointments: tinyurl.com/sos-add-appts
   - Adding Contacts and Cases: tinyurl.com/sos-add-contacts
   - Adding Notes: tinyurl.com/sos-add-notes
   - Add ToDos: tinyurl.com/sos-add-ToDos
   - Setting Up Categories: tinyurl.com/sos-categories
   - Adding New Charges: tinyurl.com/sos-add-charges
   - Entering Payments: tinyurl.com/sos-enter-payments
   - Generating Pre-Bills and Final Bills: tinyurl.com/sos-prebill
   - Using the Timer Slip: tinyurl.com/sos-use-timer
   - Using the Certified Mailer: tinyurl.com/sos-mailer
   - Using the Letter Designer: tinyurl.com/sos-letter-designer
   - Using the Letter Generator: tinyurl.com/sos-letter-generator
3. Family Law PowerPack
   • Child Support Calculator: tinyurl.com/pd-cs-calculator
   • Delinquent Support Calculator: tinyurl.com/pd-delinquent
   • Payment Splitter: tinyurl.com/pd-splitter
   • Obligation Amortizer: tinyurl.com/pd-amortizer
   • Child Possession Calendar: tinyurl.com/pd-poss-calendar
   • Divorce Inventory: tinyurl.com/pd-inventory
   • UCCJEA Affidavit: tinyurl.com/pd-uccjea

4. eFiling
   • Register Your Firm: tinyurl.com/efile-register-firm
   • Register a New User: tinyurl.com/efile-register-user
   • Notification Options: tinyurl.com/efile-notify-optns
   • Edit Your Information: tinyurl.com/efile-edit-personal
   • eFiling from ProDoc: tinyurl.com/efile-from-prodoc
   • eFiling Online: tinyurl.com/efile-online
   • My Filings: tinyurl.com/my-filings
   • Submit eService: tinyurl.com/eservice-submit
   • My eService: tinyurl.com/my-eservice
   • Firm Management: tinyurl.com/efile-firm-mgt
Appendix III - ProDoc Certification Exam Information

We provide an optional online ProDoc Core Certification exam available to you. Upon completion of the exam with a score of 84, or better, we will provide you a certificate indicating you proficiency in ProDoc. Because of the wide use of ProDoc in law firms, a certificate of proficiency in ProDoc is a valuable asset for getting hired in a law firm.

A. ABOUT THE EXAM

You will answer online general knowledge questions. The test consists of 100 True/False and multiple choice questions covering the modules in the Student Manual.

You will have a maximum of two attempts over a consecutive three day time period to take the exam. It can be rescheduled if you are not able to sit for the test during those three days or if you do not successfully pass the test during those three days. There are multiple tests so each session will be different.

The score is provided immediately after completing the exam. If you pass the Certification Exam we will deliver a certificate via the arrangement your instructor has made with us.

It is a very challenging test so don’t approach it lightly.

B. SCHEDULING A TEST

Usually, your instructor will schedule the exam or request that we do so.

However, if your instructor does not do so, you can to schedule the certification examination yourself. Send an email request to Mary Newcomer at: mary.newcomer@thomsonreuters.com

In the email provide your name, your schools, and the three-day testing window that you want.

Mary will schedule your exam and create a test ID and password which she then emails to you.

Using the information in the email she will provide, you can then login to the test site and take the exam.

C. SPECIAL SOFTWARE MAY BE NEEDED TO TAKE THE EXAM

Experience has shown us that the exam requires better security than most browsers can deliver. For that reason you will probably need to install a special security software program on your personal computer in order to take the exam. You can download and install that software from: www.questionmark.com/secure.

D. MINIMUM SYSTEM REQUIREMENTS FOR YOUR COMPUTER

1. Computer running Windows 95 or later (you cannot take the exam on a Mac operating system)
2. Internet Explorer 5.0 or later or Netscape 6.0 or later
3. Macromedia Flash Player 6.0 or later
4. 20MB Free disk space to install exam
5. Email client such as Microsoft Outlook or Outlook Express. Configured to send outbound email for score reporting
6. Cannot be running any PopUp blockers.